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Chapter 1: Introducing Fencing Time 

 
Thank you for choosing Fencing Time as your tournament management software.  If you are evaluating 
the trial version, I hope that it meets your needs, and you decide to purchase a license. 
 

Motivation 

What was the motivation for writing Fencing Time?  Several factors convinced me that a new 
tournament software solution was needed.  Initially, it was the general lack of software available for 
running tournaments.  As I downloaded and tried out all the fencing software that I could find, I 
discovered that the few packages out there are antiquated and inflexible, and most are difficult to use.  
It became immediately obvious to me that the fencing community needed a modern and flexible piece 
of software that was, above all, easy to use. 
 

Goals 

When I started writing Fencing Time, I had several goals for the new software: 
 
Easy to use 
The primary goal of Fencing Time is ease of use. Running a tournament is complicated enough on its 
own that you shouldn't need to fight with the software to get things done. In addition, Fencing Time 
does not assume that its users are computer experts. Most technical details are hidden from the user so 
that a novice computer user can easily run a tournament. 
 
Familiar 
There is no reason why the visual representation of fencing scores on the screen should be different 
from what a fencer sees on paper. Unfortunately, many of the other fencing programs do not present 
the scores in a way that is easy to understand. Fencing Time, by contrast, is designed to look just like the 
paper forms that tournament organizers normally use, and therefore should be instantly familiar to 
everyone. 
 
Easy to learn 
A program that is difficult to learn will not be used, regardless of how powerful it is. Fencing Time is 
designed so that you can learn how to use it quickly. It includes this document as a guide with a 
complete step-by-step example of how to run a tournament. In addition, this guide describes all aspects 
of the software, so the answer to any question you may have is just a few mouse clicks away. 
 
Flexible 
Fencing Time is designed to be flexible enough to run any kind of tournament. While other software 
limits you to a single format, Fencing Time supports many event formats and round types. Fencing Time 
also allows you to build a unique event consisting of any combination of rounds. For example, you can 
easily construct an event that starts with a round of pools, followed by a direct elimination down to 16 
fencers, followed by another round of pools, followed by a repêchage from 16, capped off by a final 
direct elimination with a fence-off for third! 
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Customizable 
Not every tournament is alike. Many minor details can change from tournament to tournament, such as 
the rules used for seeding fencers in pools. Do you use ratings, points, or a combination of both?  
Fencing Time lets you customize these decisions at every step, and you always have the option of doing 
things manually if you are not satisfied with Fencing Time's suggestions. 
 
Accurate 
Every effort has been made to make sure Fencing Time creates tournaments that conform to USA 
Fencing and FIE rules and guidelines. Fencing Time properly handles events such as fencer withdrawals 
and updates the final standings accordingly. 
 
Modern 
Most of the fencing software available today is antiquated and very primitive by today's standards. 
Fencing Time is written using the latest technology available on PCs. The software has been designed, 
both inside and out, to be easily extended as new features are requested. In addition, Fencing Time 
easily can output results in multiple formats so that you can import them into a spreadsheet or post 
them on a website. 
 
Well-supported 
When I undertook writing Fencing Time, I made a contract with the fencing community that I would 
support the program far into the future. Fencing Time will continue to evolve as it matures. Many new 
features have been added over the lifespan of the product, and more are planned. 
 
Mature 
Fencing Time has been available since 2002 and is now in use by thousands of tournament organizers 
worldwide.  In 2011, USA Fencing adopted Fencing Time for use at all national competitions.  In 
September of 2014, Fencing Time was homologated (certified) by the FIE for use at international 
competitions such as World Cups and Grand Prix.  Since that time, Fencing Time has run countless FIE 
events, including many World Championships. 
 

Conclusion 

It is my hope that you adopt Fencing Time as the official software for your organization. I have gone to 
great lengths to put together a professional and quality product, and I feel that it is up to the task of 
running all of your tournaments. The fencing community has long deserved a good solution to the 
tournament software problem, and I hope that Fencing Time continues to fill that void. 
 
Dan Berke 
Fencing Time, LLC 
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Chapter 2: Running Fencing Time on One or More Computers 

 
Fencing Time version 4.0 introduced a significant new capability not available in prior versions: the 
ability to run your tournament using multiple computers. This is especially useful for large tournaments 
where having a single person operate the computer may not be sufficient. 
 
Running your tournament using multiple computers requires all of these computers to be connected to 
a local network so that they can communicate with a central computer referred to as the “Fencing Time 
server.”  The Fencing Time server is simply another computer running some additional software that 
allows it to function as the central repository for all of your tournament data. 
 
Running Fencing Time on multiple computers allows you to manage your tournament more efficiently. 
You can have different people running different events from separate computers. You can also set up 
computers at your check-in desk to mark fencers as present as they arrive. This eliminates the need for a 
printed sign-in sheet, since the fencers are checked-in directly to Fencing Time. 
 
If you do not need to run Fencing Time from multiple computers, you do not need a network nor a 
Fencing Time server; you only need a single computer that will run the software. This is the “traditional” 
method in which prior versions of Fencing Time have always operated. 
 
Regardless of which option you choose, the actual operation of Fencing Time is nearly identical for both. 
There are only a few differences in how you operate the software; these will be noted in each section as 
necessary.  
 
For more information on setting up, configuring, and maintaining a Fencing Time server, please refer to 
the Fencing Time Server System Guide document, which is included with the Fencing Time server 
download.
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Chapter 3: Running Fencing Time for the First Time  

 
The first time you run Fencing Time, you will be presented with several steps necessary to set up the 
program. Don’t be intimidated by these steps – they are fairly straightforward and, in most cases, only 
need to be done once. 
 

Launching the Software 

To start Fencing Time, simply double-click your mouse on the Fencing Time v4.6 icon on your desktop. 
You may also launch the program using the Windows Start menu. Fencing Time can be found in the 
Fencing Time v4.6 program group. 
 

Setting Defaults 

The first time you run Fencing Time, you will be presented with a screen asking you to select two default 
options, the language and authority for tournaments. 
 
The language selection option determines what language 
Fencing Time will display. You must select a language 
now, but you can change it later by using the 
Preferences menu. 
 
The Authority specifies which fencing governing body 
you operate under. This allows Fencing Time to adapt to 
the rules and concepts specific to that governing body. 
For example, USA Fencing divides the country into 
administrative divisions. When running under the USA Fencing authority, fencers can be affiliated with 
one of these divisions. However, if you were to select the Canadian Fencing Federation as the authority, 
the USA Fencing divisions would be replaced with the Canadian provinces. Similar adaptations are made 
for the point lists, recognized age categories, rules, and so on. 
 
The selection made here only specifies the default authority Fencing Time will use. Every time you 
create a tournament, you may either use the default authority, or choose a different one. You can 
change the default authority at any time using the Preferences menu. 
 
Choose the default authority that most of your tournaments will operate under and click “OK”. 
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Fencing Time Licenses  

The next screen you will see indicates that Fencing 
Time is running in “Trial Mode.”  Trial Mode is a 
limited version of Fencing Time that has a number of 
restrictions on what you can do. The Trial Mode 
version of Fencing Time is free and can be used 
without purchasing a license. 
 
If you have not yet purchased a standard license for 
Fencing Time, you can do so by clicking the “Buy 
Fencing Time Now!” button, which will take you to 
the Fencing Time website. If you do not want to 
purchase a license at this point, simply click 
“Continue” to run the program in Trial Mode.  
 
When you purchase a standard license for Fencing 
Time, you will be sent a “License Key” via email that 
you will use to “unlock” the full version of Fencing 
Time and all of its features. The license key looks like 
a bunch of gibberish letters and numbers, but it 
contains information that uniquely identifies you as the purchaser of the software. It is very important 
that you keep the email with the license key so that if you ever need to install Fencing Time on a 
different computer, you can re-use the key to unlock the full version. You should also be sure to keep 
your license key secret and not share it with others. 
 
Licenses purchased for versions prior to v4.0 will not work with Fencing Time v4.6.  If you have a license 
for any Fencing Time version starting with a 4, it will work with version 4.6.  
 
Once you have your license key, click the “Enter 
License Key Now!” button. This will take you to 
a screen with step-by-step instructions on how 
to get and enter your license key. 
 
The easiest way to enter your license key is to 
use the copy and paste feature to copy the key 
from the email you received and paste it into 
the space provided.  
 
Once you have entered your license key, click 
“OK.”  If everything checks out, Fencing Time 
will inform you that the key was accepted, and 
you have successfully unlocked the program. If 
there are any problems, you will receive an 
error and can go back to fix the mistake. 
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Installing Updates 

Every time you launch Fencing Time, if your computer is connected to the internet, Fencing Time will 
check to see if there have been any updates to the program. Updates are critical to keeping your copy of 
Fencing Time up to date with the latest rules and other changes. 
 
If there are any updates available, you will see a popup indicating this: 
 

 
 
It is highly recommended that you always update Fencing Time when asked if you would like to do so. 
Click “Yes” to install the updates, or “No” to skip this step. 
 

Selecting the Operation Mode 

The next screen that you will see is where you select the operation mode for Fencing Time. There are 
two modes in which you can operate: “stand-alone” mode, and “client” mode. 
 

 
 

In stand-alone mode, Fencing Time runs solely on the computer you are using. Most users will operate 
in this mode, which is selected by choosing the first option. 
 
The second option, “Connect to a Fencing Time server”, is used when you wish to connect to a Fencing 
Time server that has already been set up on your computer network. When this mode is selected, you 
will be operating on tournament data which resides on the server rather than just your computer. This 
allows multiple people to operate on the same tournament simultaneously from multiple computers. 
 
For purposes of this tutorial, select the first option for stand-alone mode.  
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Chapter 4: Getting Familiar with Fencing Time 

 
To use Fencing Time effectively, you will want to become familiar with the terminology used throughout 
Fencing Time and this User’s Guide. After that, we will review the layout of the main Fencing Time 
program window so that you can easily navigate the program and find the information you need. 
 

Terminology 

The following terms are used throughout Fencing Time and this User’s Guide. Most of them are common 
fencing terms, so you probably are familiar with most of them. 
 
Authority 
An authority specifies which fencing governing body a tournament operates under. The selection of a 
tournament’s authority allows Fencing Time to adapt to the rules and concepts specific to that 
governing body.  
 
Club 
A club is any organized group of fencers that has established themselves as a club. Fencers that are not 
members of a particular club are said to be “unattached”. 
 
Competitor 
A competitor is either a single fencer (in an individual event) or a team (in a team event). 
 
CSV file 
CSV stands for “comma-separated value” and refers to a file format commonly generated by 
spreadsheet programs. CSV files often are used to transfer data to or from a spreadsheet program. 
Fencing Time can import CSV files containing large amounts of data (such as fencers, clubs, referees, 
point ranks, etc.) and also can export CSV files containing similar data for use in a spreadsheet. 
 
Database 
A database is a collection of related data stored by a program. Fencing Time stores fencers, clubs, and 
referees in its master database. This information is stored separately from the tournament information. 
This is done so that the same fencers, clubs, and referees can participate in multiple tournaments 
without having to be re-entered each time.  
 
Event 
An event is a single competition in a tournament. Each event has a list of competitors, one or more 
rounds where scoring is done, and final results. 
 
Ranking (or point rank) 
A fencer's ranking is their position on a point list. The fencer with the most points is rank 1; the fencer 
with the second most points is rank 2, and so on. Fencing Time supports multiple rankings per fencer 
since they could have different rankings on different point lists. Rankings are often used when seeding 
an event. (In the USA, this is done along with the fencer's weapon rating.) 
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Referee Rating 
Referee ratings are used to measure a referee’s skill level in each weapon. Each authority may have its 
own referee rating system, while all authorities also recognize the FIE referee ratings.  
 
Round 
A round is a part of an event. There are several kinds of rounds; the round of pools and the direct 
elimination round are the two most common. Typically, a round will seed the competitors for the next 
round, and possibly eliminate some from the event in the process. 
 
Seed 
A seed is a competitor's current position in an event. At the start of the event, competitors are usually 
seeded by criteria such as ranking on a national point list. (In the USA, seeding usually is done using a 
combination of point ranks and weapon ratings, although it varies by event.)  As the event progresses, 
competitors will be re-seeded based on their performance in each round. 
 
Server 
When running Fencing Time on multiple computers, a central computer on the local network is running 
additional software which allows it to function as a server. A server is a computer which acts as the 
central repository of tournament data, and this data is shared by all of the other computers which have 
connected to the server.  
 
Tournament 
A tournament is made up of one or more events. For example, fencing at the Olympic Games is a 
tournament with twelve different events (6 individual and 6 team.) 
 
Weapon Rating (formerly “Classification”) 
Weapon ratings are a system used by USA Fencing to measure a fencer’s skill in each weapon. 
References and options relating to ratings will only be present if you are running a tournament under 
the USA Fencing authority. 
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Main Window Layout 

The main Fencing Time program window is shown below. There are four main parts of the window, each 
outlined in red: 
 

 
 

1. Main menu bar 
At the top of the window is a menu bar with the standard drop-down menus that you see in 
most other programs. The File menu provides commands to create new tournaments and access 
tournament files saved on your hard drive. The View menu provides access to various additional 
screens in Fencing Time, as well as the configuration options for remote displays and live results. 
The Reports menu offers several different reports that summarize tournament information. The 
Tools menu contains several miscellaneous items. Finally, the Help menu provides access to 
various reference materials and guides. 
 

2. Main toolbar 
The toolbar immediately below the main menu bar provides you with buttons that serve as 
shortcuts to many functions that are found on the main menu bar, as well as many useful ways 
to quickly enter data into Fencing Time. 
 

3. Left menu panel 
On the left side of the window is the left menu panel. The content of this panel varies based on 
whether you are currently running a tournament or not. When no tournament is loaded, the 
panel will contain buttons that let you create or load tournaments. Once a tournament is loaded 
(as shown in the picture), the panel will display a list of the events in the tournament and 
buttons used to control them. 
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The left menu panel can be hidden from view by clicking the blue arrow button near the top. 
This will collapse it into a small bar along the left edge of the window. Clicking the arrow again 
will return the panel to its normal size. 
 

4. Event tabs 
The largest part of the Fencing Time screen is the area where the events are shown. Each event 
in your tournament appears on its own tab, which you can freely switch among at any time. 
 

Event Window Layout 

The event windows are where you will spend most of your time when using Fencing Time, so let’s take a 
look at how they are organized. 
 

 
 

1. Round tabs 
Every event has one or more tabs that provide you with access to the different rounds in your 
event. The first tab (labeled “Summary”) shows you an overview of the event. After that is one 
tab per round of your tournament. In the picture above, you can see that this event is comprised 
of two rounds – a round of pools, followed by a direct elimination (DE) round. When an event 
has finished, a “Final Results” tab will be present that shows the final results for the event. 
 
The tabs for each round are where you enter the scores in your event. At any time, you can go 
back to a previous round to look at the scores, but you can only change the scores for the 
current round. 
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2. Event settings 
The event settings area on the “Summary” tab shows you all the information about how your 
event is configured. Most of this information was entered when you created the event but is 
also provided here so that you can change it if necessary. In this example, notice that some of 
the settings are “grayed out” (the classification level, age limit, etc.) – these settings can’t be 
changed once the event has started. Other settings, like the event date and time, as well as the 
entry fee, can be changed at any time. 

 
3. Event controls 

The large buttons at the bottom of the event window are used to control the flow of your event. 
The “Competitors” button is used to manage the list of competitors in the event. The “Seeding” 
button lets you view the seeding for the event at the start of the round you’re currently viewing. 
“Referees” lets you manage the referees assigned to each round of the event. “Format” shows 
details of the selected event format. The “Mark Time” button is used to track when various 
events take place in your event. The “Notes” button lets you enter any notes you’d like to keep 
track of for your event.  Finally, the “Create Event from Eliminated” lets you create a new event 
with the fencers eliminated from this event. 
 
In the lower-right corner, the “Start Next Round” button lets you finish the current round (if all 
of the scores have been entered) and start the next round. If the event has reached its 
conclusion, this button will say “Finish Event”, which causes Fencing Time to determine the final 
results and display the “Final Results” tab. The “Unfinish Event” button (which also will 
sometimes read “Abort Round”) will let you “step backwards” through your event and cancel 
rounds in the rare case that you need to do that.  
 

4. Competitor statistics 
The right side of the tab shows statistics about the competitors in your event.  These statistics 
include the number of competitors and their check-in status, and breakdowns of the 
competitors by club, division, and country.
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Chapter 5: Running Your First Tournament 

 
The best way to learn how to use Fencing Time is to go through the process of creating and running a 
tournament. This tutorial will teach you how to set up a basic tournament with a single event.  
 
Before starting this tutorial, you will need a roster of fencers that will participate in the event. For each 
fencer, you will need to know their full name, their weapon rating or rank in at least one weapon, their 
club affiliation, and (if possible), their birth date. You can make up some fencers if you want, but it will 
be more realistic if you use real people. If you have the results from a recent tournament in your area, 
you might consider using that as your roster of fencers. 
 
This tutorial was written using the USA Fencing authority, but the general principles apply to 
tournaments for all authorities.  USA-specific items will be pointed out when necessary. 
 
This tutorial only covers the basics of Fencing Time. There are many more features available, and you 
are encouraged to explore them when you have completed the tutorial. This User’s Guide has complete 
instructions on how to use all of the features in Fencing Time, so if you want more information on a 
particular topic, it is always just a few mouse clicks away. 
 
Before starting, you should review the “Getting Familiar with Fencing Time” chapter. It covers the 
terminology used by Fencing Time and this User’s Guide, as well as the basic layout of the Fencing Time 
program windows. 
 
If you are running Fencing Time for the very first time, you should review the “Running Fencing Time for 
the First Time” chapter before starting this tutorial. That chapter will guide you through the process of 
preparing Fencing Time for use. 
 
 

 
  

In practice, you will rarely create a tournament manually.  Nearly every tournament 
organizer uses some kind of online registration system to collect event entries.  In the 
USA, the most common registration systems are AskFRED and the USA Fencing 
website.  For international events, the FIE website or a federation-specific system is 
used.  In all of these cases, the registration system can generate a file (or files) 
containing data about the tournament and entries.  The file(s) is imported into Fencing 
Time to create the tournament and the events within it.  Each event is populated with 
the fencers or teams that registered online.   
 
For more information on AskFRED, see the chapter on “Integration with AskFRED”.  
For more information on the USA Fencing registration system, see the chapter on 
“Integration with the USA Fencing Registration Website.”  For more information on 
importing XML files from the FIE (and other) websites, see the chapter on “Working 
with XML Files.” 
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Step 1: Create the Tournament 

The first step is to create the tournament. A tournament can have as many events as you want, but in 
this tutorial, you will only have one. 
 
To create the tournament, click the “New Tournament” button on the left menu panel. This will bring up 
the Edit Tournament window: 
 

 
 
Enter a name for the tournament. If you leave this blank, a default name will be used. You may 
optionally enter the location and venue where the tournament is being held. Select the starting and 
ending dates of the tournament using the calendars. 
 
If your tournament has a registration fee (separate from the per-event fee), enter it here. You may leave 
the fee set to $0.00 if you choose.  
 
Next, select the authority under which the tournament will be run. The default authority will be pre-
selected, but you may choose to use a different one if you wish. This tutorial assumes you select the USA 
Fencing as your authority. If you choose a different one, there may be minor differences between the 
screens described in the tutorial and the ones you see on your computer. However, these differences 
will be minor and not affect the usefulness of the tutorial. 
 
Click “Next” when you are done. 
 
Congratulations! You have successfully created the tournament. The next step is to create the event that 
will be run in your tournament. 
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Step 2: Create the Event 

The Create New Event window will automatically appear after you create the tournament, as shown 
below: 
 

 
 
On the left side of the window, notice that there are tabs for various properties of the event. (Some tabs 
shown will not be present if you are running under an authority other than the USA Fencing.)  You can 
step through the tabs by using the “Next” and “Back” buttons in the lower-right corner of the window, 
or you can jump directly to a specific tab by selecting it directly. 
 
Feel free to explore the various tabs. However, for purposes of this tutorial, leave 
the options set to the default values. Once you are done, click “Finish” to create 
the event. 
 
Congratulations!  Your event has been created and has automatically been added 
to the tournament. You can see the event in the list of events shown on the left 
menu panel. When you run a tournament with multiple events, all of the events 
will be listed here. 
 
Next to the event name is an icon indicating the current state of the event. A 
“ball” indicates that the event has not yet started. If an event is fencing pools, the 
icon appears as a small pool score sheet. When fencing the direct elimination, the 
icon is a small elimination tableau. Finally, when an event is finished, it appears as 
a checked flag. 
 
Under the event list are several buttons that let you manage your events. The 
“New Event” button can be used to add more events to the tournament. “Cancel 
Event” is used to cancel an event and remove it entirely from the tournament. Cancelling an event 
removes all scores, competitor lists, and results, so use it carefully.  
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When you have a large number of events, it is often desirable to organize the event list. Clicking 
“Organize Events” will bring up a window that will let you order the events in whatever order you 
choose, such as by weapon, scheduled time, gender, etc. 
 
“Combine Events” allows you to merge two events that have not yet started into a single event. This 
simply takes the competitors from one event and adds them to another event and deletes the first 
event. This is handy for situations where you initially planned to fence two events (perhaps separated by 
gender or age) and ultimately decide to just fence a single event. 
 
“Import Events” is used to add an event from an FIE XML file. This will create the event from the data in 
the XML file and populate it with the competitors (individuals or teams) from the file. 
 
The “Referees” button is used to manage referees available to your tournament. In this tutorial, we will 
not worry about referees, so you can ignore this for now. 
 
The “Rankings” button is for managing fencer rankings on a point list. This is another feature which will 
not be explored in this tutorial and can be ignored for now. 
 
Let’s now proceed with adding fencers to your event. To do this, you will need to open the event 
window for the event you wish to work on. To do this, double-click on the event name in the list. 
 

 
 
The event window is where you will focus most of your attention. Each event in a tournament has its 
own window where you keep track of the competitors and their scores. Closing an event’s window does 
not affect the event at all. When you re-open the event window for that event, all event data (scores, 
competitors, etc.) will appear exactly as it was when you closed the window.  
 
In the next step of the tutorial, you will learn how to add fencers to your event. 



 

 

 C
h

ap
te

r 
5

: R
u

n
n

in
g 

Yo
u

r 
Fi

rs
t 

To
u

rn
am

en
t 

24 
 

Step 3: Add Fencers to the Event 

To add fencers to the event, click the “Competitors” button at the bottom of the event window. This will 
bring up the Event Competitors window, which is where you manage all of the competitors in your 
event. 
 

 
 
Since your event is brand-new, the window will appear blank because no fencers have been added yet. 
As you add fencers, the window will list each of them along with their pertinent information. To start 
adding fencers from the roster of competitors that you (hopefully) have prepared, click the “Add 
Competitor” button. This will show the Add Fencers to Event window: 
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The Add Fencers to Event window is divided into two sections, a search form and a list of matching 
fencers. The search form is used to find existing fencers in Fencing Time’s database using one or more of 
the criteria shown. 
 
Fencing Time maintains a list of fencers in its database, which stores all fencers that have ever been 
used in your tournaments. As you run more and more tournaments, the database will continue to grow 
and eventually you will have nearly every fencer who regularly attends your events.  
 
To search for a fencer in the database so that they can be added to the event, enter their last name in 
the search criteria section near the top. You can enter as much or as little information as you’d like, but 
keep in mind that as you add information to the search criteria, only fencers that match all of the criteria 
will be shown.  So if you specify a club and a country, you will only find fencers who are members of that 
club and the specified country. 
 
To see this in action, try entering the last name of the first fencer on your roster and click “Search”. If 
Fencing Time finds any matches in its database, browse the matches to see if your fencer is there. If so, 
click the small checkbox at the far-left side of the list – this marks them for addition into your event. 
 
If the fencer isn’t found in the search, it is likely that he or she is not yet in your database. This is not a 
problem – all you will have to do is create a new entry for them. To do this, click the “New Fencer” 
button in the lower-left corner. 
 

 
 
Enter the fencer’s name and personal data on the left side of the window. You can leave fields blank if 
you do not have the information available. 
 
In the “Memberships” box, you can track the fencer’s membership information in multiple authorities. 
For example, a fencer may have a membership in his or her home authority (such as USA Fencing), and 
also hold an FIE license. You can create two entries in the memberships list, one for each. Each entry 
lists the membership/license number, as well as its expiration date. For now, however, you can ignore 
this section. 
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In the “Affiliations” section, you may select which club(s), division (for USA Fencing events), and country 
the fencer is affiliated with. The dropdown list of clubs will show you all of the clubs that Fencing Time is 
aware of. If the fencer is not affiliated with a club (also known as “unattached”), simply leave the 
selection blank. 
 
The list of divisions is specific to the tournament’s authority. In many authorities, there are no divisions, 
so this option will not be available. The list of countries is the complete list of FIE-recognized countries. 
As with clubs, if the fencer does not have an affiliated division or country, leave it blank. 
 
Select the fencer’s primary club from the “Primary club” list. If the club is not listed, that means that it is 
not in Fencing Time's club database, and you will need to create it. To do this, click the “New Club…” 
button next to the dropdown list. This will display the Edit Club window. 
 
In this window, enter the requested information about the 
fencer's club. Enter the club’s name and a short abbreviation 
(up to 10 letters) for the club. Select the division that the club 
is a member of from the dropdown list. You may optionally 
enter the club's location, and membership number. 
 
When you click “OK”, the club will be stored in Fencing Time's 
database. This means that it will be available to you from now 
on. You will never need to enter this club's information into 
Fencing Time again! 
 
Returning to the Edit Person window, the club you just created will now be selected in the Affiliation 
section. You may now also set the fencer’s division and country if they are not already correct. 
 
Once you have finished entering all of the fencer’s information, click “OK” to complete the fencer 
creation process. The fencer will be permanently added to Fencing Time's database, so you will not need 
to enter their information the next time you use them in an event. 
 
You will now be returned to the Add Fencers to Event window. Notice that the fencer you created has 
automatically been added to the list at the bottom of the window, and their selection checkbox has 
been checked. This means that when you click the “Add Checked” button on this window, they (and all 
other checked fencers in the list) will be added to your event. 
 
To see this, click the “Add Checked” button now. Fencing Time will ask you if the competitors should be 
marked as checked-in. The check-in process will be described later, so answer “No” for now. After doing 
so, you will return to the Event Competitors window, where you will now see the list containing the 
fencers you just added: 
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At this point, click “Add Competitor” again and add all of the fencers to the event that you have on your 
sample roster. When you are done, confirm that all of the fencers are listed in the Event Competitors 
window. 
 
If you find that you need to edit a fencer already in the list (perhaps you entered something incorrectly), 
you can do this in two different ways. If the incorrect data is shown on the grid, double-click the box 
containing the data to place it in “edit mode”. You can then correct the data directly on the grid.  
 

The second way to edit the fencer is to click the  button found near the leftmost edge of the 
fencer’s row. This will bring up the Edit Person window that you used earlier so you can make any 
necessary changes.  
 

Step 4: Print the Sign-In Sheet 

If you were running an actual tournament, it’s likely that you’d now want to print a sign-in sheet so you 
could check-in the fencers as they arrive. You could also choose to check-in the fencers directly in 
Fencing Time which eliminates the paper and the potential errors that arise from transcribing the check-
in data from paper into Fencing Time. 
 
However, if you prefer to print a sign-in sheet, you may want to customize what information is shown on 
it before printing it.  
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Whenever Fencing Time presents information in a grid like the Event Competitors window, you can 
customize the grid to present the data the way you want it shown and printed. There are three ways in 
which you’ll often want to customize the display grid: 
 

• Sort the data by a specific column 
To sort the data in the grid, click the top row of the column you wish to sort by (i.e. the column 
title.)  For example, to sort the fencers alphabetically by their first name, left-click your mouse 
where it reads “First”. A small gray arrow will appear in the column header to indicate that it is 
the column used for sorting. Columns that contain numerical data will be sorted numerically, 
while columns containing text data will be sorted alphabetically. 
 
Clicking the column that is currently being used for sorting a second time will reverse the sort, 
i.e. sort from Z to A (for text data) or sort from largest to smallest (for numeric data.) 

 

• Rearrange the column order 
To rearrange the columns, left-click your mouse on the top row of the column (the column title) 
and drag the column while holding the mouse button down. An outline of the column will 
appear and move as you drag the mouse to the position where you want the column displayed. 
When you have the column where you want it, release the mouse button. 
 

• Hide or show specific columns 
Fencing Time often will only show a subset of the columns available to you at any given time. 
While the default set of columns is often all the information you’ll need, on occasion you may 
want additional columns that aren’t currently shown. 
 
To hide or show columns, right-click the mouse anywhere on the top row of the grid (the 
column title row.)  This will cause a menu to appear that lists all of the available columns, with 
checkmarks indicating which ones are currently shown. Columns that appear grayed out can’t 
be changed because that data is not pertinent to the current event. Or, in the case of first and 
last, these columns can’t be hidden because the competitor list wouldn’t make sense without 
them! 

 
If the Event Competitors window is too small to display all of the columns you want, a horizontal 
scrollbar will appear at the bottom of the window. Use this scrollbar to move the additional columns 
into view.  
 
A few of the available columns are especially handy for sign-in sheets. The “Here/Checked In” column 
can be used to check off fencers as they arrive. The “Registration $ Paid” and “Event $ Paid” columns 
can be used to track how much each fencer has paid in registration and event fees, respectively. The 
“Registration Notes” column can be used for any notes you might want to jot down regarding that 
fencer. 
 
After you have customized your event competitor list, click the “Print” button. You will be given a few 
printing options (such as whether you want it printed in portrait or landscape mode) – you can choose 
whatever options you desire. You can experiment with what looks best by using the “Preview” button to 
see how your page will look before printing it. 
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Step 5: Check-In the Fencers 

At this point, you will either have a printed sign-in sheet showing who is present and who isn’t, or you 
may have chosen to handle check-in directly in Fencing Time. 
 
Fencers can be in one of three states: 
 

  Absent  The fencer has not checked-in yet, but still may do so 
  Checked-in The fencer has checked-in as present 
  Scratched The fencer has scratched from the event and will not be participating 
 
The fencer’s status can be selected using the three buttons present on each fencer’s row in the 
competitor list. The row color will also change to indicate the status – white for absent, green for 
checked-in, and red for scratched. 
 
You can filter the list of fencers based on their status by using the checkboxes above the list. This filter 
only affects what is shown; it does not alter the fencer’s check-in status. 
 
By now, you should have a pretty good feel for the capabilities of the Event Competitors window. Feel 
free to experiment with it some more before moving on in the tutorial. If you have not yet done so, 
enter all of the remaining fencers (and clubs, if necessary) into your event and mark them as checked-in 
so that we have some fencers to work with as we progress through the sample tournament. 
 

Step 6: Set up the Pool Round 

Now that you are done adding all of the fencers, it is time to start the event. Click the green “Start 
Event” button in the lower-right corner of the event window to get things underway. 
 
The first step in running the event is to review the fencer's initial seeding. Fencing Time will 
automatically seed the fencers by whatever method you selected when you created the event. In this 
tutorial, we selected the default method of seeding by USA Fencing weapon rating. This is the standard 
seeding method used at most local USA Fencing events.  
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Fencers who have the same rating will be seeded in random order. You can re-randomize the fencers 
with identical ratings and/or ranks by clicking the “Re-seed” button. 
 
If you would like to adjust the seeding, you can do so by selecting a fencer and clicking the up and down 
arrow buttons to move him or her in the list. Note that by default, you cannot move fencers above 
fencers with a higher rating/rank or below fencers with a lower rating/rank. For example, you cannot 
move a “C24” fencer above a “B23” fencer, nor can you move them below a “D24” fencer. If you 
absolutely must do this, you can check the “Allow unrestricted manual seeding” checkbox to allow it. 
When you are satisfied with the seed order, click “OK”. 
 
Because we accepted the default settings when we created the event, Fencing Time knows that the first 
round will be a round of pools. We will now proceed through the steps necessary to set up the pools. 
 
The first decision you must make is to decide on the number and 
size of the pools that you’d like to run. Fencing Time will figure 
out the most reasonable combinations based on the number of 
fencers in the event and preset these on the Create Pools 
window. Typically, you will choose pools of 5, 6, or 7 fencers 
each. 
 
Fencing Time gives you many options for controlling how the 
pools are laid out, but for this tutorial, we will just accept the 
default options. (If you are curious to see the options available, 
they can be seen by clicking the “More Pool Options...” button.) 
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In addition to the number of pools, you can specify how many fencers should be promoted to the next 
round. This can be a percentage, a specific number, or everyone. Accept the default selection of 
promoting all competitors and click “OK”. 
 
Fencing Time will now create the pool round, which appears on a new tab. The tab will show the pools 
created by Fencing Time. By default, fencers are moved among pools in order to avoid conflicts between 
clubs, divisions, and counties.  
 

 
 
While Fencing Time will do its best to lay out the pools, sometimes it results in combinations that you 
may not like. For example, Fencing Time may create a pool with all left-handed fencers in it. In this case, 
you may wish to manually adjust the pool layouts to balance things more evenly. 
 
In other cases, Fencing Time will detect a possible problem that it could not resolve. When this happens, 
the fencer(s) causing the problem will be highlighted and an icon will appear that provides details of the 
problem when clicked. Potential problems include having a pool that is too large or too small, too many 
fencers the same club, division or country, or name conflicts (indicating that fencers from the same 
family may be in the pool with each other.) 
 
To move a fencer between pools, simply drag the fencer from one pool to another using the mouse. You 
can also right-click the mouse on the fencer that you want to move to quickly move them to another 
pool. 
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Under each pool are a number of options that you can optionally set on a per-pool basis. You can assign 
a strip number by entering it in the box provided. The “Teammate order” option instructs Fencing Time 
to rearrange the fencers in the selected pool so that members of the same club, division, or country 
fence each other first. This is standard practice when running a tournament, so you most likely will want 
to leave this option selected. Lastly, since we are not concerned with referees in this tutorial, you can 
ignore the boxes where referees are specified. 
 
Once you are satisfied with the pool layouts, click the green “Start Pools” button to start fencing! 
 

Step 7: Fence the Pool Round 

The first thing you will notice is that there are now two options for viewing the pools: “View by Pool” 
and “View All Pools”. The default view of “View by Pool” is selected, and the screen shows a list of all of 
the pools as well as the score sheet for the selected pool. Clicking the “View all Pools” tab will switch 
back to the view showing all of the pools at once. You can toggle between views at any time. 
 
When in “View by Pool” mode, you will see the pool score sheet, which is where you will enter all of the 
pool scores. If you have kept score using traditional paper pool sheets, this should look very familiar. 
There is a grid with each fencer's score in each bout, as you would expect. To the right, you will see the 
blank result columns. These will be filled in automatically once the scores have been entered. 
 

 
 
You can select which pool to display by selecting it from the list on the left. Scores that have been 
entered in one pool will be saved automatically if you switch to another pool. 
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If you have assigned strip numbers to the pools, printing the pool assignments alphabetically by fencer 
last name will greatly assist the fencers in figuring out where they should go. To do this, change the view 
to “View all Pools” and then click the “Strip Assignments” near the bottom of the window. 
  

 
 
Next, you will want to print out the pool score sheets for keeping score while fencing. Switch back to 
“View by Pool” and click the “Print all Pools” button to do this.  
 
As each pool finishes fencing, you will enter the scores from the pool score sheets into Fencing Time. 
Entering pool scores is remarkably simple. All you need to do is enter the numeric score in each box. The 
cursor will automatically move between boxes as you type. 
 
Scores that are victories will appear in blue, and losses will be red. On occasion, there will be a bout that 
ends with a tie score. This happens when there is a tie at the end of the regulation period and neither 
fencer scores a touch in the overtime. The winner is the fencer who had “priority” based on a coin toss. 
If Fencing Time detects a tie, it will prompt you to select the winner. Simply choose the fencer who 
should be marked as the winner. 
 
When all of the scores have been entered, the result columns will automatically fill in. It is a good idea to 
double-check the pool bout scores on the screen with those on the pool score sheet – this time reading 
by columns instead of rows. Note that when a pool has had all of its scores entered, its icon in the pool 
list changes to a checkered flag and it appears grayed out. 
 
To assist in this tutorial, Fencing Time has an option to let you fill the pools with randomly generated 
scores. This, of course, would never be used during a real tournament. To use the random scores 
feature, click the “Pool Bouts” button at the top of the window and select “Fill all Pools with Random 
Scores”.  
 
Once you have entered the scores for all of the pools, the “Start Next Round” button in the event 
window will turn green. Clicking it will take you to the Pool Round Results window: 
 

These days, printing documents such as the pool strip assignments, pool results, DE 
tableaus, etc. to post for fencers to view is fairly uncommon.  It is far more common to 
use remote monitor display screens for this information, although even this is 
becoming rare.  Many organizers now simply direct fencers to get all of the 
information from the event’s live results website.   The only documents still printed 
are pool and DE score sheets. 
 
Since this tutorial does not cover using display screens and live results, it will mention 
the “old fashioned” practice of printing documents for posting.   
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This window shows the results of the pool round, and notes which fencers were eliminated based on the 
promotion settings chosen when the pool round started. If you need to change the number of fencers 
promoted, you can do so by clicking the “Change” button at the top of the window. 
 
Clicking “OK” will finish the pool round and proceed to the next round, the direct elimination. 
 

Step 8: Fence the Direct Elimination Round 

When the direct elimination (DE) round starts, you will be presented with a few options: 
 

 
 
This window lets you change the default options for the DE round. The defaults, based on the kind of 
event we are running, are to use 15-touch score sheets, fence until there is a single winner, not use 
video replay, and to not fence-off for third.  
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The option to randomize seeds in pairs is primarily used by World Cup events. Since this is not needed 
for the event in the tutorial, leave it unchecked and click “OK”.  This will bring up a window which asks 
you if you want to delay the posting of the DE tableau.  For this tutorial, choose the option to “post the 
tableau immediately” and click “OK”. 
 
After doing this, Fencing Time will create a new tab for the DE round. The DE display should be familiar 
to you; the tableau is presented just as you would expect it to be when running a tournament on paper. 
All of the fencers will be placed in the tableau based on their seed entering the round.  
 

 
 
Notice that the tab for the last round - the one which reads “Round #1 - Pool” - is still available. You can 
go back to the pool round to look at the scores, but you will not be able to make any changes. 
 
Each bout on the tableau has one or two buttons in the area where the winner is normally shown. The 
top button, if present, is used to enter the score for the bout, while the bottom button is used to set 
various bout options. Bouts that can’t be fenced yet do not display a score entry button until both 
competitors are known. 
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To the right of the DE tableau is the Active Bout list. “Active” bouts are ones that can be fenced or are 
currently underway. Using the Active Bout list is a quick way to find a specific bout without having to 
search through the entire tableau. You can double-click a bout in the list to quickly enter the score, or 
just single-click it to locate it in the tableau. You can also mark a bout as being on-strip by checking the 
box in the upper-right corner. If you want to hide the Active Bout list entirely, click the blue arrow above 
the list. 
 
Entering a bout score is as simple as clicking the top button in the box where you want to place the 
winner. A popup will be displayed where you enter the scores. Fencing Time will determine the winner 
based on the scores and automatically fill in the result on the tableau. In the case of a tie, you will be 
prompted to select the winner. 
 
To print a copy of the tableau, click the “Print Tableau” button. Click “Print Bouts” and then “Print bout 
scoresheets” to print bout score sheets for all of the unfenced bouts.  
 
Often fencers who are eliminated in the early rounds of the DE will want to know where they stand in 
the final results. The “Results So Far” button is a handy way to display the results that are known based 
on the bouts that have already been entered. 
 
There are many more features available during the DE rounds, especially ones that help when running 
large events with large tableaus. You are encouraged to explore these features or read more details 
about them in the “Direct Elimination Rounds” chapter. 
 
As with the pool round, Fencing Time offers the ability to fill the tableau with random scores for you. To 
do this, click the “Tableau Options” button, then “Fill Entire Tableau with Random Scores”. 
 
After you have entered all of the DE bout scores and the final winner has been determined, the “Finish 
Event” button at the bottom of the window will turn green. When you are certain all of the scores are 
correct, click this button to finish the event. 
 

Step 9: Finish the Event 

Once you have entered all the direct elimination scores, your event is done!  You have a winner and 
everyone else can be ranked based on where they finished in the tableau.  
 
For USA Fencing events, Fencing Time will automatically determine what the event classification is based 
on the ratings of the fencers present and where they placed. The Award Classifications window will 
appear, showing this information. Click “OK” to continue. 
 
Now that your event is complete, a “Final Results” tab will appear after the DE round tab. This tab 
displays the final results listing all of the fencers, their final places, and any earned ratings. You can 
customize the columns shown on the final results just like you did when customizing the Event 
Competitors list at the start of the event. 
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Congratulations! You have finished running your first tournament!  
 
This tutorial intentionally ignored many of the more advanced features that Fencing Time has to offer. 
You should now be confident enough to explore some of these features. This User’s Guide has detailed 
explanations of every feature of Fencing Time, so you should have no trouble learning how to exploit 
Fencing Time's full power. 
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Chapter 6: Managing Clubs 

 
In Fencing Time, club affiliations are primarily used to avoid conflicts when laying out pools. Other than 
that, they are largely just informational. Fencers and referees can be affiliated with up to two clubs, and 
teams can be affiliated with one. 
 
Fencing Time maintains a database of clubs, which is essentially a list of all of the clubs that Fencing 
Time has ever been told about. Usually you create a new club when you run a tournament and a fencer 
shows up that is a member of a club you have never seen before. You will create the club as part of the 
process of adding the fencer to the tournament. That club will now be permanently added to the 
database, which means that you will re-use the club for any future people that you encounter from that 
club. 
 
If a fencer/referee/team is not affiliated with a club, they are said to be “unattached”. When this is the 
case, the club selection should be left blank.  
 

 

 
 
 
Clubs may be created automatically for you when you load a tournament file. If the tournament you are 
loading contains clubs not already present in Fencing Time’s database, these clubs will automatically be 
added as part of the load process. You can also explicitly create large numbers of clubs by importing 
them from CSV files. 
 
All of the clubs that are in the database can be viewed by selecting View → Club Database on the main 
menu bar. This will bring up the Club Database window: 
 

 
 

Do not create a club in your database called “Unattached”, “(None)”, or any other 
name that indicates a fencer is unattached.  Doing this will actually create a club by 
that name, and Fencing Time will treat it like any other club.  That means that if two 
fencers from the “Unattached” club are in the same pool, Fencing Time will see that as 
a conflict and attempt to move one of the fencers to another pool.  However, that is 
not necessary, since two unattached fencers shouldn’t be a conflict with each other! 
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As with all tabular data in Fencing Time, you can customize this display as you choose – rearrange 
columns, hide/show columns, sort the data, etc. You can also edit club data in-place by double-clicking 
the item you wish to edit. 
 
From this window, you can also create new clubs, either individually or by bulk importing a club list from 
a CSV file. You can also merge duplicate clubs into a single club if you discover that you have multiple 
clubs of the same (or similar) names.  Each of these operations is described below. 
 

Creating and Editing Clubs 

There are several ways to create new clubs in the database. The easiest way is to click the “New Club” 
button in the Club Database window. This can be done at any time, regardless of whether a tournament 
is underway or not. The second way to create a new club is to click the “New Club…” button next to the 
club selection dropdown when editing fencers, referees, or teams.  
 

To edit an existing club, click the  button in the leftmost column on the club’s row in the Club 
Database window. You can also edit specific data in-place by double-clicking the cell in the table that 
contains the information that you want to change.  
 
Editing clubs and creating new clubs is done with the Edit Club window: 
 

 
 
Club name 
The club name field is where you enter the full club name. All clubs must have a name, ideally one that is 
unique. If Fencing Time detects an existing club in the database that has the same name as the club you 
are creating or editing, you will be alerted to this in case you are creating a duplicate. 
  
Abbreviation 
The club abbreviation is the commonly used shorthand for the club. The abbreviation must be provided 
and should be as short as possible (ideally, ten letters or less). As with club names, if Fencing Time finds 
an existing club with the same abbreviation, you will be alerted to this fact. 
 
Country 
The country indicates which country the club resides in. All FIE-recognized countries are available for 
selection. 
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Division 
The division represents the home division of the club. You may select from of all of the divisions 
available in the authority which you have set as Fencing Time’s default authority. If the authority does 
not have divisions, this option will be disabled. 
 
Location 
You may optionally enter the club's home location (city/state/etc.) for further identification. 
 
Member #  
The member number field is for specifying the club’s unique membership number in their applicable 
fencing federation. Membership numbers must be unique across all clubs – duplicates will not be 
allowed. Providing a membership number greatly improves Fencing Time’s ability to match the club 
when importing data from another source (such as a CSV file.) 
 
List members 
Clicking this button will list all fencers and referees that are members of the club (either in primary or 
secondary affiliation.)  You cannot edit this list directly. To add or remove a person from the club, you 
must edit that person directly. 
 

Merging Duplicate Clubs 

As your database of clubs grows, it is almost certain that you will eventually get duplicate clubs in the 
database.  Often, this is due to a club having multiple possible names – for example, “Los Angeles 
International Fencing Center” and “LA International Fencing Center”.  These are both the same club, 
differing only in how the name is written. 
 
Having duplicate clubs will cause problems when creating pools.  Fencing Time will treat each club as a 
different club since it has no way to know that they are actually the same club.  If you have fencers in 
your event that represent both variations of the club, Fencing Time will think they are from different 
clubs and may put the fencers in the same pool.  Since they are actually from the same club, this is an 
undesirable situation. 
 
Fencing Time has the ability to merge duplicate clubs to solve this problem.  Merging clubs is a simple 
process – you choose which two clubs should be merged, and Fencing Time will combine all of the 
members into the same club and delete the duplicate club.  
 
To merge two clubs, click the “Merge Duplicates” button on the Club Database window.  A popup will 
appear asking you which club to keep and which to delete (the duplicate club.)  After selecting the two 
clubs, click “OK” and Fencing Time will move all of the fencers from the duplicate club into the one you 
chose to keep.  If details about the club such as the name, abbreviation, division, etc. differ, Fencing 
Time will prompt you to select which of the two options you wish to use in the club that you are 
keeping. 
 
If you have more than one duplicate of the same club, simply repeat this process until all of the clubs 
have been merged into the single one you wish to keep. 
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Deleting Clubs from the Database 

Fencing Time does not let you explicitly delete a club from the database, but you can effectively achieve 
the same result by using the merge duplicates feature.   
 
To delete a club, click “Merge Duplicates” on the Club Database window.  Leave the “Club to keep” set 
to “(Unattached)”, select the club that you wish to delete, and click “OK”.  Fencing Time will then take all 
fencers in the club that you are deleting and remove their affiliation (thus making them “unattached”.) 
 

Importing Clubs from a CSV File 

If you have a large number of clubs that you want to add to your database, you can perform a bulk 
import using a CSV file that was exported by a spreadsheet program. Club CSV files may contain 
information such as the club name, division and country affiliations, club location, and membership 
number. CSV files can provide as much or as little of this data as desired.  
 
To import club data, you must first close the current tournament file if one is already open. Then, click 
the “Import Clubs” button on the Club Database window to start the Import Club Data Wizard. 
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Chapter 7: Managing Fencers  

 
Fencers are one of the most basic elements in Fencing Time. Before you can run a tournament, you must 
have fencers – either competing as individuals, or as part of a team. Like clubs, Fencing Time maintains a 
database of fencers, which is essentially a list of all of the fencers that Fencing Time has ever been told 
about. Usually, you create a new fencer when you run a tournament and a fencer shows up that you 
have never seen before. You will create the fencer as part of the process of adding him or her to the 
tournament. That fencer will now be permanently added to the database, which means that they will be 
available to you for all future tournaments. 
 
Fencers may be created automatically for you when you load a tournament file. If the tournament you 
are loading contains fencers not already present in Fencing Time’s database, these fencers will 
automatically be added as part of the load process. You can also explicitly create large numbers of 
fencers by importing them from CSV files. 
 
All of the fencers that are in the database can be viewed by selecting View → Fencer Database on the 
main menu bar. This will bring up the Fencer Database window: 
 

 
 

Searching for Fencers 

Frequently, you will need to search Fencing Time’s database for a specific fencer or for a group of 
fencers (such as fencers from the same club.)  When this is necessary, you will be presented with a set of 
search controls like the ones at the top of the Fencer Database window. 
 
To use the search controls, enter as much or as little information as you’d like and click the “Search” 
button. The more information that you specify, the narrower the search will be – this is because all of 
the information you provide must match for a match to be made.  Fencing Time will populate the list of 
fencers beneath the search controls with fencers that match the criteria you have specified. 
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When specifying a fencer’s name, you can use all or part of the name. For example, to find all fencers 
whose last name starts with “J”, simply enter “J” in the last name field. If you want fencers whose last 
name is specifically “Jones”, enter the full name in the last name field. 
 

Creating and Editing Fencers 

There are several ways to create new fencers in the database. The easiest way is to click the “New 
Fencer” button in the Fencer Database window. This can be done at any time, regardless of whether a 
tournament is underway or not. 
 

To edit an existing fencer, click the  button in the leftmost column on the fencer’s row in the Fencer 
Database window. You can also edit specific data in-place by double-clicking the cell in the table that 
contains the information that you want to change. 
 
Editing and creating new fencers is done with the Edit Person window: 
 

 
 

First name & Last name 
The first name and last name fields are where you enter the fencer's name. These fields cannot be 
blank. 
 
Nickname 
If a fencer has a nickname that they commonly use, enter it here. This nickname will be used in searches 
and also be displayed instead of the fencer’s given first name. 
 
Middle and Suffix 
If you know the fencer’s middle name and suffix (Jr., Sr., IV, etc.), enter it in the corresponding box. 
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Gender 
Select the fencer's gender, male or female. 
 
Handedness 
Select the handedness of the fencer, right or left. 
 
IWAS Classification 
If the fencer has an IWAS (parafencing) classification, select it here. 
 
Birthdate 
If you know the fencer’s birthdate, check the checkbox and select the date. If you do not know their 
birthdate, uncheck the box.  If the fencer’s birthdate has been verified, you can indicate this using the 
provided checkbox.  (Birthdate verification is primarily tracked by USA Fencing.) 
 
Memberships 
In the “Memberships” box, you can track the fencer’s membership information in multiple authorities. 
For example, a fencer may have a membership in his or her home authority (such as USA Fencing), and 
also hold an FIE license. You can create two entries in the memberships list, one for each. Each entry 
lists the membership/license number, as well as its expiration date.  
 
Membership numbers must be unique within each authority – duplicates will not be allowed. Providing 
a membership number greatly improves Fencing Time’s ability to match the fencer when importing data 
from another source (such as a CSV file.) 
 
For USA Fencing members, you can also indicate whether the person’s membership allows them to 
fence in local and regional competitions. Members with a full competitive membership can compete in 
both, while members with an “access” membership may only compete in local competitions. 
 
Primary and Secondary club 
Fencers may be affiliated with one or two clubs. If a fencer does not have a secondary club, leave this 
field blank. The primary and secondary clubs must be different. 
 
Use the dropdown lists to select the club(s) that the fencer is affiliated with. If a club is not listed, this 
means that it is not in the database. To create a new club, click the “New Club…” button next to the 
dropdown list. This will take you to the Edit Club window, where you can enter the new club's 
information. 
 

Never change a fencer’s name to represent another person!  If you accidentally enter 
Alan Jones in your event, when you actually meant to enter Adam Jones, you might 
think the simple solution is to just change Alan’s name to Adam.  This is a huge 
mistake!  Since Alan and Adam are distinct people, you should instead remove Alan 
and add Adam (who probably is already in the database.)  You should only change a 
fencer’s name if it is spelled incorrectly.  
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Division 
The division represents the home division of the fencer. You may select from of all of the divisions 
available in the authority which you have set as Fencing Time’s default authority. If the authority does 
not have divisions, this option will be disabled. 
 
Country 
The country indicates which country the fencer represents. All FIE-recognized countries are available for 
selection. 
 
Region 
the region indicates what USA Fencing region the fencer resides in.  This is usually determined by their 
division affiliation but can be changed if necessary.  The region is used to determine whether the fencer 
should earn points at regional events such as RJCCs and RYCs. 
 
Photo URL 
If you have a photo of the fencer online, the URL of that photo can be specified here.  At the moment, 
Fencing Time does not use this data, but may do so in the future. 
 
Weapon Classifications and Referee Ratings 
Under some fencing authorities, fencers have a classification in each weapon which is an indication of 
their skill level. In addition, fencers also may have a referee rating to indicate their skill refereeing each 
weapon. 
 
Fencing Time can track weapon classifications and referee ratings for a fencer across multiple 
authorities (selected from the dropdown list.)  
 
In the case of USA Fencing, a fencer's classification in each of the three weapons can be selected using 
the arrow buttons to scroll through the possible choices. The year can be set using the up and down 
arrows to scroll through classification years (except for unrated). Referee ratings in each weapon can be 
selected from each weapon’s respective dropdown list. 
 
If you change a fencer's weapon classification while they are competing in an event, their classification 
will be updated in the database but not in the event. This is done so that any classification changes that 
you make will not affect the seeding of fencers in the event. If a fencer is signed up for an event that has 
not yet started, the classification change will be in effect when that event starts. 
 

Deleting Fencers from the Database 

At present, you cannot delete fencers from the database. This is for a number of technical reasons.  This 
capability may be added in a future version of Fencing Time. 
 

Importing Fencers from a CSV file 

If you have a large number of fencers that you want to add to your database, you can perform a bulk 
import using a CSV file that was exported by a spreadsheet program. Fencer CSV files may contain 
information such as the fencer’s name, club, division, and country affiliations, personal data such as 
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birth date and gender, weapon classifications, and membership number and status. CSV files can 
provide as much or as little of this data as desired. 
 
To import fencer data, you must first close the current tournament if one is already open. Then, click the 
“Import Fencers” button on the Fencer Database window to start the Import Fencer Data Wizard. 
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Chapter 8: Managing Referees 

 
In prior versions of Fencing Time, referees and fencers were stored in separate databases. This meant 
that if you had referees who also fenced, there would be an entry for that person in the fencer database 
and another entry in the referee database. There was no connection between the two, so if the fencer 
changed clubs, the referee version of the same person would also need to be updated manually to 
reflect that change.  
 
Since Fencing Time v4.0, referees and fencers have been united in a single database. This way, there is a 
single entry for each person. When the person is a competitor in an event, they behave like a fencer. 
When they are listed as a referee in an event, they behave like a referee. You could, in fact, have the 
same person both fence and referee in the same event! 
 
The process of managing referees is nearly identical to that of managing fencers. Creating and editing 
referees follows the same process. The only difference is the user interface used to search for referees. 
 
To search for referees, select View → Referee Database on the main menu bar. This will bring up the 
Referee Database window: 
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Searching for Referees 

Frequently, you will need to search Fencing Time’s database for a specific referee or for a group of 
referees (perhaps with a minimum weapon rating.)  When this is necessary, you will be presented with a 
set of search controls like the ones at the top of the Referee Database window. 
 
To use the search controls, enter as much or as little information as you’d like and click the “Search” 
button. The more information that you specify, the narrower the search will be – this is because all of 
the information you provide must match for a match to be made.  Fencing Time will populate the list of 
referees beneath the search control with referees that match the criteria you have specified. 
 
When specifying a referee’s name, you can use all or part of the name. For example, to find all referees 
whose last name starts with “J”, simply enter “J” in the last name field. If you want referees whose last 
name is specifically “Jones”, enter the full name in the last name field. 
 

Creating and Editing Referees 

There are several ways to create new referees in the database. The easiest way is to click the “New 
Referee” button in the Referee Database window. This can be done at any time, regardless of if a 
tournament is underway or not. 
 

To edit an existing referee, click the  button in the leftmost column on the referee’s row in the 
Referee Database window. You can also edit specific data in-place by double-clicking the cell in the table 
that contains the information that you want to change. 
 
Editing referees is identical to the process for editing fencers. For details on the editing process, see the 
“Creating and Editing Fencers” section of the “Managing Fencers” chapter. 
 

Deleting Referees from the Database 

As with fencers, referees cannot currently be deleted from the database. See the “Deleting Fencers from 
the Database” section of the “Managing Fencers” chapter for more details. 
 

Importing Referees from a CSV File 

If you have a large number of referees that you want to add to your database, you can perform a bulk 
import using a CSV file that was exported by a spreadsheet program. Referee CSV files may contain 
information such as the referee’s name, club, division, and country affiliations, personal data such as 
birth date and gender, weapon ratings, and membership number and status. CSV files can provide as 
much or as little of this data as desired.  
 
To import referee data, you must first close the current tournament if one is already open. Then, click 
the “Import Referees” button on the Referee Database Window to start the Import Referee Data 
Wizard. 
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Importing Referees from an XML File 

If you have an XML file that follows the FIE XML format for describing competition registrations or 
results, you can import referees from that file into Fencing Time.  See the “Working with XML Files” 
chapter for complete details on how to do this. 
 

Using Referees in a Tournament 

To use a referee in your tournament, you must first add them to the list of available tournament 
referees. This list is generally the list of all referees hired to referee at your tournament. 
 
To manage the tournament referee list, click the “Referees” button on the left menu panel under the 
event list. This will bring up the Tournament Referees window, which displays a list of the referees 
currently in your tournament. 
 

 
 
Like all other data tables in Fencing Time, this display can be customized to display the data as you want 
it to be displayed. You can also edit the shown referees, either by editing the field directly on the grid, or 

by clicking the  button at the left edge of the row.  
 
To add referees to your tournament, click the “Add Referees” button. This will bring up the Add 
Referees to Tournament window, which looks much like the Referee Database window. From here, you 
can search for referees for your tournament. To select referees to add, put a checkmark in the selection 
box at the left edge of each referee’s row. When done, click “Add” to add the referees that you selected 
to your tournament. 
 
To remove a referee from your tournament, select the referee and then click “Remove Referee”. You 
can only remove referees that have not yet been used in your tournament. 
 
To import referees into the tournament, use the “Import from CSV” or “Import from XML” button and 
follow the steps to import the referees. 
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The “Check All Memberships” button, which is only available when running an event under the USA 
Fencing authority, allows you to update the referee membership data from the USA Fencing website.  
This will update the person’s affiliations, membership type, and eligibility to referee as per the USA 
Fencing rules.  If one or more referees is not in compliance, a warning will appear indicating this so that 
you can resolve the issue. 
 
The “Additional Countries” button allows you to associate a referee with up to three additional 
countries (other than their “permanent” country affiliation.)  This feature is primarily for use at FIE 
events, where it is helpful to track multiple potential country conflicts.  For example, a referee from 
Belgium who is coaching at a club in France would be a conflict with both French and Belgian fencers.  
By adding the second country to the referee’s record, Fencing Time will avoid assigning this referee to 
pools or bouts with fencers from either nation. 
 
Note that, unlike a referee’s “permanent” country affiliation, the additional countries that you set are 
only in effect for the current tournament.  
 

Adding Referees to an Event 

After adding referees to your tournament, the next step is to add them to your events. Fencing Time 
allows you to customize the list of referees used during each round of your event. This gives you the 
ability to move referees from one event to another as necessary. It also ensures that the referee 
dropdown lists used to assign referees to pools and DE bouts only contain the referees that you have 
assigned to that specific round. 
 
To add referees to your event, click the “Referees” button at the bottom of the Event window: 
 

 
 
The list on the left shows all of the referees in your tournament. The list on the right shows which 
referees have been assigned to this round of your event. The “Add” and “Remove” buttons allow you to 
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move referees in and out of the round. Note that if a referee has refereed one or more pools or DE 
bouts in this round, you will not be able to remove them from the round. 
 
Since most events use the same set of referees throughout the entire event, referees are automatically 
added to the next round as your event progresses. You can always remove those referees from the 
round if they will no longer be working in the event. 
 
If you want to add a referee that has not yet been added to your tournament, you can click the “Add 
Referees to Tournament” to do so. This will add the referee to the list of tournament referees so that he 
or she can be used in any event. 
 
Fencing Time does not prevent you from adding the same referee to multiple events. It is your 
responsibility to make sure you do not assign referees to multiple events at the same time! 
 

Active and Inactive Referees 

Once in an event, referees can be marked active or inactive.  When inactive, the referee will no longer 
be included in the list of referees available for assignment.  This is useful for situations where a referee is 
no longer being used in an event – by marking them as inactive, you will not accidentally assign them to 
a pool or bout. 
 

Assigning Referees to Pools and Bouts 

The process of assigning referees to pools and specific bouts depends on what kind of round you are 
running. For details on each, see the chapter on the specific kind of round that you would like to know 
about. 
 

Referee Usage Reports 

Fencing Time can generate reports showing how long and how many pools and DE bouts each referee 
worked. This can be done on a per-event basis, or a tournament-wide basis. 
 
To view the per-event usage report, click the “Referees” button at the bottom of the Event window. 
Next, click the “Referee Usage Report” button. The report lists each referee that was used, along with 
their rating and affiliations. There will also be a column for each pool round and DE table in the event.  
 
For pool rounds, the number of pools refereed will be listed.  For elimination tables, the number of 
bouts that the referee worked as the primary referee, video, and assistant will be listed. 
 
To view the tournament-wide referee usage reports, select the Reports →Tournament Referee Usage 
Reports item on the main menu bar. 
 
To view a report showing the hours a referee worked, select the Reports → Referee Daily Hours Report.  
To create this report, Fencing Time reports the time of the first pool or bout refereed by the referee, as 
well as the time at which their last bout finished. 
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For FIE events where video appeals are recorded, the Video Appeals Report generates statistics about 
the video appeals taken during the event. 
 

Pod and Video Referee Assignment Forms 

When running the DE tableau using a pod/partition approach (as USA Fencing does), it is more efficient 
to have the referee assigner assign the referees to the pods during the pool round rather than waiting 
until the DEs begin. Fencing Time provides two forms that you can print out to assist in this process.  
Both forms are available by clicking the “Referees” button at the bottom of the event window. 
 
The “Print Pod Refs Form” prints a form that can be used to assign referees to up to four pods.  The 
“Print Video Refs Form” prints a form used to assign referees to the bouts that use video. 
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Chapter 9: Tournaments 

 
In Fencing Time, tournaments represent a group of events and the data associated with them (fencers, 
teams, scores, referees, etc.)  You can have a simple tournament with a single event, or a huge 
tournament with over 100 events.  
 
The first step in running a tournament is to create the tournament itself. The tournament initially starts 
out empty, so you must add one or more events to it. Each event can be run individually with no effect 
on the other events. 
 
Tournaments are saved in tournament files that end in “FTX4”. Tournament files can be thought of as 
the basic “document” in Fencing Time. Just as you would load a document file into a word processor, or 
a spreadsheet file into your favorite spreadsheet program, tournament files are loaded into Fencing 
Time.  
 
Tournament files save the state of the tournament so that the data can be stored for later use. Over 
time, your collection of tournament files will grow and serve as a permanent record of all tournaments 
you have run. 
 
By default, Fencing Time stores tournament files in the “My Tournaments” folder located in the “My 
Documents” folder used by Windows. You can, however, store tournament files anywhere you want. 
You can also move tournament files between computers so that you can work on the same tournament 
in different locations (but not at the same time.) 
 
 

 
 

Creating a Tournament 

There are two general ways to create a tournament in Fencing Time. Be sure you understand the 
difference between the two as they are very different. 
 
The first (and easiest) way to create a tournament is by using a registration file downloaded from the 
AskFRED or USA Fencing website, or using one or more XML files of inscriptions that are in the FIE XML 
format.  
 
To use an AskFRED file, you must have access to a “bout committee” account on AskFRED. This will allow 
you to create the tournament on AskFRED, along with the events in your tournament. Competitors will 
see your tournament online and register for the event(s) that they want to fence in.  
 
At some point (generally, the day before your tournament) you will create the tournament in Fencing 
Time using the registration data from AskFRED. To do this, use the File → New AskFRED Tournament 
option on the main menu bar or the button on the left menu panel. Follow the procedure described in 

If you are using a Fencing Time server, your tournaments are stored in a database on 
the server rather than in tournament files.  However, you can still save your 
tournaments to “FTX4” files, which can then be loaded by the non-server version (or 
loaded onto another server.) 
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the “Integration with AskFRED” chapter to transfer the AskFRED data to Fencing Time. Fencing Time will 
take the data from AskFRED and create the tournament and the events, then populate them with the 
competitors.  
 
To use a file from the USA Fencing website, you must have “tournament organizer” access on the site.  A 
with AskFRED, you will download the registration file from the website and use it to create your 
tournament in Fencing Time using the File → New USA Fencing Tournament option on the main menu 
bar or the button on the left menu panel.  For more information on integration with the USA Fencing 
website, see the “Integration with the USA Fencing Registration Website” chapter. 
 
To use XML files, download the files for each event from whichever website collects the inscriptions 
(such as the FIE or EFC website.)  Then, select File → New Tournament from XML Files on the main 
menu bar.  Follow the steps detailed in the “Working with XML Files” chapter on how to import the XML 
files to create the tournament. 
 
If you don’t use AskFRED, USA Fencing, or XML files for your tournaments, you can manually create 
tournaments in Fencing Time by selecting File → New Tournament on the main menu bar. You can also 
use the “New Tournament” button on the left menu panel to perform the same function. Note that this 
button is only visible when a tournament is not currently underway. 
 
The first thing you will see when creating a tournament manually is the Edit Tournament window: 
 

 
 
Tournament name 
This is the name that describes the tournament. Examples would be “Summer Nationals” or “The Mid-
Winter Open”. There are no restrictions on what you name your tournament. If you leave this field 
blank, a default name will be used. 
 
Location 
This field is where you specify the city, state, and country where the tournament is held.  It is primarily 
used to help people locate your tournament when viewed on Fencing Time Live. 
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Venue 
This optional field can be used to record the venue (club, convention center, etc.) where the tournament 
is held. There are no restrictions on what you place in this field. 
 
Start date & End date 
You can use the dropdown calendars to select the starting and ending dates of the tournament. Single-
day tournaments should set both of these to the same date. 
 
Registration fee 
Enter the registration fee for the tournament. Note that this fee is separate from the per event fee. 
 
Authority 
The authority specifies which fencing governing body the tournament will operate under. This allows 
Fencing Time to adapt to the rules and concepts specific to that governing body. All events in the 
tournament will be run under this authority. Once the tournament is created, the authority cannot be 
changed. 
 
Tournament Staff and Notes 
The “Staff” button takes you to a window where you can record the names of the tournament staff 
working at the event. The “Notes” button shows a window where you can enter any notes you wish to 
record about the tournament. 
 
 

 
 
 

Saving and Loading Tournaments to/from a File 

Once a tournament has been created, you will want to save it to disk so that you have a permanent 
record of it. Saving the tournament frequently also ensures against data loss that might result from a 
loss of power or computer crash. 
 

 

 
 
 
Tournaments are saved in files that end with an “FTX4” extension. By default, Fencing Time will create a 
“My Tournaments” folder within your “My Documents” folder and save tournament files there. 
However, you may save your tournaments to any location on your computer.  
 
Tournament files created with Fencing Time v4.6 cannot be opened in prior versions of Fencing Time. 
Similarly, Fencing Time v4.6 can't open tournament files created with versions of Fencing Time prior to 
v4.0. To open an older version file, you need to use the version of Fencing Time that created it.  
 

Once a tournament has been loaded, you can edit the name and other properties by 
clicking the “Edit” button on the title bar on the left menu panel. 

Tournaments run from a Fencing Time server do not need to be saved to disk – they 
are automatically stored in the server’s database.   
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To save a tournament, select File →Save Tournament on the main menu bar. Navigate to the folder 
where you want to save the tournament and name the file. Click “OK” to save the tournament. 
 
You can save a tournament at any time. Fencing Time also will auto-save periodically to prevent data 
loss. You can configure the auto-save frequency or disable auto-save entirely from the Preferences 
window. To do this, select Tools → Preferences on the main menu bar.  
 
To enable the timed save, check the “Automatically save tournament every X minutes” checkbox and 
select the frequency of the save. To disable automatic saving, uncheck the box. 
 
Loading a tournament that was previously saved to disk is a simple process. Simply File → Open 
Tournament on the main menu bar. This will bring up the familiar open file window, where you can 
browse the folders on your computer to find the tournament file you wish to load. 
 
Keep in mind that you can only have one tournament loaded at a time. If you try to load a tournament 
when one is already loaded, current tournament will be closed before loading the new one.  
 

Moving Tournament Files to another Computer 

Sometimes you will want to transfer tournament files from one computer to another. An example of this 
might be where you have Fencing Time installed on a home or office PC where you enter all of your 
fencer data before the tournament. You then want to transfer the tournament to Fencing Time running 
on a laptop, which you use at the venue to run the events. 
 
To do this, all you need to do is copy the tournament file (with the “FTX4” extension) to a USB drive and 
bring it to the destination computer. Once there, you simply load it as you would with any other 
tournament file. 
 
When you load the file on the destination computer, you may be prompted with a series of 
synchronization steps. This is a very important process that lets you reconcile any differences between 
the data in your tournament file and conflicting data on the destination computer. For example, 
suppose you have a fencer in your tournament with an A24 classification. However, this fencer is listed 
as having a B23 in Fencing Time’s database on the destination computer. The synchronization step will 
detect this difference and ask you which classification is correct.  
 
It is critical that you understand the synchronization process so that the data in your tournament 
remains accurate. For a complete discussion of the synchronization process, see the “Data 
Synchronization” chapter. 
 

If you load a tournament file that was created with Fencing Time v4.0 through v4.5 
and then save it using Fencing Time v4.6, it will no longer be usable in the older 
version. 
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Loading Tournaments from a Fencing Time Server 

If you are running Fencing Time connected to a Fencing Time server, you will not be using tournament 
files. Instead, you will access tournaments stored on the server. When you select the “Open 
Tournament” option, instead of being asked to pick a tournament file, you will be presented with a list 
of Tournaments available to be loaded from the Fencing Time server. To load a tournament, simply 
select the tournament and click “Open”.  
 

 
 
On this screen, there are several other operations you can perform to manage your tournament list.  
 
If your tournament list starts getting too large, you can hide tournaments using the “Hide” button. The 
checkbox in the upper-right corner will allow you to see the hidden tournaments (listed in grey.)  Hidden 
tournaments can be un-hidden using the “Unhide” button. 
 
If you want to delete a tournament, select the tournament and click “Delete”. Deleting a tournament 
will erase all of the tournament data (pools, DEs, scores, competitors – EVERYTHING!) permanently. This 
can’t be un-done, so you will be asked to confirm this twice before the tournament is deleted. 
 
Finally, the “Import” button can be used to import a tournament from an FTX4 file into the server’s 
database. This is useful if you originally ran the tournament on a computer not using a server.  
 

Finishing a Tournament 

A tournament is said to be complete when the last event finishes. Of course, if you add new events at 
this point, the tournament will not be complete. When it really is complete is up to you. 
 
When Fencing Time thinks your tournament is complete, you will be presented with the Finish 
Tournament window: 
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This window presents you with some of the most common end-of-tournament tasks so that you don't 
forget anything. All of these tasks can be done elsewhere in Fencing Time, but they are presented here 
simply for convenience. 
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Chapter 10: Events 

 
In Fencing Time, an event is a single competition and is considered part of a tournament. Events come in 
two flavors: individual and team events. The only difference between the two is the definition of what a 
“competitor” is. In an individual event, a competitor is simply a fencer. In a team event, a competitor is a 
team of several fencers. 
 
An event has numerous properties, such as the weapon being fenced, the gender mix, and the age 
restriction of the participants. Every event has a list of competitors, which ultimately produces a list of 
final results.  
 
Events are made up of one or more rounds. There are numerous types of round, such as pool rounds, 
direct elimination rounds, and repêchage rounds. 
 

Creating Events 

A tournament is made up of one or more events. Each event is completely independent from the rest 
and has its own list of competitors, scores, and results. New events can be created at any time without 
affecting other events that may or may not be in progress. 
 
To create an event, click the “New Event” button on the left menu panel under the event list. This will 
display the Create New Event window, which will walk you through the process of creating an event. 
 
On the left side of the window there are tabs for various properties of the event. (Some tabs shown will 
not be present if you are running under an authority other than USA Fencing.)  You can step through the 
tabs by using the “Next” and “Back” buttons in the lower-right corner of the window, or you can jump 
directly to a specific tab by selecting it directly. 
 
Event Type 
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Fencing Time can manage both individual and team events. Once this has been selected, you cannot 
change it without starting a new event. 
 
Several types of team events are supported: 

• 45-touch relay – This is the common format where teams of four (three plus a reserve) compete 
in nine bouts to a total of 45 touches. 

• Best 5-of-9 bouts – In this format, teams of five (three plus two reserves) compete in matches 
that are comprised of nine five-touch bouts. The winning team is the first to win five bouts in 
the match (although you may fence all nine if desired.) 

• CBA format – In this format, teams designate three fencers, A, B, and C.  Each match is fenced 
as three 5-touch bouts – a C bout where the C fencers fence each other, a B bout for the B 
fencers, and an A bout for the A fencers.   Events using the CBA format are limited to only 
running pool rounds. 

• Mixed gender – This format uses teams of six, three men and three women.  (Two fencers in 
each gender compete, with the third being the reserve.)  The four competing fencers on each 
team fence the opponent team’s fencers of the same gender, for a relay of 40 touches.  Before 
a match is fenced, a coin flip determines which gender fences in the first bout.  The genders 
alternate in each bout after that.  

• 3-weapon mixed gender – This format is only available when running under the FIE authority.  It 
is a special format only used once for the cadet team event at the Junior/Cadet World 
Championships. 

• Vet Worlds – This format, used at the Veteran World Championships, is a team relay of 30 
points.  Each team consists of a fencer in each age category (Vet-50, Vet-60, and Vet-70) plus an 
optional alternate in each age.  The fencers in each age category fence the opponent team’s 
fencer in the same category two times during the match. 

 
If your event is a wheelchair event, click the checkbox and select the wheelchair category. 
 
Finally, the Event Type dropdown list lets you choose if your event is a World Cup, Grand Prix, European 
Cadet Circuit event, etc.  Choosing one of these events sets some default values for seeding methods 
and other parameters.  If your event is not one of these kinds of events, simply select “Other”.  (Note 
that your tournament must be run under the authority of the FIE or one of its confederations to select 
some of these event types.) 
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Date, Time, and Fees 

 
 

Select the start time for your event using the date and time controls. This is the time at which the check-
in will close, and the event will start. 
 
If you wish to track entry fees, you can enter an amount in the entry fee box. This amount should be the 
per-event entry fee. Do not include any one-time registration fees - these were set when you created 
the tournament. 
 
Weapon 

 
 

Here you select the weapon that the event will be using. This cannot be changed after you create the 
event. 
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Gender Mix 

 
 
The gender mix of the event can be restricted to men or women, or it can be a mixed event. While 
Fencing Time will not prevent you from adding people of the wrong gender to an event, it will warn you 
if you attempt to do so.  
 
Age Category 

 
 
If your event restricts entry by age, select the age category from the dropdown list. The list of age 
categories is specific to the authority of the tournament. As with the gender option, Fencing Time will 
allow you to add ineligible fencers to the event, but will warn if you do so.  
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Classification Level 

 
 
For USA Fencing events, you can use this option to select the classification level of the event. This 
restriction will limit the tournament to fencers of a certain range of classifications.  
 
Seeding 

 
 
At the start of the event, competitors can be seeded by one of several methods. To select the seeding 
method, click “Change”. For a detailed discussion on the various seeding methods, see the chapter on 
“Event Seeding”.  
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Event Format 

 
 
An event format defines the specific types of round that make up your event, including any round-
specific parameters. For instance, a common format is pools to a direct elimination with 100% 
promotion. Other formats may promote a smaller percentage, exempt the top fencers from fencing the 
pool round, or be composed of an entirely different set of rounds. You can view and change round 
formats by clicking “Change”. 
 
When a round format is specified, Fencing Time will automatically adapt your event to the format’s 
rounds as the event progresses. If the “Select rounds automatically based on format” option is checked, 
Fencing Time will not prompt you when a round ends and will automatically move to the next round 
defined by the format. If the option is not selected, you will be prompted at each step. 
 
If you are not sure what format you want to use or want to adapt the format as the event progresses, 
you can select “Determined by the user during the tournament” as the format. This option will make no 
assumptions and prompt you to make all selections as necessary. 
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Qualifier 

 
 
When running events under the USA Fencing authority, the qualifier tab will be present. This is used for 
when you need to run qualifier events to determine who qualifies to attend events such as Summer 
Nationals or Junior Olympics. If you tell Fencing Time that your event is a qualifier, when the event 
finishes, Fencing Time will apply the latest USA Fencing qualification rules to determine who has 
qualified. For more information on this, see the chapter on “USA Fencing Qualifier Events”. 
 
Note that qualifier events must be gender-specific, so if you selected “Mixed” on the “Gender Mix” tab, 
the option to be a qualifier event will be unavailable. 
 
Once you have finished creating the event, it will appear in the list of events on the left menu panel. 
Notice that the event name is automatically generated based on the selections that you made when 
creating the event. Once an event has been finished, it will appear grayed out in the list. 
 
Most of the options that you selected when creating the event can be changed on the “Summary” tab in 
the event window. Some options can only be set prior to the event starting, while others can be 
changed at any time. 
 

Setting Event Options in Bulk 

If the event you are creating is a part of one of the USA Fencing regional circuit events (ROC, SYC, RYC or 
RJCC) or a national qualifier, there are specific options that must be set (such as the seeding rule and the 
qualifier option.) Rather than having to set these options manually for each event, Fencing Time has a 
shortcut that will make this much simpler. 
 
On the Tools → Bulk Operations menu, there are options to set your events as one of the pre-defined 
regional or qualifier events.  Selecting one of these options will cause Fencing Time to apply the selected 
event settings to the events in your tournament. 
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Changing an Event Name 

If you want to give an event a custom name, you can do so by clicking the “Edit” button in the upper-
right corner of the event tab.  To return the event name to the default name, simply clear the custom 
name. 
 

Organizing the Event List 

When running a tournament consisting of many events, it is often desirable to organize the event list so 
that it is easier to find the events. Some people order events by weapon, gender, or by the scheduled 
day and time of the event. You can order the events in any way you find convenient. 
 
To organize the event list, click the “Organize Events” button under the event list. To sort the list, click 
the header of the column that you want to sort by. You can also manually order the list by selecting an 
event and moving it in place using the up and down arrows. 
 
If you want to simply hide the events which have been finished, you can check the “Hide completed 
events” checkbox under the event list in the main window.  You can also use the dropdown under the 
event list to only show events on a specific day. 
 

Viewing Events in the Event Window 

To view an event, select it from the event list on the left menu panel and double-click the event name. 
This will open the event in a new window. Each event appears in its own tab, so you can have multiple 
events open at one time. 
 
Closing an event window does not affect the event at all; if you re-open the window, the event will be in 
the same state as you had left it when you closed the window. 
 
A typical event window is shown below: 
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At the top of the event window there is a row of tabs that can be selected. The first tab will always be 
the “Summary” tab which gives you information on the event settings. After this, there will be one tab 
for each round (pool round, DE round, etc.) in the event. Once the event is complete, a “Final Results” 
tab will appear as the last tab. 
 
If you have many events, it often is helpful to use a different background color for each event to help 
you easily distinguish one from another.  You can set which colors to use for each event (based on 
weapon and gender) by enabling this option and setting the colors on the Tools →  Preferences → 
Colors tab.  
 
On the summary tab, there are a number of options available. Most of these options are the same ones 
described earlier in the section on creating events. If the event has not yet started, you can modify the 
event settings using the dropdown lists. Once the event is underway, however, most of the settings 
cannot be changed.  
 
Other settings on the “Summary” tab include places to record the name of the computer operator that 
is managing the event, the referee assigner for the event, and how P-Black cards are handled when the 
two fencers are tied.  According to the FIE rules, normally the winner is the fencer with the higher initial 
seed entering the event, but some federations choose to use the higher-seeded fencer after the pools.  
For competitions that do this, you can set that option here.  Note that for events run under the FIE and 
USA Fencing authorities, the option to change this is disabled, to prevent you from accidentally using a 
method not in accordance with that authority’s rules. 
 
At the bottom of the window is a row of large buttons: 

Competitors This button is used to manage the competitors in the event, including check-in. 

Seeding Displays the seeding for the round currently selected. Before the event starts, this 
shows the preliminary seeding. 

Referees Manages the referees assigned to work the currently selected round. 

Format If you have set an event format (other than “Determined by the user during the 
tournament”), this button will display details of the event format. 

Mark Time Displays a window where you can view and track various key moments in the event. 

Notes Shows a window that allows you to enter any notes that you want to record about 
the event or a specific fencer. Fencer notes will appear on all printed DE slips with 
that fencer; this is a good way to record medical breaks that the fencer had in earlier 
rounds so that referees of future bouts are aware of them. 

Create Event 
from Eliminated 

This button, which is only active once the event is underway, allows you to create a 
new event with the competitors that have been eliminated from this event.  This is 
occasionally done for tournaments that offer “consolation” events for those 
eliminated from the main event. 

Start Event This button is used to start the event or the next round once the event is underway. 

Abort Round When the event is underway, this button lets you abort the current round and return 
to the prior round. When the event is finished, this button will let you “unfinish” the 
event and return to the last round. 

Event Competitors 

Managing event competitors is a large topic and is discussed in the next chapter. 
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Starting Events 

After setting up an event and adding all of the competitors, you will be ready to start the event. To do 
this, click the green “Start Event” button in the event window.  
 
The first thing Fencing Time does when you start an event is to alert you if there are any fencers who are 
still listed as “Absent”. If so, you will be shown a list of these fencers and asked to either mark them as 
checked-in or scratched. Typically, this is when you would announce the names of the missing fencers in 
the venue and give them a few minutes to show up. If they fail to show, you mark them as scratched and 
proceed. 
 
Next, Fencing Time will check to see if any competitors are ineligible to fence in the event. If any issues 
are found, you will be notified of the problems. At this point, you can either cancel starting the event so 
that you can return to the Event Competitors window to fix the issues or ignore the problems and start 
anyway.  
 
If your event is running under the authority of USA Fencing, Fencing Time will check the membership 
status of each competitor. If any members do not have a current competitive USA Fencing membership, 
you will be alerted. You can choose to ignore this and start anyway, although it is not recommended. 
 
The final step is to review the initial seeding. Fencing Time will seed the competitors using the method 
that you specified during the event creation steps. This will be shown in the Initial Seeding window: 
 

 
 
 
If you would like to adjust the seeding, you can do so by selecting a competitor and clicking the up and 
down arrow buttons to move him or her in the list. Note that by default, you cannot move fencers above 
fencers with a higher classification/rank or below fencers with a lower classification/rank. For example, 
you cannot move a “C24” fencer above a “B23” fencer, nor can you move them below a “D24” fencer. 
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The same rule applies to teams:  you can’t move a team with more points below one with fewer points. 
If you absolutely must do this, you can check the “Allow unrestricted manual seeding” checkbox to allow 
it. When you are satisfied with the seed order, click “OK”. 
 

Canceling Events 

Sometimes it is necessary to cancel an event. Keep in mind that once an event has been canceled, all 
information about that event is lost. This includes all scores, results, and the list of competitors. 
 
To cancel an event, select it from the event list and then click the “Cancel Event” button. Confirm your 
decision or click “No” if you have changed your mind. 
 

Combining Events 

Sometimes, you may need to combine events. This usually happens when you originally plan to hold 
events for each gender, but due to poor turnout, decide to combine the genders and run a mixed event. 
To do this, you will want to move the competitors from the smaller event into the larger one and then 
cancel the smaller event. 
 
To automate this process, click the “Combine Event” button on the left menu panel. You will be able to 
choose which events to combine and whether you want scratched competitors moved to the combined 
event or not. After the two events are combined, the original one will be cancelled.  
 

Finishing an Event 

Fencing Time will automatically detect when your event is finished. This is the case when only one un-
eliminated competitor remains in the event. You can also manually finish an event by selecting the “End 
the event now” option in the round selection window. 
 
In the first case, the “Start Next Round” button in the event window will change into the “Finish Event” 
button.  
 

Unfinishing an Event 

Once an event has been finished, it is possible to “unfinish” the event by clicking the “Unfinish Event” 
button in the event window. Unfinishing an event lets you return to the last round of the event. This is 
useful if you discover that a score was entered incorrectly, or some other problem was discovered.  
 

Awarding Classifications 

When running events under the USA Fencing authority, classifications may be awarded to the top 
finishers. All team events and some individual events that restrict entry based on age do not generate 
classifications. In addition, fencers who have been black carded will not earn a classification, even if their 
final ranking would otherwise grant them one. 
 
The Award Classifications window shows the classification of the event based on the number of fencers 
who participated, their classification, and their final placing. These classifications are taken directly from 
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the USA Fencing Classification Reference Chart. This chart can be viewed by clicking the “Classification 
Chart...” button. It is also available on the main menu bar under Help → Event Classification Chart. 
 

 
 
Once the event level has been determined, a complete list of earned and renewed classifications is 
shown. If you do not want your event to award classifications, you can mark it as unsanctioned using the 
checkbox below the list. 
  
After the entire tournament is complete, you can generate a report of all earned classifications to be 
sent to USA Fencing. For more information on this, see the “Reports” chapter. 
 

Viewing the Final Results 

After an event has finished, the “Final Results” tab will appear in the event window to the right of all 
other tabs. This tab will display a table with the final results, along with other pertinent data for each 
competitor. 
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For USA Fencing individual events, each fencer's classification at the start of the event is listed along 
with the classification they earned (or renewed). Additionally, competitors who were excluded (black 
carded) are listed as “Fencer Excluded” or “Team Excluded.” 
 
Competitors who did not finish the event are listed as “DNF” for their place (“Did Not Finish”). Usually 
this is due to a medical withdrawal or black card during the first round of the event. 
 
In rare cases, you may need to exclude a competitor from the event after they have been eliminated. To 
do this, click the “Exclusions” button. This will show a list of all of the competitors and their exclusion 
status. From here, you may exclude a competitor, or un-exclude one who was excluded using this 
process. You cannot un-exclude a competitor who was excluded during the event. 
 
If you want to separate the final results by gender, as is often done in mixed youth events (so that you 
can award medals to the top placing girls separately from the boys), simply change the “Filter results” 
option located above the result list to the desired gender. 
 
As with all data tables in Fencing Time, you can customize which columns are displayed. Right-clicking on 
the top row of the table (the column header) will let you hide or show specific columns. You can re-
order the columns by dragging the column header to where you want it positioned. 
 
Once you are satisfied with the final results display, you can print the results by clicking the “Print” 
button. Printed results will reflect the columns and column order on the screen. 
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Splitting Events after the Pools (Continuation Events) 

Some events are structured where everyone fences an initial round of pools and then they fence 
separate DE tableaus depending on their age, gender, or skill level.  Fencing Time handles this format by 
running each phase of the event as a separate event.  The initial pool round with all fencers is run as a 
single-round event consisting only of the pools.  Each DE tableau is run as a separate event consisting of 
a single DE round.  The fencers are seeded into the DE-only “event” based on their pool results in the 
“pool” event.  These “DE-only events” are referred to as “Continuation Events.” 
 
To run an event using this “split DE” format, follow these steps: 
 

1. Create the event with all of the fencers as would be done for any other event. 
2. Change the format of the event to “Determined by the user during the tournament”. 
3. Start the event and fence the pools. 
4. After the pools are complete, select the option to end the event. 
5. On the Final Results tab, click the “Create Continuation Event” button.  Select the fencers that 

you wish to place into the first DE tableau, and then click “Create Event with these Fencers”. 
6. Create as many continuation events as you need to partition the fencers as desired. 
7. Start each newly created continuation event and run the tableaus until finished. 

 

Exporting the Final Results 

The final results for each event can be independently exported from Fencing Time to a number of 
different file formats. To export results, click the “Export” button on the “Final Results” tab in the event 
window. The exported data will match the data displayed on the screen, so if you have made any 
customizations to the final results table, those customizations will also be present in the exported file. 
 
Comma Separated Value (*.csv) 
The comma separated value (CSV) file format is designed to be imported into a spreadsheet such as 
Microsoft Excel.  
 
Excel Spreadsheet (*.xls) 
This option exports the results in the native file format used by the Microsoft Excel spreadsheet 
program.  
 
Text (*.txt) 
This is the most basic format, a standard text file. Text files can be imported into any word processor, 
such as Microsoft Word. 
 
HTML (*.htm) 
The HTML format is designed for posting on a website. Fencing Time will generate an HTML page 
containing the tournament information and the final results in a table. Complete results for the rounds 
(including pool scores, elimination tableaus, etc.) are also included. You can either post the page on the 
web without making changes or load it into a webpage editor to customize it before putting it online. 
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Fencing File Format (*.fff) 
The FFF file format option saves the results in a format identical to the FFF files used by some 
federations for reporting results. When you select this format, you will be prompted to provide some 
additional data that gets saved in the FFF file: 
 

 
 
Most of the information in this window will be filled in by Fencing Time, but it is presented to you in 
case you need to alter it. The guidelines for what information need to be provided in these fields are 
usually set by your fencing federation. 
 
XML Format (*.xml) 
The XML format option saves the results in an XML file that can be uploaded to any website that 
recognizes the FIE XML format.  This format is used by the FIE and EFC websites to report results for 
events such as World Cups and European Cadet Circuit events.  This format is also used by some 
federations for results reporting. 
 

Generating Result Kit PDFs 

Many organizers are required to generate a PDF file containing all of the relevant data that completely 
documents their event.  These documents include competitor lists, seedings and round results, the 
event formula, pool and DE tableau results, final rankings, and referee activity reports. 
 
Creating this document used to be a tedious process that required the computer operator to generate 
each document, save it as a PDF, and then join all of the PDFs into a single file.  Fencing Time simplifies 
this process with a one-click solution:  the “Results Kit”. 
 
To generate the results kit, simply click the “Results Kit” button on the “Final Results” tab.  Fencing Time 
will collect all of the documents into one and prepare to print them.  In order to save them as a PDF, you 
need to print the document to a PDF virtual printer.
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Chapter 11: Managing and Checking-In Competitors  

 
When fencers arrive at the venue, their first order of business is to check-in with the organizers to let 
them know that they are present.  Fencers that do not confirm their presence will be removed from the 
event and will not fence.  This chapter will explore how Fencing Time makes checking-in fencers quick 
and easy. 
 

The Check-In Phase 

Each event in your tournament has a scheduled start time. Before that start time, you will be in the 
“check-in phase”. This is when you will allow competitors to report as present, pay entry fees, sign 
waivers, etc. The event start time is set when creating an event and can be changed on the “Summary” 
tab before the event starts. 
 
When the scheduled start time arrives, you will usually announce which competitors have not yet 
checked in. After giving the missing competitors a few minutes to present themselves, you either mark 
them as present or scratched. Once this is done, you start your event. 
 

Event Competitor Window Layout 

Competitor management and check-in is accessed via the “Competitors” button at the bottom of each 
event’s Event Window. This will show the Event Competitors window. 
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The Event Competitors window shown above is the one for individual events. For team events, the 
window functions identically, but some of the columns displayed will be different. 
 
There are several parts to this window. At the top is the event name. To the right of the event name is a 
dropdown list with which you can use to quickly change to another event. If you have a lot of events, 
you can use the All / Today / Starting soon options to limit the events shown.  (“Starting soon” means 
events scheduled to start within two hours.) 
 
Under the event name section is a blue bar showing how long until check-in closes.  Once the event has 
started, this bar is not shown. 
 
Under the blue bar is the check-in bar. This controls how the "quick check-in” features work, which are 
described later in this chapter. Once the event has started, the check-in bar is not shown. 
 
The next section of the window is the competitor grid showing all of the competitors in the event. This 
grid is highly customizable. You can hide or show columns by right clicking the mouse on the top 
(header) row of the grid and selecting the columns you want. You can re-order columns by dragging 
them to the position where you want them. You can sort columns by clicking the column header of the 
column you want to sort by. And finally, you can edit most data in-place by double-clicking the cell in the 
grid that you want to change. 
 

The leftmost column of each competitor row has an edit button ( ) used to edit the details of that 
row’s competitor. To the immediate right of the edit button are three buttons indicating the 
competitor’s check-in state. The three states are: 
 

  Absent  The competitor has not checked-in yet, but still may do so 
  Checked-in The competitor has checked-in as present 
  Scratched The competitor has withdrawn from the event 
 
The color of the row also indicates the check-in state: white for absent, green for checked-in, and red for 
scratched. 
 
Above the grid are three checkboxes, one for each check-in state. The number in parenthesis next to 
each state is the number of competitors in that state. You can hide or show competitor rows in each 
state by checking or unchecking the corresponding checkbox. 
 

Adding Competitors to an Event Manually 

Adding competitors to an event is a basic operation done at nearly every tournament. Even if you import 
your competitors by loading an AskFRED, USA Fencing registration, or XML file, there often will be 
competitors who did not sign up online and need to be added at the door. Competitors can only be 
added when the check-in is open. 
 
The process of adding competitors to an event is different for individual events and team events. The 
remainder of this chapter will discuss the process of adding fencers to an individual event. For 
information on adding teams to team events, see the chapter on “Team Events”. 
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To add a fencer, click the “Add Competitors” button at the bottom of the Event Competitors window. 
This will bring up the Add Fencers to Event window: 
 

 
 
The Add Fencers to Event window is divided into two sections, a search form and a list of matching 
fencers. The search form is used to find existing fencers in Fencing Time’s database using one or more of 
the criteria shown. 
 
To search for a fencer in the database so that they can be added to the event, enter their last name in 
the search criteria section near the top. You can enter as much or as little information as you’d like; the 
more specific you are, the narrower the search will be.  For a fencer to match, all of the given criteria 
must match.  
 
If you find the fencer you want to add in the list of matching fencers, put a checkmark in the leftmost 
column on the fencer’s row. This will mark them for adding to the event. You can now search for more 
fencers, mark them for addition, and repeat the process. 
 
If the fencer you are looking for isn’t found in the search, either your search criteria are too strict, or 
they are not in your database. If they are not in the database, you can create the fencer by clicking the 
“New Fencer” button in the lower-left corner. After going through the fencer creation process (see the 
chapter on “Managing Fencers”), the fencer will appear in the list already checked for addition. 
 
Clicking the “Add Checked” button will add the checked fencers to the event and return to the Event 
Competitors window. 
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Importing Competitors from a CSV File 

Fencing Time can use a CSV file for importing event competitors for both team and individual events. 
This allows you to use a spreadsheet or database to track event registrations and import the data into 
Fencing Time. Most people, however, choose to use an online system for tracking registrations, so this 
feature mainly applies to those who don’t use those systems. 
 
Since there is no one standard CSV file format for event registrations, the import process is handled like 
a custom CSV import. For details on importing custom CSV files, see the “Importing Data from CSV Files” 
chapter. 
 
To start the import process, click the “Import from CSV” button in the Event Competitors window. You 
will go through the usual step of locating the CSV file, followed by the column-matching step where you 
match the columns in your file to the data Fencing Time expects. 
 
The column-matching step requires that you supply, at the minimum, some form of data to use to 
identify the fencer. To identify a fencer, you can supply their name or member number. The member 
number is preferred, since it is a unique way to identify fencers. However, using the member number 
assumes that your fencer database contains member numbers in each fencer’s record. 
 
If you provide fencer name information instead of member numbers, Fencing Time will attempt to find 
the named fencer in the fencer database. If the named fencer can’t be found (because an exact name 
match must be made), Fencing Time will ignore that fencer when importing the registrations. 
 
If you are importing registrations for a team event, you must supply a team name, as well as three 
columns that specify fencer information for three team members.  
 
Often, you will have registrations for multiple events in your CSV file. If you specify a column that 
identifies the event name, Fencing Time will prompt you to select which event you want to import data 
for. A dropdown list will appear showing all of the values present in your CSV file’s “event” column for 
you to select from. 
 

Importing Competitors from an XML File 

Fencing Time can also import fencers from an XML file.  For more information on this, please see the 
“Working with XML Files” chapter. 
  

Checking-In Competitors by Name or Scanned Barcode 

Check-in can be performed three ways. The “old fashioned” way is to print out the list of competitors 
and mark them checked-in on paper as they arrive. Using this approach, you will need to transcribe the 
check-in state of each competitor into Fencing Time prior to starting your event. 
 
If you are using a Fencing Time server, an automated way to handle check-in is to use the Fencing Time 
Check-In Kiosk application.  This option is discussed later in this chapter. 
 
One very efficient way to handle check-in is to check-in the competitors directly into Fencing Time. By 
eliminating the paper process, you eliminate the chance of making transcription errors.  



 

 

 C
h

ap
te

r 
1

1:
 M

an
ag

in
g 

an
d

 C
h

ec
ki

n
g-

In
 C

o
m

p
et

it
o

rs
 

78 
 

 
 

 
 
As competitors arrive at the check-in desk, the obvious way to check them in is to look the competitor 
up by name and mark them as checked-in. However, if you have a long list of competitors, this can be 
tedious. 
 
To help you easily locate competitors, you can use the text box labeled “Quick check-in” above the 
competitor grid. You can enter the competitor’s last name in the box – as you type, the list of matches 
will appear for you to quickly select from. You can also use the dropdown list and select the competitor 
directly. 
 
If your fencing federation provides fencers with membership cards that represent their member number 
(as the USA Fencing does), you can also scan the barcode if you have a barcode scanner hooked up to 
your PC. (This only applies for individual events – barcode scanning is not available for team events.) 
 

 
 

Check-In Options 

When checking-in fencers using the Quick check-in box, you can optionally have a confirmation window 
appear. The “Confirm” checkbox to the right of the Quick check-in box controls this. This window will 
show the fencer’s name, birthdate, affiliations, and classifications/ranks. This is to assist you in verifying 
that the information is correct before checking in the fencer. 
 

If you are using a Fencing Time server, you can set up separate computers at your 
check-in desk to handle check-in.  When Fencing Time is started, you can log into the 
server in “check-in” mode.  This puts Fencing Time in limited-functionality mode which 
limits the operator to only doing check-in.  All other functions of Fencing Time are 
disabled.  This prevents a person at the check-in desk from accidentally altering the 
tournament. 

Handheld barcode scanners are very inexpensive; you can get one that hooks up via 
the USB port for $25 at Amazon.com and other online retailers.  If you decide to buy a 
scanner, make sure it supports “Code-128” barcodes to be compatible with Fencing 
Time’s barcodes. 
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If all of the information is correct, clicking “Check-in” will close the window and mark the fencer as 
checked in. If there are errors in the data, you should click “Cancel” and make the necessary corrections 
on the competitor grid (or by using the “Edit” button on the competitor’s row.) 
 
If you have a second computer screen available, you can streamline the check-in process by hooking it 
up to the check-in computer (set the screen to behave as an “Extended Desktop” in Microsoft 
Windows.)  Set up this screen so that it faces the fencer that is checking-in and make sure the “Show on 

” option is selected to the right of the Quick check-in box.  
 
Now, when you check-in a fencer, the fencer’s information will be displayed on the screen so the fencer 
can review it and alert the check-in operator if there are any mistakes. While this information is 
displayed to the fencer, the corresponding confirmation window will be shown to the computer 
operator. 
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Several other options are available for the check-in process. These options are controlled by checkboxes 
to the right of the Quick check-in options. The options are to show warnings to the check-in operator if 
any of the selected conditions exist. 
 
Expired membership A warning will be shown if the competitor does not have a current membership.  
Unpaid entry fees If the event entry fee is not set, this warning will be shown 
Note present This warning will appear if any text is present in the “Notes” column for the 

competitor. The notes field is usually where any unresolved issues are noted. 
Unverified birthdate If you are requiring verification of fencer birthdates, setting this option will 

show a warning if the fencer is marked as having an unverified birthdate 
 

Removing Competitors from an Event 

There are two ways to remove a competitor from an event. You can either mark them as scratched or 
remove them entirely. Competitors can only be scratched and removed before the event starts. 
 
Scratching a fencer is done using the check-in status buttons on the competitor’s row in the competitor 
grid. Scratching a competitor removes them from the competitor list and preliminary seeding, yet their 
information (such as payment data) is retained. You can undo a scratch by simply changing the 
competitor’s status to absent or checked in. 
 
Removing a competitor is a more drastic measure. This removes the competitor from the event entirely, 
leaving no record of the competitor’s presence in the event. In addition, the removal process cannot be 
undone, although you could add the competitor back in by following the steps for adding new 
competitors. Generally, removal is only necessary for competitors who were accidentally added to the 
wrong event and you do not want a record of their presence. 
 
Before removing a competitor, they must be marked as scratched. This is to prevent the accidental 
removal of competitors that have been checked in.  
 
To remove a competitor, select the competitor you wish to remove and click “Remove Competitor”. You 
will be prompted to confirm the removal, and if approved, the competitor will be removed. 
 

Updating Memberships and Fencer Data from the USA Fencing Website 

If you are running a sanctioned tournament under the USA Fencing authority, it is essential that you 
ensure that you use the official fencer data from the USA Fencing membership database.  This data 
includes the fencer’s membership status, club, division, and country affiliations, and current weapon 
ratings. 
 
Fencing Time provides you with a simple way to make sure you are using the latest data – simply click 
the “Check All Memberships” button under the competitor grid.  You should do this at least once for 
every event in your tournament before starting any events. 
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By default, the fencer’s name, gender, 
birthdate, affiliations, and weapon 
classifications are synchronized with the USA 
Fencing data. You can customize which fields 
to synchronize by using the “Membership” tab 
on the Preferences window, found on the main 
menu bar under Tools → Preferences. 
 
Fencer data can be updated per-fencer or per-
event. To update data for a specific fencer, 
select the fencer’s row on the Event 

Competitors grid and click the  button. 
Fencing Time will download the fencer’s data 
and make any necessary changes.  
 
To update all fencers in the current event, click 
the “Check All Memberships” button under the 
competitor grid.  
 
In both cases, a popup window will appear listing any changes that were made.  This list can be sorted 
and printed if you wish. 
 
If you have many events, opening each one to check the fencer member data would be a tedious 
process.  You can check the memberships of all fencers in your tournament by using the Tools → Bulk 
Operations → Check Memberships in All Unstarted Individual Events option. 
 

Using the Fencing Time Check-In Kiosk Application 

If you are running an event under the USA Fencing or Canadian Fencing authority and are also using a 
Fencing Time server, you can also use the Fencing Time Check-In Kiosk application.  The kiosk app is used 
at the check-in desk where fencers scan their membership card’s barcode to check-in for the event they 
are fencing each day.  This app is now available to all tournament organizers. 
 
To use the kiosk app, you will need to set up a PC connected on the same computer network as the 
server.  This PC must also be equipped with a barcode scanner and a screen facing the fencers. 
 
When a fencer arrives, they simply scan their membership card’s barcode on the scanner.  The barcode 
encodes their member number, so Fencing Time uses this to look-up the fencer and find the next event 
they are participating in on that day.  If there are no issues, the kiosk will respond with a pleasant “ding” 
sound and show a green “success” screen telling the fencer that they are checked-in for their next 
event.  If the fencer is fencing multiple events that day, they will need to scan their card again for each 
subsequent event. 
 
There is always a possibility that the fencer’s check-in will fail, so you should plan on having at least one 
person at the check-in desk to assist these fencers.  There are several reasons why a check-in may fail, 
including: 
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• The fencer is not registered for any events on the current day; 

• The start time for event they are trying to check-in for has passed (even if the event has not yet 
been started); 

• There is an issue with the fencer’s USA Fencing membership status (most commonly, it is not 
current);  

• The fencer’s birthdate has not been verified (this only applies to some USA Fencing regional 
events); or 

• There is a registration note in the fencer’s record which may need to be handled. 
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Chapter 12: Point Lists and Fencer Rankings 

 
Point rankings are numerical values used to rank fencers for purposes of seeding. Commonly known 
point ranking systems include the USA Fencing national rolling point standings and FIE senior and junior 
points. These point rankings, which are categorized by weapon and age group, are tabulated over the 
fencing season.  Because they change frequently, point rankings are stored in Fencing Time on a per-
tournament basis. 
 
Every point ranking that a fencer has is associated with a specific point list. Each point list must be 
created in Fencing Time in order to track these rankings. Point lists are specific to an authority – for 
example, USA Fencing has point lists for senior, junior, cadet, youth, and veteran age groups, while the 
Canadian Fencing Federation has National and HPP point lists. All authorities also have the option to 
record FIE senior and junior points. 
 
Fencing Time includes known point lists for several authorities, and you can create your own custom 
point lists. Frequently, custom point lists are created to track points that are specific to a club, division, 
or regional circuit. 
 
It is very important to understand that Fencing Time uses point rankings, not point values. For example, 
assume Fencer X is ranked #1 with 500 points, and Fencer Y is ranked #90 with 200 points. Fencing Time 
expects that you will enter 1 and 90 as their ranks, respectively. If you were to enter their absolute point 
values, 500 and 200, Fencer Y will incorrectly be seeded above Fencer X because it is interpreting this as 
rank 200 and 500. 
 

Viewing Rankings and Lists 

To view fencer rankings and lists, click the “Rankings” button under the event list on the left menu 
panel. This will bring up the Fencer Rankings window where you can view the current rankings. To view 
a specific point list, choose the point list and weapon from the corresponding dropdown lists. The grid 
will be populated with the list of fencers ranked on the chosen list. 
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If the point list you want to view is not one of the available options, you can create a new list. To do this, 
click the “New List…” button and provide a name and abbreviation for the list. The abbreviation will be 
shown on the screen and visible to the fencers, so it is best to choose an abbreviation that they may be 
familiar with. 
 
Generally, point lists are created for a specific age category. Fencing Time does not track age categories 
for lists, so you should just make the age category part of the list name. Once a list has been created, it 
is available for use by all combination of genders and weapons, so you do not need to create multiple 
lists for each weapon and/or gender. 
 

Importing Fencer Point Rankings from a CSV File 

Once you have selected or created a point list, the next step is to populate it with the current fencer 
rankings. Frequently, ranking data is tracked in a spreadsheet external to Fencing Time. Many 
federations post spreadsheets of the current national rankings on their website. Importing this data into 
Fencing Time is the easiest way to get the latest data into your tournament. 
 
To import ranking data, click the “Import” button on the Fencer Rankings window. This will launch the 
Import Point Ranking Data Wizard, which will guide you through the process of importing the data from 
a CSV file.  
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On the first page of the wizard, you must select which point list and weapon you are importing the data 
into. If the point list does not exist, you should cancel the wizard and create the list as described earlier, 
then restart the wizard. 
 
The first option tells Fencing Time that the file you will import has data for multiple lists.  When using 
this option, the rows in your file must be sorted so that the data for each point list is contiguous. 
 
When importing a file with multiple point lists, you must include the following three columns (in 
addition to the columns specifying the fencer and their point rank value): 
 
Point List Name 
The point list name must exactly match the spelling of the list name in Fencing Time.  
 
Point List Gender 
The point list gender must be one of the following: “men’s”, “boy’s”, “male”, “m”, “women’s”, “girl’s”, 
“female”, “f”, “mixed”, or “x”. 
 
Point List Weapon 
The point list weapon must be one of the following: “foil”, “epee”, “saber”, “sabre”, “f”, “e” or “s”. 
 
The final option on the first step of the wizard is the choice to indicate that the file contains absolute 
point values rather than rankings. If you select this option, Fencing Time will analyze the point values 
and assign ranks – the fencer with the most points will be rank #1; the second most points will be rank 
#2, and so on. 
 
When importing ranks from a CSV file, Fencing Time will attempt to match the fencers using the criteria 
you provide when setting up the import (generally the fencer’s name or membership number.)  If 
Fencing Time cannot find the fencer in its database, the fencer will be skipped. As a result, it is 
recommended that you import ranks after you have created all of the fencers in your tournament. 
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Editing Fencer Point Rankings 

The easiest way to edit a fencer’s rankings is to do so directly in the Fencer Rankings window. To do this, 
select the list and weapon you wish to edit, and then simply double-click the rank column on the row of 
the fencer you wish to change and enter the new ranking. To remove a fencer’s ranking, you can either 
just delete their ranking value, or set it to “0”.  
 
If the fencer does not appear in the ranking list, this means they are not currently ranked. You can add a 
ranking by clicking “Add Fencer” to locate a fencer in the database. Once added to the list, you can edit 
the fencer’s ranking as described above. 
 
If an event is set to be seeded using a point list, a column will be available in the Event Competitor 
window which displays the fencer’s rank on the corresponding point list. You can also edit the fencer’s 
rank directly by changing the value in the competitor list. 
 
Any changes to fencer rankings will automatically reseed any events that depend on the point list that 
the edited ranking belongs to. However, once an event has started, changes to rankings have no effect. 
 

Seeding an Event Using Point Rankings 

To use a point list for seeding an event, the point list must be selected in the event’s seeding rule. For 
details on how to do this, see the “Event Seeding” chapter. 
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Chapter 13: Team Events 

 
In team events, several fencers compete as a team against other teams. This is in contrast to individual 
events, where fencers compete as individuals. The basics of running either kind of event are the same, 
but this chapter will discuss topics that are specific to running team events. 
 

Adding Teams to an Event 

To add teams to a team event, start by clicking “Add Competitors” button in the Event Competitors 
window. This will bring up the Edit Team window: 
 

 
 
Team Name 
All teams must have a name. No two teams in the same event can have the same name.  
 
Captain 
Teams may optionally specify a captain. Enter the captain’s name in the provided box if known. 
 
Team Rank 
If the team has a ranking used for seeding, enter the value here.  
 
Club 
In most events, teams represent a specific club. If this is the case in your event, set the club affiliation 
using the dropdown list. (If the club is not present in the list, use the “New Club” button to add it.)  If the 
team does not represent a specific club, leave the selection blank. 
 
Division/Region 
The division/region dropdown list contains the names of all divisions/regions used by the authority the 
event is running under (if any.)  Select the team’s affiliated division/region or leave the selection blank. 
 
Country 
Select the country that the team represents from the dropdown list.  
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Team members 
This grid lists the current members of the team if any are specified. The number of fencers on a team 
varies based on what kind of team event you are running (45-touch relay, best 5-of-9, mixed gender, 
etc.)   
 
The process of adding fencers to a team works just like the process of adding fencers to an individual 
event. Clicking the “Add Members” button will bring up the Add Fencers to Event window, where you 
can search for the fencers to add to the team. Removing team members is also done in a similar fashion: 
check the fencers to remove and then click the “Remove Checked” button. 
 
Once you have finished creating the team, click the “OK” button to return to the Event Competitors 
window. The newly added team will now be displayed in the competitor list. 
 

If you need to edit a team at a later time, simply click the  button on the team’s row in the list. This 
will return you to the Edit Team window. If the event has already started, you will not be able to edit the 
team members, but you can edit the rest of the team’s information. 
 

Bulk Importing Teams into a CBA Team Event 

CBA team events often have a large number of teams, and each team can have a large number of 
fencers.  Rather than manually entering this data, teams and fencers can be bulk imported from a CSV 
spreadsheet file. 
 
To import a team roster, you must use two specific CSV files.  The first file is a list of teams along with 
their seeding points in each weapon.  The second file is a list of fencers on each team.  Sample CSV files 
in the correct format are included with Fencing Time.  To access these files, locate the Fencing Time 
program group on the Windows Start menu.  Inside this group will be links to the “CBA Team List 
Template” and “CBA Athlete List Template” files, which can be viewed with any spreadsheet program. 
 
To create a copy of the spreadsheets, use the “Save As” option in the spreadsheet program. Be sure to 
save the spreadsheet in an easy-to-find location and use the “Comma Separated Value (CSV)” format. 
 
The team file provides basic information about each team – the club/school name, the division/district 
that the club/school competes in, the (optional) coach’s name, and the seeding points in each weapon.  
Divisions/districts must be indicated using their abbreviated name or left blank.  Seeding points should 
be provided as a numeric value.  If a club/school does not compete in a particular weapon, enter -1 as 
their seeding points. 
 
The athlete file lists the fencers on each team.  You should use a separate athlete file for each gender.  
The format of this file is simple – each row lists the fencer’s first and last name, and the team they fence 
for.  Note that the team’s name must exactly match (in spelling and capitalization) the team name in the 
team CSV file. 
 
To import the rosters into an event, open the event in Fencing Time and click the “Competitors” button 
near the bottom of the window.  Next, click the “Import from CSV” button at the bottom of the window 
that opens.  This will show the Import Teams from CSV Files popup. 
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You will need to specify the team and athlete CSV files - click the “Browse” buttons and navigate to the 
CSV files you wish to import.  Next, click “Import Teams”.  Fencing Time will read the files and list the 
teams in the list below. 
 
Each team has a checkbox next to it, which initially be checked.  A check indicates that the team will be 
imported.  If you do not wish to import a specific team, un-check it. 
 
To review the details of the teams read in from the files, click the “Review Imported Teams” button.  
This will show a popup with the data for the first team: 
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The popup shows the information imported from the CSV files.   (Fencing Time automatically generates 
the abbreviation from the team’s name.)  If you wish, you can change the information on the left side.  
 
You can navigate through all of the teams using the Next and Previous Team buttons.  Once you have 
finished reviewing the teams and making any changes, click “Done” to add the teams to your event. 
 

Tracking Teams in an Event 

As each team progresses through an event, they will fence a number of other teams. It is often helpful 
to centralize the cumulative list of matches each team fences, rather than just relying on the match 
scoresheets.  
 
Fencing Time provides a “Team Tracking Form” that you can print out for each team in your event. To do 
this, click the “Print Team Forms” button in the Event Competitors window. (This button is only present 
when viewing competitors for a team event.)  You can also print a team form for a single team from the 
Edit Team window. 
 

 
 

Each match that a team fences is listed on the next available row in the provided table. When a match is 
being set up between two teams, take each team’s tracking form and fill in the “Opponent Team” 
column on the next available row. You should also specify which round the match is a part of in the 
“Pool or Tableau” column (such as “Pool” or “Table of 32”).  
 
Next, a coin-flip is used to determine which team is the “A” team and which is the “B” team. The fencers 
on the “A” team are (usually) numbered 1, 2, and 3, while the “B” team is 4, 5, and 6. The relay is fenced 
using the match order shown at the top of the form. In the row for the match being set up, circle which 
team is “A” (1-3”) and which is “B “(“4-6”) in the “A/B” column of each team’s tracking form. 
 
In the DE rounds, Fencing Time can do the coin flip for you so that you do not have to do it for each pair 
of teams.  To do the coin flip, click the “Match Draw” button above the tableau.  Select which table (or 
specific bouts) to do the draw for, and then click the green “Draw” button.  The results of the draw will 
be shown in the list at the bottom of the window.  Usually, you will want to print the results of the draw 
so that you can circle the appropriate team A/B on the team tracking forms. 
 
At this point, you should hand the tracking form to its respective team captain and ask them to place a 
number on the row under each team member’s column. This number will indicate which fencer is 
fencing in each position for that match. Any extra fencers are then marked as the “Reserve”. 
 
 

Team tracking forms are not generally used in team events that use the CBA format. 
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On the sample tracking form shown above, the “Founding Fathers” team was selected to be the “4-6” 
team in their match with the “Civil Warriors” team in the DE round of 16, so the organizer circled “4-6” 
on the row. The organizer then handed the form to the captain, George Washington, who decided that 
John Adams would fence in the “anchor” position (in the last bout in the relay, the match between 
fencers #3 and #5.)  To indicate this, he wrote a “5” in Adams’s column. As you can see, Washington 
assigned himself to position #6, Jefferson as #4, and Madison as the reserve for this match. Once he was 
done, he initialed the row and handed the form back to the organizer. 
 

Setting up Team Matches and Printing Match Scoresheets for non-CBA Format Events 

Once you have the team match forms for both teams in the match, you can set up the team match using 
the provided information and print out the match scoresheet. 
 
To set up a team match during elimination rounds, click the “Setup Team Match” button on the active 
bout list in the bout you want to set up. When fencing team matches in a pool, click the “Team Match” 
button under the list of pools. Select the match to set up from the list and click “Setup Match”.  
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The Setup Team Match window shows the two teams and their members.  Under each team name are 
options to set which team is 1-2-3 and which is 4-5-6.  Set the teams accordingly based on the result of 
the coin-flip (this will be set automatically if you had Fencing Time do the draw.) 
  
Once you have the team numbers selected, select the position assignment of each team member as 
indicated by the captains on their respective Team Tracking form. If you would like to assign referee(s) 
for the match, you can do so using the referee dropdowns. 
 
The print buttons will print the scoresheets, either single or in triplicate (one for each team and one for 
the referee.) 
 
If a team withdraws or is excluded prior to the match, you can use the “Withdraw or Exclude a Team” 
button to indicate this – when this happens, you do not need to setup the team match and the 
remaining team is simply marked as the winner. 
 

Entering Team Match Scores for non-CBA Format Events 

Fencing Time will let you enter detailed team match scores in both the pools and elimination rounds. 
You can enter the score after each bout in the team relay so that you have a permanent record of the 
entire match. 
 

To enter team match scores during an elimination round, click the  button on the tableau in the 
bout you want to fence. To access the team match scoresheet during a pool round, click the “Setup 
Team Match” button under the pool list. Select the match for which you want to enter scores from the 
list and click “Enter Scores”. This will show the Team Match Scores window. 
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The Team Match Scores window looks and functions much like a team match scoresheet. The team 
members will be listed in the relay bout order, just like on the scoresheet. 
 
Down the center of the window are two columns for the running score at the end of each bout. Note 
that this is not the number of touches scored in the bout, but the running team score at the end of each 
bout. If Fencing Time detects a score that is out of 
place, such as one where the running total has 
decreased, an error message will appear. 
 
The final score for each team must be entered in the 
bottom score box. This is the score that will be 
recorded for the match. If you do not wish to enter 
detailed match scores for every bout, simply enter 
the final scores in the bottom boxes and click “OK”. 
 
If one team dominates the match and scores five 
touches in every relay, you can quickly enter the 
scores for that column (5, 10, 15, 20, … 45) by clicking 
the “5..45” button above the column. 
 
When a team has four members, the name of each 
team member will be displayed in each dropdown 
list. If you click one of these lists, you will notice that 
the choices are the fencers as initially assigned, as 
well as the reserve fencer. This allows you to change 
the fencer to the reserve if they are used during the 
match.  
 
If a team has only three members, the dropdown lists will not appear since there is no reserve to 
substitute in for another fencer. 
 
To erase the scores for the entire match, click “Clear”. To assign referee(s) for the match, use the 
dropdown lists.   If the team needs to medically withdraw, is excluded, or fails to appear, use the 
corresponding checkbox under the team. 
 

Printing Match Scoresheets and Entering Scores for CBA Format Events 

CBA format events comprise of one or more rounds of pools.  Each match in the pool is a three-bout 
CBA match.  These bouts are generally scored using a custom scoresheet that tracks the fencers used in 
each bout, as well as the scores.  These scoresheets can be printed using the Tools > Print Blank 
Scoresheets and Forms option on the main menu.  Select the “CBA Teams” sub-option under the “Team 
match scoresheet” option in the window that appears. 
 
In some cases, you may already have pre-printed scoresheets (often in triplicate) which can also be 
used.  However, the basic data on the scoresheets is the same.  A sample scoresheet looks like this: 
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The scoresheet has spaces for the two team names, as well as the fencers each team will use in the 
match.  For each pair of fencers, two score boxes are provided.  Finally, there are spaces for penalties 
and the signatures of the referee and team captains. 
 
Since each pool will require the use of many CBA team match scoresheets, these blank forms are usually 
pre-printed in bulk prior to the tournament.  With so many scoresheets, you can quickly get 
overwhelmed with the volume of sheets if they are not organized in some fashion. 
 
In order to make managing the scoresheets simpler, Fencing Time can print the details of each match 
onto labels.  Fencing Time supports two label sizes:  1” x 4” (Avery 8161) and 2/3” x 3 7/16” (Avery 
8366).  
 
The labels are printed in the order that the matches should be fenced.  At the start of each match, the 
next label is applied to the top of a blank scoresheet, the team captains fill in their fencers, and then the 
match is fenced.   
 
A bout label looks like this: 
 

 
 

The label includes the name of the event and round number, which pool and bout this label is for 
(including the competitor numbers in the pool), and the team names.   
 
Notice the barcode and match ID number on the right side of the label.  Match ID numbers are used to 
quickly access the score entry form in Fencing Time, rather than searching for the specific bout among 
all of the pools.  To locate a match, enter the match ID number into the yellow “Score Bout ID#” box 
near the very top of the main Fencing Time window.  If you have a barcode scanner attached to your 
computer, you can further speed up this process by simply scanning the barcode. 
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Entering the bout ID number (either via keyboard or scanned barcode) will bring up the Edit Team 
Match window for that bout.  You can also bring up the Edit Team Match window for a specific bout by 
clicking the mouse in one of the score boxes on the pool display on the screen. 
 

 
 
 
The Edit Team Match window shows both teams.  If you need to swap the sides of the teams, use the 
swap button found between the team names. 
 
If you have already entered scores for one or both of the teams in another match, each team’s fencers 
will be pre-selected to match their positions in the prior match.  Before entering the scores, make sure 
the fencers match the names on the scoresheet just in case a fencer was replaced in the match. 
 
Next, enter the scores for the three matches in the boxes near the center of the form.  If a tie is 
detected, Fencing Time will prompt you to select the winner. 
 
Occasionally, a team will not field a full squad.  When this happens, the team’s C fencer will be left 
blank.  (In the rare case that the B and/or A fencers are also missing, those fencers will also be left 
blank.)  If the opponent team does have a full squad, the team with the short squad will forfeit the bouts 
missing a fencer.  To record this, enter the score as a 0-0 victory, with the winner being the team with 
the full squad. 
 
If both teams have a short squad, you can omit the bout entirely by checking the box between the 
corresponding scores.  This lets Fencing Time know that neither team should be marked as the winner of 
that bout. 
 
After the scores are entered, click “OK”.  The individual CBA scores will appear on the pool display, with 
red scores indicating losses and blue scores indicating victories. 
 

Running High School and Collegiate Tournaments 

Many traditional high school and collegiate tournaments can be run in Fencing Time using the CBA team 
format.  The steps needed to run the common formats are listed below. 
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NJSIAA District and Squad Championships and NEIFA (also known as “IFA Format”) 
 

1. Create the tournament using the NJSIAA authority. 
2. Create each weapon as a team event using the CBA format. 
3. Import the teams and athletes. 
4. Start the event with a round of pools with one single pool. 
5. When the pool is complete, click “Start Next Round” and choose “End the event now” (unless a 

barrage is required). 
6. If there is an individual event, click the “Create Individual Event” button and select the correct 

athletes to participate.  Conduct the individual event. 
 
To calculate the 3-weapon team results, click “Overall Results”, select the three events to include, and 
select the “Combined results” option. 
 
NJIFA Cetrulo Championships 
 

1. Create the tournament using the NJSIAA authority. 
2. Create each weapon as a team event using the CBA format. 
3. Import the teams and athletes. 
4. Start the event with a round of pools.  Select the option offering pools of size 8 and 7. 
5. When the round is complete, click “Start Next Round” and choose another round of pools. 
6. Select the number of pools required for the final round.  Click “More Pool Options...”, then 

select the option to “Create grouped pools” and click “OK”. 
7. When all pools are complete, click “Start Next Round” and choose “End the event now.” 

 
To calculate the 3-weapon team results, click “Overall Results”, select the three events to include, and 
select the “Combined ordinal placements” option. 
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Chapter 14: Event Seeding 

 
As competitors are added to an event, Fencing Time will automatically seed them into the competitor 
list based on the seeding method you have chosen. If a competitor's classification or ranking is changed 
before the event starts, they are re-seeded to reflect this updated data. Changes to a fencer’s 
classification or ranking after an event has started do not affect the seeding for that event. 
 
There are several different ways to seed competitors. In individual events run under the USA Fencing 
authority, the most common way is by using the fencer's classification. At some events, including most 
run under non-USA Fencing authorities, seeding is done using rankings on a point list. Other events use a 
combination of classifications and rankings. The Event Seeding Wizard will assist you in the process of 
selecting a seeding method for your event. 
 
Team events can be seeded using team rankings or points, either user-provided or computed. 
 
When you create an event, you have the option to set the seeding method. You can also set the seeding 
method by clicking the “Change” button next to the seeding method on the “Summary” tab in the event 
window. 
 

Seeding Individual Events Using Pre-Defined Seeding Rules 

Fencing Time contains pre-defined seeding rules for some authorities. If your event is running under one 
of these authorities, the first step in the wizard lets you choose whether you want to create your own 
seeding method or use one of the pre-defined rules. For the USA Fencing authority, Fencing Time knows 
the seeding methods used at national and regional events. 
  
To use a pre-defined seeding rule, select “Use a standard event seeding method” on the Event Seeding 
Wizard. You will then be presented with a list of event types to choose from. You can view the event’s 
seeding rule in the description box below the list. 
 
Once you have selected the rule you wish to use, continue through the wizard until complete. Fencing 
Time will then re-seed your event using the new rule. 
 

Seeding Individual Events Using a Custom Seeding Rule 

Occasionally, you will want to use a custom rule to seed your events. A custom rule can be something as 
simple as seeding by classification, or as complex as seeding by classification plus multiple point 
rankings. 
 
To use a custom rule, select “Choose your own seeding method” on the first step of the Event Seeding 
Wizard. If you are running under the USA Fencing authority, this will be the first decision you need to 
make: 
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In this step, you can choose to seed using weapon classifications, point rankings, or both.  
 
If you select “Weapon classifications only”, fencers are seeded based on their weapon classification 
without regard for point rankings. This is by far the most commonly used method, especially at local 
events. 
 
If you choose “Fencer ranking(s) only”, or if you are running under an authority that does not have any 
pre-defined seeding rules, you will be asked to select which point list to use for seeding. This will seed 
the fencers based on their rank on the point list. Fencers without rankings will be ordered randomly. 
 
If you choose the third option, “Both classifications and rankings”, you will have several more choices to 
make: 
 

 
 
First, you will specify which point list to use for seeding. When using a point list for seeding, fencers with 
identical letter classifications are sorted based on point ranking, then by letter and year. For example, a 
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fencer who has an A23 ranked #3 will be seeded higher than a fencer with an A24 ranked #6. Both of 
these fencers will be seeded ahead of all other A-rated fencers who have no point ranking. 
 
The next question relates to the concept of “protection”. Fencers who are “protected” get seeded ahead 
of all other fencers, regardless of their letter classification.  
 
If you want to protect fencers, you can select which rank the protection extends to. By protecting the 
top 32 fencers, for example, only fencers ranked 1-32 are protected. So, if there is only one fencer 
present with a rank in the 1-32 range, only that fencer will be protected.  
 

 
 
The next step in the wizard lets you use a secondary point list for seeding if desired. As the wizard 
explains, a secondary point list will be used to seed unranked fencers (on the primary point list) ahead of 
fencers without rankings on either list. 
 
Once you complete the Event Seeding Wizard, Fencing Time will reseed your event using the new 
method. You can see the updated seeding by clicking the “Seeding” button at the bottom of the event 
window. 
 

Seeding Team Events 

Teams are seeded using a different process than in individual events. While individual events are seeded 
using fencer classifications, point ranks, or a combination of both, team events can be seeded five 
different ways: 
 

1. by a user-supplied ranking value, 
2. by a user-supplied point value, 
3. by a computed point value that a represents composite team strength based on the 

classification and (optionally) point ranking of the individual team members, 
4. by a computed rank using the sum of the top three ranked fencers on a point list, or 
5. by a composite team rank computed from the final places of the team competitors in an 

individual event at the same tournament. 
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When you change the seeding method for a team event, the Event Seeding Wizard will guide you 
through the seeding choices. 
 

 
 
 
Depending on which authority your event is being run under, as well as the type of team event, there 
may be additional seeding options available.  The most common options are described below. 
 
The first option seeds teams based on a user-supplied ranking. When you choose this option, you will be 
able to assign each team a rank when you edit the team. 
 
The second option is like the first but allows you to use an absolute point value rather than a rank. The 
point value can be set when the team is edited. Fencing Time will seed the team with the most points 
first, followed by the team with the second-most points, and so on. 
 
The third option, which is only available to events running under the USA Fencing authority, seeds teams 
using the formula used by USA Fencing at national events. This method uses the best three fencers’ 
weapon classification and ranking to compute the team’s point value. 
 
The fourth option seeds the fencers using the sum of the ranks of the top three fencers on a specific 
point list.  So, if the team consists of fencers ranked #1, #2, and #3, their computed ranking will be #6, 
which seeds ahead of a team with the #4, #5, and #6 fencers (with a computed rank of 4+5+6=15.) 
 
The final option lets you seed teams based on the performance of the team members in an individual 
event run as part of the same tournament. This option takes the results of the best three fencers in the 
specified event and computes a composite team rank based on those results. 
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Chapter 15: Rounds 

 
Every event is composed of one or more rounds. The purpose of each round is to generate a seed order 
for the competitors, to narrow down the field of competitors, or both. When a round results in only one 
competitor who has not been eliminated, the event is finished and that competitor is declared the 
winner. 
 

Starting Rounds 

To start the next round of an event, simply click the green “Start Next Round” button in the event 
window. If you have not set the option “Select rounds automatically based on format” on the Summary 
tab for the event, you will be presented with the Select Next Round window.  
 

 
 
In some events (mainly World Cups), the format specifies that the top seeded competitors should get a 
bye past the round (also known as being “exempt” from the round.)  If you wish to give byes to some 
competitors, you can do so by checking the box and choosing how many byes to give.  
 
Under the “byes” option is a list of the different rounds that Fencing Time supports. When presented 
with this list, some options may be disabled. This is usually because that option is either unnecessary or 
does not make sense for your event. For example, if you have 8 competitors left, you can't run a 
repêchage from 16 or 32 since you don't have enough fencers to do so. 
 
Once you select which type of round you want to run, the round will start by prompting you for any 
further setup information it normally would require.  
 
Finally, you can select the option to end the event now. This will take the results from the last round and 
use them as the final event results. Under normal circumstances, Fencing Time will automatically end an 
event if it has determined that there is only one competitor remaining who has not been eliminated. 
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Ending Rounds 

To end the current round, click the green “Start Next Round” button in the event window. If the current 
round is the final round, click the “Finish Event” button.  
 
Note that the “Start Next Round” and “Finish Event” buttons will not become active until all of the 
scores are entered. You cannot finish an incomplete round.  
 

Aborting Rounds 

Under rare circumstances, you may need to abort the current round in an event. A round should only be 
aborted if it turns out that some kind of serious error was made when the round was set up. 
 
When you abort a round, all scores, results, and withdrawals in that round are lost. The event will revert 
to the state it was in before the round started as if it had never taken place. Once you abort a round, 
there is no way to undo this action! 
 
Only the current round can be aborted. If you want to abort a round that has already been completed, 
you must abort each round which has taken place since that round. 
 
To abort the current round, click the “Abort Round” button in the event window. You will need to 
confirm your decision twice to proceed. 
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Chapter 16: Pool Rounds 

 
Pool rounds are very common in fencing events. Many formats include at least one round of pools. The 
purpose of pool rounds is to generate a new seed order for all of the competitors in the event. In some 
cases, some competitors will also be eliminated from the tournament. All of these decisions are made 
based on each competitor's overall performance in the pools. 
 
Pools are fenced in a round-robin format where each competitor fences all of the other competitors in 
their pool. In an individual event, bouts are fenced to five touches in a maximum of three minutes. In 
most team events, each pool bout actually is a 45-touch relay fenced between two teams. 
 
It is preferable to select pools comprised of six or seven competitors each if possible. However, it is up 
to the bout committee to decide on what the best pool size is given the situation. Pools in most 
competitions are composed of between five and seven competitors.  
 

Setting up Pools 

The first step when starting a pool round is to set up the pools. This involves selecting the number and 
size of the pools, deciding how many competitors will be promoted to the next round based on the pool 
results, and finally doing the pool assignments.  
 
Fencing Time will start the process by determining all of the 
possible combinations of pool sizes based on the number of 
competitors remaining in the event. Select the combination of 
pools that you wish to run from the list. 
 
Next, you need to decide how many competitors will be 
promoted to the next round based on the results of the pools. 
You may choose to promote all competitors, a percentage of 
the field, or a specific number.  
 
Fencing Time offers a number of other options for the pool 
round. These options are discussed in the next section. 
 
Once you have selected the number of pools to use, the 
number of competitors to promote, and have set any desired 
options, click “OK”. Fencing Time will then spend a few 
moments assigning competitors to the pools. This is a very 
complex process where the competitors are assigned to the 
pools in such a way as to preserve the initial seed order, but also to avoid conflicts in each pool. When 
conflicts are detected, Fencing Time will swap competitors between pools in order to resolve those 
conflicts. 
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Pool Round Options 

Fencing Time offers a number of options for customizing the pool round. These options are infrequently 
used but are available if your event requires them. The options are accessed by clicking the “More Pool 
Options…” button when setting up the pool round. 
 
Maximum bout score 
Generally, the maximum score in a pool bout is 5. If you need 
to change this value, enter the new maximum score in the 
box. Note that this option is not available in team events. 
 
Teammates share the same ______ 
Each pool uses a bout order based on the number of 
competitors in the pool. If there are multiple competitors of 
the same affiliation, they are considered “teammates”. When 
teammates are present in a pool, an alternate bout order is 
used which makes teammates fence each other first (to 
prevent collusion.)  This option lets you decide which specific 
affiliation to use when evaluating if the competitors are 
teammates. By default, clubs are used. In events that use FIE 
rules, countries are the default. The dropdown list lets you 
change the default setting if necessary. 
 
Randomize competitors within each pool 
This option causes the competitors to be placed in the pool in a random order once they have been 
assigned. 
 
Use optimized pool layout algorithm 
When this item is selected, Fencing Time will use a more intelligent pool layout algorithm rather than 
the more basic snaking algorithm.  This generally tends to produce better pools than the basic 
algorithm. 
 
Allow swapping of ranked fencers of phase 2 of pool layout 
When this item is selected, Fencing Time may swap ranked fencers in order to resolve conflicts between 
competitors.  These swaps take place during the second phase of the pool layout, after the initial 
“snaking” has been done.   
 
Make last pools smaller when using uneven pool sizes 
When this item is selected, Fencing Time will layout the competitors in such a way that if the pool sizes 
are uneven, the larger pools will always start at pool #1.  The practical effect of this is that the top-
seeded competitors will be guaranteed to be placed in one of the larger pools.  
 
Create “Sharks & Minnows” pools 
Selecting this option lets you run the pool round as a “Sharks & Minnows” round. This is usually done 
after an initial round of pools that uses the standard format. The “Sharks & Minnows” pools are set up 
by putting the top seeded competitors (“sharks”) into their own pool(s), and the remaining competitors 
(“minnows”) are put into the standard pools. At the end of the round, the “sharks” are ranked against 
one another and are seeded 1 through N (where N is the number of “sharks”) and the “minnows” are 



 

 

 C
h

ap
te

r 
1

6:
 P

o
o

l R
o

u
n

d
s 

105 
 

then seeded after that. This format gives the top-seeded competitors more quality bouts against other 
top-seeded competitors, and similarly, gives the “minnows” more bouts against competitors at their 
own level. 
 
Create “grouped” pools 
Another option for creating pools is to simply divide the pools into groups. For example, if you have 
selected pools of size 7, the first 7 competitors will be placed in pool #1, the next 7 in pool #2, and so on. 
At the end of the round, the results will also be computed based on these groups, i.e. the competitor 
who loses all of his or her bouts in pool #1 will be ranked 7th overall, and the competitor who goes 
undefeated in pool #2 will be ranked 8th overall. 
 
Conflict minimization 
When competitors are assigned to pools, Fencing Time attempts to avoid conflicts with other 
competitors in the pool. The options in this section let you choose what criteria should be used when 
determining if two competitors conflict with each other. 
 

Laying out Pools 

Once the number of pools and layout options are set, Fencing Time will perform the layout process. 
After a few moments, the results of this process will be shown on the newly-created tab for the pool 
round. You will now have the opportunity to review the pools and make any changes that you feel are 
necessary. 
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Each pool is shown listing the competitors with their initial seed, their club(s), division, country, and 
classification. If you are using a point list for seeding, each fencer’s point rank will also be shown. The 
“P” column indicates which fencers are protected based on their ranking.  
 
Like all other data grids in Fencing Time, you can customize the columns shown in each pool by right-
clicking on the header row. All of the pools will be updated to reflect the customizations.  
 
Each pool also lists a “strength” value. This number is calculated based on the classifications of the 
competitors in each pool. Ideally, each pool will be relatively close in strength so that no one pool is 
much easier or harder than another. 
 
If Fencing Time detects any errors in your 
pools, a warning icon will appear under 
the problem pool. Hovering your mouse 
over the icon will show the error details. 
Errors include pools that have too many or 
too few competitors, and pools that 
contain too many or too few competitors 
from the same club, division, or country. 
In addition, Fencing Time will warn you if multiple competitors have the same last name - this is often a 
warning that two fencers from the same family are in the same pool, which you might want to avoid. 
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The true power of the Layout Pools display, however, is in the ability to rearrange the competitors as 
you desire. If you want to move competitors between pools, simply drag-and-drop them from one pool 
to another. You can move competitors anywhere you want, although you should only do so with an 
understanding of how your changes affect the seeding.  
 
You can also quickly move a competitor to another pool by right-clicking on the competitor’s name. This 
will show the Move Competitor window, which lets you quickly choose which pool the competitor 
should be moved to. This is especially helpful if you have a lot of pools and can’t see them all at once. 
 
Below the pool competitors is space where you can enter the strip number and time that the pool will 
be fenced. Fencing Time offers advanced features for assigning strips and times, which are described in 
a the “Assigning Strips and Times” section below. 
 
Each pool also has a checkbox marked “Use teammate bout order”. If this box is selected, Fencing Time 
will rearrange the competitors within that pool (after you have finished laying out the pools) to generate 
a bout order where all members of the same club/division/country fence each other first. If you do not 
select this option, then the standard bout order for the pool will be used. 
 
Each pool also offers the ability to select two referees. The process of assigning referees will be 
discussed in the “Assigning Referees to Pools” section below. 
 
Once you have finished laying out the pools, you can officially start the pool round by clicking the green 
“Start Pools” button in the lower-right corner. Once this is done, the pools will be visible to the fencers if 
you are using secondary display devices at the venue or pushing live results to the internet. 
 
There are several buttons and dropdown menus above and below the displayed pools which provide 
access to more features: 
 
Assign Strips and Times 
This button is used to assign strips and times to the pools and is discussed below. 
 
Assign Referees 
This button is used to assign referees to the pools and is discussed below. 
 
View → Referee Strip Assignments 
This menu option allows you to quickly view and print out a list of the referee pool assignments 
alphabetically by referee name.  
 
View → Pool Layout Details 
This menu option will let you review some of the decisions Fencing Time made when laying out the 
pools, such as which conflicts were encountered and how they were resolved. 
 
Display Options → Keep Competitors in Seeded Order 
This menu option, when checked, will display the competitors in seeded order as you rearrange them. If 
left unchecked, competitors will be shown in the actual order they will appear in the pool. 
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Display Options → Show (various) Conflicts 
This set of menu options control which conflicts Fencing Time will highlight on the pool display. Note 
that turning off the display of certain conflicts will also prevent Fencing Time from warning you about 
any conflicts of that type, so you should only disable conflicts that you truly do not care about. 
 
Display Options → Show Referee Selection Lists 
This menu option will hide or show the referee selection lists under each pool. This can be helpful if you 
want to see a more compact view of each pool. 
 
Find Competitor 
In the upper-right corner is the find competitor box, which you can use to quickly locate a competitor by 
name. 
 
Find Country and Division 
Next to the find competitor box are two dropdown lists, one of countries and one of divisions.  When a 
country or division is selected, all fencers from that country or division will be highlighted in the pools.  
This can be useful to make sure fencers of the same country or division are equally distributed across all 
pools. 
 
Print Summary 
Clicking this button will print the pool assignments in a compact form (multiple pools per page.)  This 
printout can be very useful for the head referee, and also for posting for fencers to view. 
 
Print With Scores 
This button prints a compact summary display of the pools including the scores and pool results.  
 
Strip Assignments 
This button shows a list of pool, strip, and time assignments for each competitor listed alphabetically. 
This is often printed out and posted at the venue so the competitors will know where to report. 
 

Adding Fencers to Fill-Out the Pools 

At FIE events such as World Cups and Grand Prix, the host country usually is allowed to add additional 
fencers to the event.  The number that can be added usually is equal to the number of pools of six – this 
way, the added fencers will bring these pools to a size of seven. 
 
There are two approaches to adding these additional fencers: 
 

1. Compute the number of pools of six prior to starting the event and then add the additional 
fencers to the competitor list.  The additional fencers will be seeded into the competition based 
on their rank (although they are usually unranked) and placed in the pools when the pool layout 
is done.  This is generally the preferred method. 

2. Start the event without the additional fencers, and then add the additional fencers during the 
pool setup phase.  This will place the additional fencers as the bottom-ranked fencer in each 
pool of six. 

 
To use the first approach, simply add the fencers to the competitor list prior to starting the event, and 
then proceed as you normally would.  To use the second approach, start the event without the fencers.  
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When you are on the pool layout screen, click the “Add Fencers” button on the blue bar above the pool 
display.  Fencing Time will prompt you to search the database for the additional fencers (or create then 
if necessary.)  Once selected, the fencers will be added to the pools with available slots. 
 

The Pool Round Display 

Pool rounds, like all other rounds, are shown on a tab in the event window. It is here where you will 
manage the pools and enter scores. The pool display has a number of important elements, each 
described below. 
 

 
 
View Options 
At the top of the pool window, two tabs control which view you see. The “View by Pool” tab shows the 
pool-by-pool view with the pool scores as shown above. The “View All Pools” tab shows all of the pools 
using the condensed format similar to the display used when laying out the pools. 
 
Pool List 
To change the pool being viewed, select it from the list on the left. Viewing a different pool will not 
affect the scores that have been entered; they will still be there when you switch back to that pool. 
Pools that are still fencing are indicated with crossed swords, and those that have had all of their scores 
entered appear with a flag icon. The number of pools still underway is shown above the list. 
 
The number in [brackets] after the pool number is the pool size.  If the pool has been assigned to a strip, 
it will be shown after the pool size in (parenthesis). 
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Print Pools 
Under the pool list are buttons used to print the pool scoresheets – either the current pool or all pools. 
 
Schedule DE Bouts 
This button allows you to pre-assign strips and times for the next DE round.   
 
Temporary Results 
As completed pools are entered, Fencing Time can generate temporary round results.  These results 
include a prediction on whether each fencer will be promoted or eliminated after the pools are 
complete. These predictions are just estimates based on the promotion percentage and should not be 
considered official – they are just there to give the fencers an idea of where they stand overall. 
 
Change Promotion 
Click this button if it is necessary to change the number of fencers promoted from the pool round while 
the pools are being fenced. 
 
Team Matches 
When running team events, the “Setup Team Match” button will be present. Clicking this button will 
allow you to set up a match between two teams and print out the team match score sheet. See the 
“Team Events” chapter for more information.  You can also set the strip and time for each team match 
since you generally will fence team pools on multiple strips at the same time. 
 
Strip and Time 
The strip and time can be specified in the boxes above the pool. Times can be entered using a 12- or 24-
hour clock. 
 
Manage Pool Competitors, Pool Bouts, and Display Option Menus 
These three dropdown menus offer a number of options and will be described in the “Other Pool 
Options” section below. 
 
Score Boxes 
In the center of the window are the score boxes where you enter the bout scores. To enter pool scores, 
simply click the box that you want to enter and type in the score. You can also navigate between the 
score boxes using the arrow keys. Winning scores are shown in blue, and losses are shown in red. 
Fencing Time will automatically determine which score is the winner and which is the loser by 
comparing the two numbers. 
 
In the case of a tie score, a popup will appear that will prompt you to select the winner. The scores will 
still be reported as tied (such as V3-D3) but the winner will be marked in blue and the loser in red. 
 
Score Results 
To the right of the scores are the result columns. These columns will automatically be computed by 
Fencing Time once all of the scores have been entered. The columns are labeled “V”, “TS”, “TR”, “Ind”, 
and “Pl” which stand for “Victories”, “Touches Sent”, “Touches Received”, “Indicators” and “Place”. 
These columns are identical to those on a standard pool sheet. 
 



 

 

 C
h

ap
te

r 
1

6:
 P

o
o

l R
o

u
n

d
s 

111 
 

Once you have entered all of the scores, it is a good idea to double check that the indicators computed 
by Fencing Time match those that you have computed on the score sheet. This is a good way to make 
sure you did not mistype any of the scores. 
 
Referees 
The referees assigned to the pool are displayed under the score display. The list of referees shown will 
be limited to the referees present in this round. 
 
Find Competitor 
To quickly locate a competitor in the pools, enter their name in the text entry box at the bottom of the 
window or select them from the dropdown list. Once selected, the display will switch to the pool 
containing that competitor and their name will be highlighted. 
 
Font Size 
The size of the font used to draw the score boxes can be adjusted to your liking using the slider in the 
lower-right corner of the window. 
 

Assigning Pool Strips and Times 

Fencing Time provides an easy way to assign 
strips and start times to the pools in your event. 
You can assign strips individually or by lettered 
“pod”, in one, two, or three flights. 
 
To assign strips, select the “View All Pools” tab at 
the top of the pool display on the pool round tab. 
Then, click the “Assign Strips and Times” button 
above the pool display. 
 
The top part of this window lets you specify the 
parameters for the strip and time assignments. 
Once you have set this up, the green “Assign 
Strips & Times” button applies the settings to the 
pools listed on the grid. 
 
To assign strips automatically, enter the strip 
numbers to use in the “Strips” box. You can list 
strips individually separated by commas, or 
ranges using hyphens. For example, if you enter 
“1,3,5-9,14,16”, Fencing Time will interpret this 
as strips 1, 3, 5, 6, 7, 8, 9, 14, and 16. You can also 
use lettered ranges such as “A1-4” which would 
mean strips A1, A2, A3, and A4. 
 
If you are using the standard four colored strips (blue, yellow, green and red) for your event, you can 
quickly populate the strips box with the colors by clicking the color button. 
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If you were to click “Assign Strips & Times” now, Fencing Time would assign the strips to the pools in the 
order you listed. However, if there are more pools than strips, the excess pools would remain 
unassigned. 
 
When you have more pools than strips, the standard approach is to “flight” your pools. This sends out 
the pools in waves, either at pre-assigned times, or as soon as strips become available as the first flight 
finishes. 
 
When assigning strips in waves, you can either leave the unassigned strips blank, or use the “Set TBD” 
button to mark those pools’ strip assignment as “to be determined”.  
 
If you want Fencing Time to flight your pools, you can check the “Assign strips in later flights”. This will 
cause Fencing Time to re-use the strips in order, until all of the pools have strips assigned.  
 
Pools also can be assigned start times by using the flight time boxes. Enter a time (in 12 or 24 hour 
format) in the box for each flight that you wish to assign. All of the listed strips will be assigned to the 
first flight time, and then reassigned at the second flight time. If a third flight time is specified, the strips 
will be reassigned at the third flight time. 
 
If Fencing Time detects that there are pools without a strip assignment, a warning will be displayed 
above the grid. Similarly, if you have accidentally assigned the same strip to two pools at the same time, 
you will be warned. 
 
At any time, you can edit the strip and time directly on the grid if you wish to make customizations. 
Clicking “Clear All” will erase all strip and time assignments. 
 
If you are running a team event with a round of pools, strips and times are not generally assigned to a 
pool.  Instead, you are more likely to assign each team match in the pool to a specific strip at a specific 
time.  To set these match times, click the “Setup Team Match” button under the pool list when viewing 
the pool you want to schedule.  Enter the strip and time of each match by directly editing the cell on the 
grid.  
 

Assigning Referees to Pools 

Referees can be assigned to pools either during the pool layout phase, or after the pool layout has been 
completed. You can assign referees to each pool manually, or you can have Fencing Time do the 
assigning for you.  For pools in team matches, you can assign referees to the individual matches within 
the pools. 
 
Before starting the referee assigning process, you should make sure the referees that you wish to use in 
the pool round have been added to the event. To do this, click the “Referees” button on the grey bar at 
the bottom of the pool window. Add the referees using the process described in the “Managing 
Referees” chapter. Once the referees have been added to the event, you can proceed with either 
manual or automatic assignment. 
 
To assign referees manually, simply select the referee(s) that you want to assign to each pool from the 
dropdown lists under the pool.  This option is not available in team events. 
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When assigning referees on the “View All Pools” display (or while doing the initial pool layout), any 
referee conflicts with one of the competitors in the pool, will appear as a warning and the conflicting 
fencers will be highlighted. Conflicts are not shown when assigning referees on the “View by Pool” 
display. 
 
To automatically assign referees, click the “Assign Referees” button on the blue bar above the pools on 
the “View All Pools” display. For individual events, this will open the Assign Referees window. 
 

 
 
The top half of the window shows all of the referees assigned to the pool round in your event. Each 
referee is shown with his or her assignment status, rating in the event’s weapon, and affiliations. You 
can filter this list based on status using the checkboxes on the right. You can also print the referee list 
using the button on the right. 
 
The bottom half of the window lists the pools and their assigned strips and times. Fencing Time’s referee 
assignment process works best if strips and times have been assigned, so you should generally do that 
first. Two referees may be assigned to each pool. 
 
The middle section of the window contains two large buttons for assigning and clearing referees. To the 
right of these buttons are the assignment rules to use when assigning referees automatically. If you wish 
to assign more than one referee per pool, check the “Assign second referee” box. If you want to only 
assign referees to pools at a specific time, check the box and set the time from the dropdown list. 
Finally, you may select which affiliations to use when minimizing conflicts between the referees and the 
pool fencers. 
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To select referees for assignment, use the checkbox on each referee’s row (or use the Select All and 
Select None buttons on the right.)  Once you have chosen the refs to assign and set the assignment 
rules, click “Assign Selected Referees” and Fencing Time will assign referees to the pools. 
 
When assigning referees, Fencing Time skips pools that already have a referee assigned. This allows you 
to assign referees in “waves” – you can select a group of referees, assign them, then select a second 
group, assign them, and so on. You can use this approach to assign your senior referees first, and then 
assign your developmental referees (to be paired with senior referees.)  
 
You can, at any time, also assign a specific referee to a specific pool by selecting their name in the drop-
down list on the pool’s row. 
 
If Fencing Time detects that a referee has been assigned to two pools scheduled for the same time, a 
warning will appear, and the referee will be highlighted in red in the conflicting pools. 
 
The process for assigning referees to team matches is nearly identical to the process for assigning 
referees to pools.  When you click the “Assign Referees” button, you will be presented with a list of 
team matches (from all of the pools): 
 

 
 
Use the checkboxes to select which team matches for which you want to draw referees, then click “OK”.  
This will take you to the “Assign Referees” window as before, but now the pools will have been replaced 
by the team matches that you selected.  The process for assigning the refs from this point on is identical 
to the process used for individual events. 
 

Other Pool Options 

The dropdown menus above the pool display when in “View by Pool” mode contain options to allow you 
to manage competitors, bouts, and how the pool is displayed. 
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Manage Pool Competitors → Withdraw/Exclude/Scratch a Competitor 
If you need to withdraw, exclude, or scratch a competitor from the pool, or undo a previous withdrawal, 
exclusion, or scratch, you can do this using the corresponding menu item. For complete details on 
withdrawals, scratches, and exclusions in the pool round, see the section later in this chapter. 
 
Manage Pool Competitors → Reorder Competitors in this Pool 
You can rearrange the competitors in the displayed pool by selecting the competitor and then clicking 
the up/down arrows to the right of the list. Moving competitors will not affect their scores, so this can 
be done whether scores have been entered or not. 
 
If you are using the teammate bout order, moving a competitor may force Fencing Time to switch to the 
standard bout order, since the teammate order expects competitors to be in specific places within the 
pool.  
 
Manage Pool Competitors → Move a Competitor to another Pool 
Sometimes it is necessary to move competitors between pools once the pool round has started. This 
should be done carefully since it can cause affiliation conflicts between competitors. Moving 
competitors also overrides the seeding that Fencing Time used when originally laying out the pool, so 
care should be taken to keep the pools balanced. 
 
To move competitors between pools, select the competitor from the list and click the “Move Competitor 
to Another Pool” button. Competitors can only be moved between pools if they do not have any scores 
recorded. Fencing Time will alert you if you attempt to do so. 
 
Manage Pool Competitors → Add a Latecomer to this Pool 
This option, which is only available if the pool round is the first round in the event, is used to add a 
competitor to the currently displayed pool. This is very handy if you need to add someone who shows 
up late to an event. When adding an individual, you will be taken to the Add Fencers to Event window 
where you can search for the fencer that you want to add. When running a team event, you will be 
shown the Edit Team window where you can create the late-coming team. Once you have done this, the 
late fencer or team will be added to the pool.  
 
Pool Bouts → View the Bout Order 
This option will display the bout order in use by the displayed pool, either the standard or teammate 
order. You may toggle between bout orders using the “Change” button at the bottom of the Pool Bout 
Order window. When the teammate bout is selected, Fencing Time may rearrange the competitors in 
the pool in order to ensure teammates fence each other first.  
 
Pool Bouts → Print Pool Bout Tickets 
This option will print out “pool bout tickets”, which are small tickets for each bout in the pool indicating 
the bout number and fencers in each bout.  These tickets are often used when fencing large pools (10 or 
more fencers) across multiple strips.  These tickets, printed 20 per page and collated, are cut up and 
used by the referees to record the scores for each bout.  This record of bout scores helps sort out any 
errors that may occur when filling in the pool scoresheet. 
 
Pool Bouts → Clear All Scores in this Pool 
Selecting this option will erase all scores in the displayed pool. 
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Pool Bouts → Fill this Pool with Random Scores 
This option fills the displayed pool with random scores, which is a handy way to generate data when 
running a test event. 
 
Pool Bouts → Fill all Pools with Random Scores 
This option is identical to the last option, except that it operates on all pools rather than just the 
displayed one. 
 
Pool Bouts → Export/Import pool to/from VSM 
These options are used to exchange the current pool’s information with the Virtual Scoring Machine 
(VSM) software.  
 
Display Options 
The options on this menu allow you to customize the information shown on the pool display. 
 

Withdrawals, Exclusions, and Scratches 

If a competitor medically withdraws, is excluded, or fails to appear during a pool round, their results are 
annulled, and they are removed from the pool. They will be displayed below the competitors that 
remain when the round completes. 
 
If the pool round is the first round of the tournament, withdrawals, exclusions and scratches will cause 
the competitor to be marked as “DNF” (did not finish). In all cases, the competitor is effectively removed 
from the entire event and treated as if they had never participated. When running events under the USA 
Fencing authority, this can affect the classification level of your event. For example, if you have exactly 
15 fencers and are expecting the event to be a D1-classified event (as according to the USA Fencing 
Event Classification Chart), if someone is black-carded during the first round of pools, the event will now 
be treated as if it has only 14 fencers and no longer will qualify for a D1 classification. 
 
It is important to note that a medical withdrawal or exclusion in the pool round causes the competitor’s 
results to be annulled even if they have completed their pool. If a competitor completes his or her pool 
bouts and then wishes to withdraw, you should start the next round and then do the withdrawal. Only 
withdraw/exclude a competitor in the pool round if they do not complete all of their bouts. 
 
To remove a competitor, select Withdraw/Exclude/Scratch a Competitor on the Manage Pool 
Competitors dropdown menu above the pool containing the competitor. After selecting the reason for 
the removal, the competitor and all of their scores will be removed from the pool. The competitor and 
scores will be shown as hashed-out on the pool display.  
 
If you need to undo the removal, select Undo Withdrawal/Exclusion/Scratch on the same menu. Note 
that any scores previously entered for the competitor will not be restored when they are re-added to 
the pool; you must re-enter these if necessary. 
 

Finishing the Pool Round 

Once you have entered all of the scores in all of the pools, the “Start Next Round” button will turn 
green. Clicking the button will begin the process of ending the pool round. 
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If the round prior to the current round was also a pool round, you will have the option to combine the 
round results. For more information on combined pool results, see the following section on Combined 
Pool Rounds. 
 
Once the round results have been compiled, you will see the Pool Round Results window. The overall 
round results are shown with the status of each competitor – either “Advance” or “Eliminated”. This is 
based on the number of competitors you chose to promote when setting up the pool round. If you need 
to modify this selection, click “Change” and make the necessary adjustments. The round results will be 
re-computed based on your new selection. 
 
If there is a tie between competitors at the breakpoint between those advancing and those eliminated, 
all competitors with the tied seed will be promoted. For example, if there are three competitors tied for 
16th place and you select the option that would promote the top 16, Fencing Time will automatically 
promote the 18 competitors (numbers 1 through 15 and the three tied for 16th). 
 

Combined Pool Rounds 

Upon ending a pool round, Fencing Time looks to see if the prior round was also a pool round. If that is 
the case, a popup will appear giving you the option to combine the results.  
 
If you select the first option, then the current round's 
results will not be combined, and the next round will be 
seeded as normal. If you select the second option, the 
results will be combined with specified number of 
preceding pool rounds and the combined results will be 
used as the seeding for the next round. 
 
The method used to combine results is simple. Each competitor's results from each of the rounds to 
combine are added together. Victories, touches sent, touches received, and indicators are each added to 
the corresponding number in the prior round(s) to arrive at a composite result. 
 
To compute the competitor's ratio of victories to bouts fenced (V/M), the combined number of victories 
is divided by the combined number of bouts fenced. This is the only way to properly account for pools of 
different sizes. 
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Chapter 17: Direct Elimination Rounds 

 
Direct elimination (DE) rounds are part of virtually every fencing event. DE rounds are also known as 
“single elimination” because competitors are eliminated after one loss. At the end of a DE round, there 
are a fixed number of finalists or a single winner if the DE tableau is fenced to completion. 
 
In individual events, DE bouts are usually fenced to a score of 15. Veteran events go to a score of 10.  
The number of touches scored in younger age groups tends to vary based on the authority under which 
the event is run. In a team event, DE bouts are usually 45-touch relays between two teams (depending 
on what kind of team event is being used.) In all cases, the final bout score is irrelevant - all that counts 
is the victory or loss. Winners will progress to the next “table” in the tableau, and losers will go home. 
 

Setting up the DE Round 

Setting up a DE round is starts with the Elimination Round Options window: 
 

 
 

The first option lets you change the type of scoresheet used in the DE bouts. 
  
The next option lets you decide how many competitors will remain at the end of the DE round. Fencing 
Time will generally assume that you want to run your DE round until a single competitor remains. This is 
the most common scenario. However, it is possible to run a DE round until you have a specified number 
of competitors left by selecting it from the dropdown list. 
 
The video option lets you specify from which round you will use video replay.  Fencing Time uses this 
information to set some default values when assigning strips and referees in the video bouts. 
 
If your DE round contains the semifinals, you may optionally choose to fence-off for third place. Use the 
checkbox to indicate this. You can also change this later via the DE Round Options, discussed later in this 
chapter. 
 
In some event formats (mainly World Cups), the top-seeded competitors are seeded into the tableau by 
randomizing them in pairs. If you wish to do this, check the box and specify the range of seeds to 
randomize in pairs. Leave this unchecked if you do not wish to randomize any of the top competitors. 
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Once you have chosen the DE options, you will be shown the Delay Tableau Posting window.  This 
window offers you the option to delay the posting of the tableau for a specified period of time.  During 
this time, the tableau will not be shown on the internet live results nor screens at the venue.  Instead, 
the pool results will continue to be shown so that the fencers can review the results and report any 
errors. 
 
If a fencer reports an error in the pool scores, this delay will give you the opportunity to correct the 
error before the tableau is posted (by aborting the DE round, fixing the score in the pool, and re-starting 
the DE round.)  Since re-starting the DE round will re-randomize tied fencers, the delay avoids the 
confusion that would arise if the randomization pairs fencers with different opponents after the tableau 
is re-created.  The fencers will only see the final tableau after all corrections are made. 
 
While the tableau posting is delayed, however, you will still be able to prepare the bout scoresheets, 
assign strips and referees, etc.   (Of course, if errors are reported, this work will need to be re-done.)  
The delay countdown timer is displayed in a large red box in the upper-right corner of the tableau, along 
with controls to adjust the delay time, pause the timer, or release the tableau immediately. 
 
If the delay timer expires and you decide that you want to re-enable it, you can do so using the Display 
Options → Restart Tableau Display Timer menu option. 
 

The DE Round Display 

DE rounds, like all other rounds, are shown on a tab in the event window. It is here where you will enter 
all of the DE bout scores. 
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The DE round display should look very familiar since it is modeled directly after a standard DE 
scoresheet. You can adjust the font size used to draw this display using the slider in the lower-right 
corner. You can also view certain parts of the tableau by using the “View” dropdown list at the bottom 
of the window. 
 

The DE Tableau 

The majority of the DE display window is taken up by the DE tableau. Depending on the size of the 
tableau, you may need to use the scroll bars to see it entirely. 
 
The ordering of the competitors in the tableau is based on their seed. Each unfenced bout has two 
buttons in the space where the winner’s name would appear. The top button is used to enter the results 
of the bout. The bottom button is used to set bout options such as the start time, strip number, and 
referees as well as to print out the scoresheet for the bout. For more information on printing bout 
scoresheets, see the Printing Scoresheets section below. 
 

The Active Bout List 

The right side of the DE display shows the active bout list, which lists all of the bouts that can be fenced. 
By default, the bouts are ordered in table order (from top to bottom) but you can choose to order them 
by time using the checkbox.  This entire active bout list can be hidden from view by clicking the arrow 
button near the top of the list.  
 
Each active bout in the list shows which table it is in, such as the 
table of 16. To the right of this are the competitors. Hovering 
the mouse pointer over a competitor will show that 
competitor’s club/division/country affiliation (if any.) 
 
On the right side of the bout, the status is displayed. If a clock is running on the bout (i.e. a fencer is 
taking their 10-minute break between bouts), the time remaining on this clock is shown. You can mark 
bouts as being fenced on-strip by checking the box to the right of the status. 
 
Under the status is a box where you can assign a strip number to the bout, as well as mark the bout as 
printed or not. Finally, a dropdown list lets you quickly set the bout referee. When fencing a team event, 
the referee dropdown list is replaced by a “Setup Team Match” button, which you can use to set up the 
team match and print the scoresheet. 
 
The active bout list can be used to locate a bout in the tableau quickly. This is especially useful for large 
DE tableaus where locating a specific bout could require a lot of scrolling around. To find a bout, simply 
click on the corresponding bout in the active bout list. The bout will automatically scroll into view and 
will highlight in blue. Double-clicking a bout will let you enter the score for the bout. 
 

Results So Far 

As the round progresses, it is possible to determine the final place of the competitors that have been 
eliminated. Clicking the “Results So Far” button above the tableau will report the final places of the 
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competitors that can be determined. Note that all of the bout results must be entered in a table of the 
tableau for the losing competitors to be listed in the Results So Far list. 
 

Strip Assignments 

The process of assigning bouts to strips can follow a number of different strategies. For smaller events, it 
may make sense to not assign bouts to a specific strip, but rather just assign bouts to the next available 
strip. Larger events often will partition the tableau into quarters or eighths and assign one or more strips 
to each partition. When using the partitioning approach, you have the additional option of assigning 
each bout to a specific strip and time, or simply fence each bout in on the first available strip allocated 
to that partition. 
 
If you are using the “assign bouts as strips become available” approach, then it generally isn’t worth 
tracking strip assignments in Fencing Time. If you do wish to track strips, the easiest way is to manually 
enter the strip number in the Active Bout List as each bout is assigned to a strip. 
 
If you plan on using the partitioning approach, Fencing Time offers two ways to assign strips. To begin 
the strip assignment process, select the “Assign Strips to Tableau Partitions” option on the Strips 
dropdown menu above the tableau. 
 
Assigning Strips by Partition 
When assigning strips by partition, you are essentially taking the tableau, dividing it into halves, quarters 
or eighths, and assigning a group of strips to each partition. Within each partition, bouts are assigned to 
the first available strip. Bouts are not pre-assigned to specific strips at specific times. 

 

 
 
To assign strips using the partition approach, select the “Assign Strips by Partition” tab in the Assign 
Strips and Times window. 
 

This is approach used at USA Fencing national events and large regional events.  At 
these events, the term “pod” is often used rather than “partition”; the meaning is the 
same. 
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The “Assign strips for” option lets you choose which table in the tableau you wish to operate on. 
Generally, you will want to make your selections using the first table and select the “Apply through all 
tables” option to have the strip assignments use the same partitioning through the tableau. If you are 
using video replay (and had indicated so when starting the DE round), Fencing Time will apply the strip 
assignments through all of the tables until video is reached (since you will usually move to different 
strips at that point.) 
 
The “Number of partitions” dropdown lets you choose how many partitions you plan on using. As you 
change this value, the number of “Partition #” text fields will be updated to reflect the new number. In 
each of these text fields, you can enter a list of strip numbers or any arbitrary text string you wish. 
 
Once you have filled out the list of strips for each partition, click “Apply Changes”. This will update the 
grid on the right side of the window with the assigned strips. This grid shows every bout in the selected 
table, which partition it is in, and the assigned strips. 
 
Assigning Strips and Times for each Bout 
At some events, DE bouts are fenced following a structured schedule. Rather than fencing bouts as 
quickly as possible by utilizing the first available strip, every bout is scheduled to be fenced at a specific 
time and on a specific strip. This approach is typically used at FIE events like World Cups. 
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To assign strips and times for each bout, select the “Assign Strips for each Bout” tab in the Assign Strips 
and Times window. When assigning strips this way, you generally will assign strips for each individual 
table. As you change the table selection, the strip assignments grid will update showing the list of bouts 
in each table with their assigned strip and time. 
 
Next, choose the partitioning method using the “Assign tableau by” dropdown list. This lets you choose 
how many partitions you will be using.  In almost every situation, you will want to assign strips by 
quarter. 
 
Enter the strip numbers to use in the “Strips numbers” box. You can list strips individually separated by 
commas, or ranges using hyphens. For example, if you enter “1,3,5-9,14,16”, Fencing Time will interpret 
this as strips 1, 3, 5, 6, 7, 8, 9, 14, and 16. You can also use lettered ranges such as “A1-4” which would 
mean strips A1, A2, A3, and A4. 
 
The strip numbers box also includes a dropdown list of options commonly used at World Cups and other 
FIE events.  These options include variations on the standard four colored strips (blue, yellow, green and 
red) for quick selection. 
 
In the “Start time for bouts” box, enter the time at which the first bouts will start (using a 12 or 24 hour 
clock.)  In the “Time between bouts” box, enter how many minutes you wish to schedule for each bout. 
Typical times are 25 minutes for foil and epee, and 20 minutes for saber. 
 
Once you have made your selections, click “Apply Changes”. This will update the grid on the right side of 
the window with the assigned strips and times. If you are satisfied with the assignments, click “OK”. 
 
Regardless of which method you use to assign strips and times, you can manually set the strip and time 

for a specific bout by clicking the  button in that bout on the tableau.  
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Viewing the Strip Assignments 
To view an alphabetical list of competitors showing their strip assignment and report time (if set), click 
Strips → View Competitor Strip Assignments on the blue bar above the tableau. This list can be printed 
and posted along with the tableau – it provides competitors with a much easier way to locate their strip 
rather than scanning the entire tableau for their name. 
 

Assigning Referees to Bouts 

At some events (mainly FIE events), it is standard procedure to assign referees to each DE bout.  This is 
done by the tournament software in an impartial way, and also to avoid conflicts with fencers from the 
same country. 
 
Referees are assigned by table of the tableau (128, 64, 32, etc.) since all bouts in the current table of the 
tableau are completed before moving to the next table.  In order to properly schedule the assignment of 
referees, you must assign strips and times to the bouts before assigning referees.  Fencing Time will 
warn you if this has not been done. 
 
In the early tables of the tableau (256, 128, and the preliminary 64), usually every referee is used.  
Tables from the final 64 are generally assigned using a subset of referees selected by the referee 
delegate. 
 
To assign referees, select Referees → Assign Referees from the 
dropdown menu above the tableau.  This will show a popup with 
several options.  
 
The first option lets you select which round of the tableau to 
assign.  Fencing Time will offer all of the rounds where all of the 
fencers are known, as well as the next round where only some 
of the fencers may be known.  In that case, Fencing Time will try 
to avoid conflicts with the two fencers in the prior round since either one of them could win the bout. 
 
The “Assign by” option lets you choose how you want to partition the table for assignment.  Partitions 
should be chosen based on how you want to group referees.  For example, if the referee delegate 
selects referees for each quadrant of the table, select “Assign by quarters.”  If the referee delegate 
wants to assign referees to the entire tableau (as is often done for the T128 and earlier), select “Entire 
tableau.” 
 
The next two options – “Ref stays on same strip” and “Skip completed bouts apply those rules to the 
referee assignment process. 
 
The final option is to specify what criteria to use when minimizing conflicts.  For FIE events, it is 
mandatory to separate by country. 
 
The next screen consists of several parts.  At the top are two lists of referees.  The bottom lists all of the 
bouts in the table you chose in the first step. 
 



 

 

 C
h

ap
te

r 
1

7:
 D

ir
ec

t 
El

im
in

at
io

n
 R

o
u

n
d

s 

125 
 

 
Assigning referees is a two-step process.  First, you select which referees to assign to each part of the 
tableau.  Then, you instruct Fencing Time to do the assignments. 
 
To see this in action, click 
“Select Primary Referees”.  This 
opens a window where you will 
see all of the referees in the 
event.  On the right side of the 
window is a collection of tabs, 
one for each part of the table.  
Each tab contains a list of 
referees that will be used in 
that partition, as well as a list of 
the fencers in that partition. 
 
Use the arrow buttons to move 
referees into and out of each 
partition’s referee list.  If your 
referee delegate is following 
the standard procedure, he or 
she will provide lists of referees 
for each partition.   
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If the referee delegate has not given you a list of referees for each partition, you can have Fencing Time 
allocate the referees to each partition for you.  Fencing Time will try to minimize conflicts with the 
fencers in each partition so that when it comes time to assign referees to bouts, the chances of a conflict 
are even smaller. 
 
To have Fencing Time allocate referees to partitions, first use the “Remove Referee” button to remove 
any referees that you do not wish to use.  Once this is done, select how many referees should be 
assigned.  The default option will be to assign an equal number of referees to each partition.  Finally, 
click “Assign” to perform the assignment.  You can then review the assignments made and make any 
changes using the arrow buttons. 
 
Another option is to use “A” and “B” referee lists.  In this option, the referee delegate gives you two lists 
of referees – “A” refs, which are the “stronger” referees, and “B” referees, which are “weaker”.  When 
you choose this option, a window will open where you move the referees into either the “A” or “B” list.  
Once this has been done and you click “Assign”, Fencing Time will allocate referees to each partition 
equally spreading the “A” and “B” referees across the partitions (while also avoiding country conflicts.) 
 
Once you have assigned referees to each partition (either automatically or manually), click “OK” to 
return to the prior screen.  The list of referees at the top of the screen will now be populated showing 
which partition each referee will be assigned to. 
 

 
 
Under the referee list, you can choose how many referees to use from each partition’s referee list.  For 
example, if the referee delegate gave you six referees for each quarter of the tableau but only four of 
those should be chosen, set this number to four.  When you click the green “Assign Primary Referees” 
button, Fencing Time will randomly pick four referees out of the six and assign those four to the bouts in 
the quarter. 
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Assigning video referees can be done in two ways.  If you want to use the same referees as both primary 
and video referee, you can simply check the “Assign video referees using primary referees.”  This will 
rotate all of the referees through being primary and video referee.  However, if you want to assign video 
referees from a separate pool of referees, you can do this by clicking the “Select Video Referees” button.  
The procedure for selecting video referees then follows the same process as was done for primary 
referees. 
 
When you are ready to do the actual referee assignment, click the large green “Assign Primary Referees” 
button.  This will assign the referees to each bout, using the referees in each partition.  The results of the 
draw will be shown in the grid at the bottom if the window.  If any conflicts exist, they will be 
highlighted in yellow.  If you are assigning video referees separately, click the “Assign Video Referees” to 
perform that assignment. 
 
If you chose to use the “A” and “B” referee lists, Fencing Time will do its best to avoid pairing two “B” 
referees together.  If this happens, it will appear as a conflict so that the delegate can decide what to do. 
 

Printing the Tableau and Bout Scoresheets 

One of the biggest hassles in running a tournament is preparing the scoresheets for each bout. Fencing 
Time has a number of features to make this process easier for you. 
 
Printing the Tableau 
To print the tableau, click the “Print Tableau” button above the 
tableau. This will show the Print Tableau window, which lets you 
choose exactly how you want the tableau printed. 
 
The first option lets you decide which table of the tableau to start 
printing from. For example, you could print starting at the 
quarterfinals by selecting the Round of 8. 
 
The remaining options control the orientation of the tableau on 
paper, as well as various pieces of additional information that can 
be included on the printout. 
 
Printing Bout Scoresheets 
To print the scoresheets, select “Print Bout Scoresheets” on the 
“Print Bouts” menu above the tableau. This will show the Print 
Elimination Bouts window.  
 
This window lists all the bouts that are ready for printing. By default, Fencing Time will print all 
unprinted bouts where both competitors have been determined. You can choose to include bouts where 
at least one competitor is known, in which the unknown competitor will be left blank, allowing you to 
pencil them in when they have been determined. This greatly speeds up the process of handing 
scoresheets to the fencers to return to the referees. 
 
You can also print all of the bout scoresheets in the tableau, including those where neither of the 
competitors is known. By selecting this option, you can print all of the scoresheets at the start of the 
round and fill them in as the competitors are determined. Doing this helps you avoid potential 



 

 

 C
h

ap
te

r 
1

7:
 D

ir
ec

t 
El

im
in

at
io

n
 R

o
u

n
d

s 

128 
 

bottlenecks at the computer since you will never need to wait for more scoresheets to be printed. Note 
that the scoresheets that are completely blank still are numbered with a bout ID number, the table, and 
sequence number. It is important that you put the proper competitors on the proper sheet when filling 
them out to avoid confusion. 
 
In some cases, you may wish to only print bout scoresheets for a specific table – this option is also 
available, and you can optionally include bouts that have already been printed. 
 
If you select the “Include area to record video appeals” option, Fencing Time will print the scoresheet 
with an additional area used to record each video appeal request made.  For each request, the score, 
time, and the opinion of the two referees can be recorded, along with the final decision made.  This 
information can then be entered into Fencing Time when recording the bout results. 
 
Fencing Time offers many more options to control how DE scoresheets are printed. To see these 
options, click the “Printing Options…” button at the bottom of the Print Elimination Bouts window. Most 
of the options are self-explanatory; some of the less-obvious ones are described below. 
 
Bout Scoresheet Collation 
Printing bout scoresheets in collated order is a huge timesaver and eliminates the need to sort the bout 
slips after they have been cut. The collation feature is best illustrated with an example. 
 
Suppose you have 16 bout scoresheets that need to 
be printed. Using the “traditional” method of 
printing shown to the right, the first page will 
contain bouts 1 through 4; page two will contain 
bouts 5-8, and so on. In other words, the bouts are 
printed in order. While this seems intuitive, when 
you cut up the bout scoresheets, you will have to do 
a great deal of manual sorting to keep these 
scoresheets in the proper order. 
 
When using Fencing Time’s collation feature, the number of cuts you have to make is greatly minimized, 
and the bouts will not require any sorting once cut.  
 
To use the collation feature, you first must tell 
Fencing Time how many sheets you will cut at a time. 
For example, if you use a collate setting of four pages, 
the scoresheets will be distributed across the four 
pages as shown to the right. 
  
Notice that when the four pages are stacked and cut 
together, each stack will already be in order. Cutting 
through the four pages as a group on the line under 
the first bout will yield a stack of four bouts, numbers 1-4 already in order. As you make each successive 
cut, you will have the next four bouts in order and can simply stack them right after bouts 1-4. 
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Notice that if you were to cut the collated bouts three pages at a time, the order of the scoresheets 
would make no sense. As a result, you must make sure you cut the scoresheets using the same number 
of pages that you specified in the bout options. 
 
Expanding Score Boxes 
In some countries, people are used to scoresheets with only 15 score boxes instead of 29 (so that when 
fencing standard 15-touch bouts, each touch can be individually recorded up to a final score of 15-14.)  
Fencing Time offers the option to print “collapsed” scoresheets where the score boxes have not been 
“expanded” to 29: 
 

 
 
To use “unexpanded” score boxes, check the corresponding box on the print options.  
 
Bout Scoresheet Barcodes 
By default, DE scoresheets include a barcode. If your computer has a barcode reader attached to it, you 
can quickly bring up the bout scores entry window by scanning the barcode. If you do not want to print 
barcodes on your DE scoresheets, an option has been provided to disable them. 
 
Print Bouts by Strip or Referee 
Printing bouts by strip or referee can be useful when running events that assign referees to all bouts in 
the current table (such as FIE events.)  Selecting these options will enable sorting slips by strip or 
referee. 
 
Call Room Bag Tags 
Call room bag tags are simply full-page printouts with each fencer’s name and nationality in a large font 
which can be used to track fencer’s bags in the call room. The tags can also be used as signs on the strip 
if you do not have large displays showing the names of each fencer.  
 
To print the bag tags, select “Print Call Room Bag Tags” from the “Print Bouts” dropdown menu and 
select which round you wish to print from.   
 

Entering Bout Scores 

To enter an elimination bout score, you can use one of the following methods:  
 

1. Click the enter score button located on the tableau where the winner's name would appear 
2. Double-click the bout in the active bout list 
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3. Enter the bout's ID number into the “Score Bout ID” box on the main window toolbar  
4. Enter the bout's ID number in the box at the top of the Bout Result window 
5. Scan the bout’s scoresheet with a barcode scanner 

 
In all of the above methods, you will be presented with the Bout Result window: 
 

 
  
 
At the top of the window is information about the bout such as the bout ID number, which table it is in, 
what the bout sequence number is, how many bouts remain unfenced in the current table, and the bout 
ID # where the winning competitor should be placed. 
  
To record the score, enter the bout scores in the boxes next to each competitor's name. The winner will 
be automatically determined by comparing the two scores. If there is a tie, you will be prompted to 
select the winner. Simply click on the name of the 
competitor that should be marked as the victor. 
 
The dropdown lists of referees contain all of the referees 
which are active in the current round. You can select the 
referee and video referee for the bout or leave them 
blank if you are not tracking referees in your event. 
 
If you printed the scoresheets with the area for recording 
video appeals, you can enter the recorded appeal data 
by clicking the “Video Appeals” button. 
 
When running a team event, the Bout Result window will 
look slightly different. The top section of the window will 
contain the same information, but the score area will be 
replaced by the 45-touch relay scoresheet. 
 
Down the center of the window are two columns for the 
running score at the end of each bout. Note that this is 
not the number of touches scored in the bout, but the 
running team score at the end of each bout. If Fencing 
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Time detects a score that is out of place, such as one where the running total has decreased, an error 
icon will appear. 
 
The final score for each team must be entered in the bottom score box. This is the score that will be 
recorded for the match. If you do not wish to enter detailed match scores for every bout, simply enter 
the final scores in the bottom boxes. 
 
When a team has four members, the name of each team member will be displayed in each dropdown 
list. If you click one of these lists, you will notice that the choices are the fencers as initially assigned, as 
well as the reserve fencer. This allows you to change the fencer to the reserve if they are used during 
the match. If a team has only three members, the dropdown lists will not appear since there is no 
reserve to substitute in for another fencer. 
 
Team bouts can have four referees, all of which can be set using the dropdown lists at the bottom of the 
window. 

 
Clicking the “Next” button will clear the window and move the cursor to the bout ID field. After entering 
the ID of the next bout that you want to record, the window will populate with the competitor’s names 
and you can enter the scores. This cycle of “enter bout ID, enter score, enter bout ID” can make entering 
a large number of bout scores highly efficient. Bout IDs are more thoroughly covered later in this 
chapter. 
 
Changing Existing Scores 
To change the results of a bout that has already been entered, select the bout using the bout's edit 
score button or bout ID as usual, and then modify the scores as necessary. If the winner changes as a 
result of your changes, the new winner will be propagated down the tableau in place of the old winner. 
For example, suppose you have a bout where Competitor A fenced Competitor B and A wins. A then 
goes on to beat Competitor C in the next bout. If you modify the original bout to make Competitor B the 
winner, B will be marked as the winner of the bout with Competitor C. 
 
Clearing Scores 
The Bout Result window also has “Clear” button which is used to erase the score and referee details of 
the selected bout. However, this should be done with caution. If you clear the results of a bout, all bouts 
that follow it will also be cleared. Using the example above, if you clear the results of the bout between 
Competitors A and B, the results from the bout with Competitor C will automatically be cleared. This is 
necessary because Fencing Time no longer knows whom Competitor C will fence, so there cannot be a 
result.  
 

Bout ID Numbers 

Often, you will be running a tournament with multiple simultaneous events. At some point, you will 
have several events fencing some kind of elimination round. The computer operator will start getting 
swamped with bout scoresheets and will need to constantly switch back and forth between events to 
enter the scores. Clearly, this can be inefficient and time-consuming. 
 
Fencing Time has a unique solution to this problem. That solution is the bout ID number. 
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Every pool, elimination bout, and team match in your tournament has a completely unique ID number. 
This number will never be repeated and is guaranteed to uniquely identify a specific bout/pool/match in 
the entire tournament, regardless of which event it is in. The bout ID number is found in the upper-right 
corner of every printed bout scoresheet. 
 
To enter a bout score, first locate the bout ID on the scoresheet. Next, click on the “Score Bout ID#” text 
field on the main window toolbar. Enter the bout ID number and press Enter or click the green arrow to 
the right of the text entry box. This will bring up the Bout Result window, where you can enter the bout 
score as you normally would. 
 

 
 
After entering the score, if you have more bouts to enter (regardless of which event they are for), click 
the “Next” button. The competitors and scores will clear, and the cursor will move to the bout ID box at 
the top of the window. Enter the bout ID of the next bout you wish to enter, and press Enter or Tab. The 
window will again populate with the bout information, and you can now enter the scores. To enter more 
scores, simply repeat this process until all bouts have been entered. 
 
Aside from the ability to enter scores quickly, notice that the bout ID system completely removes the 
need to switch from event to event to enter scores. You no longer need to hunt for the bout on the 
tableau or switch tabs to find the correct event. This alone greatly speeds up the score entry process. 
 
When you rely on the bout ID numbers, it sometimes is handy to have the bout IDs of each bout 
displayed on the tableau. This is especially true if you are using a printed tableau to track the progress of 
the event and are filling in blank scoresheets. To display the bout IDs on the tableau in the event 
window, select the “Bout ID Numbers” option on the Display Options menu above the tableau. There is 
a similar option available when setting up the tableau for printing. 
 
Bout ID Barcodes 
If you are fortunate to have a barcode scanner hooked up to your computer, the process becomes even 
faster because you do not need to enter bout IDs at all. Simply scan the barcode from the scoresheet 
and Fencing Time will automatically display the Bout Result window for that bout. 
 
Handheld barcode scanners are quite inexpensive – some can be purchased for as little as $20 online. If 
you purchase a scanner, it must be capable of reading “Code 128” barcodes. 
 

Withdrawals, Exclusions, and Scratches 

If a competitor medically withdraws, is excluded (from a black card), or fails to appear (forfeit) during 
the DE round, their opponent will automatically be marked as the winner of the bout. In the rare event 
where both fencers withdraw, are excluded, or fail to appear, a “Bye” will be promoted as the winner of 
the bout. 
 
Marking a competitor as withdrawn, excluded, or forfeited is done in the Bout Result window. Next to 
each competitor’s score box are three checkboxes representing the three situations – medical 
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withdrawal, black card exclusion, or failure to 
appear. Checking any of these options will disable 
score entry since the score is not relevant if one of 
these situations occurs. 
 
To undo a withdrawal/exclusion/forfeit, use the “Clear” button just like you would with clearing the 
bout scores.  
 

Tableau & Display Options 

The “Tableau Options” and “Display Options” dropdown menus on the blue bar above the tableau 
contain a number of options that you may find useful during your elimination rounds. 
 
Fence-off for Third Place 
If your tableau includes the semifinals, you will have the option to fence-off for third place. If you had 
set this option when you created the round, the option will be pre-selected. At any time during the 
round, you can decide to add or remove the fence-off for third place. Note that if there is already a 
score present in the fence-off bout and you uncheck the fence-off option, you will lose the score from 
that bout. 
 
Swap Competitor Positions 
In rare situations, it may be necessary to swap the position of two competitors in the tableau. Selecting 
this option will show a popup window where you can select the two competitors to swap. Note that you 
cannot swap competitors who have already fenced a bout in the tableau. (If this must be done, you 
must clear all of the competitor’s bout scores before performing the swap.) 
 
Fill Entire Tableau / Current Table with Random Scores 
Selecting either of these options will fill the unfenced bouts on the tableau or the current table with 
random scores. This is useful for running a sample tournament or otherwise just experimenting with 
Fencing Time. 
 
Display Options Menu 
The “Display Options” menu lets you configure how much information to display on your on-screen 
tableau. The possible options are: 
 

• Competitor Clubs – Shows the club affiliations of each competitor. 

• Competitor Divisions – Shows the division affiliation of each competitor.  

• Competitor Countries – Shows the country affiliation and its flag of each competitor. 

• Competitor Classifications – Shows the competitor classifications in individual events (UFA 
Fencing events only) 

• Competitor Affiliations in Incomplete Bouts – If you have the tableau set to a view where some 
bouts in the leftmost column are not yet fenced, this option will show the affiliations of the two 
fencers (such as “USA or ITA”) on the tableau. 

• Referees – Shows the referee(s) that are assigned to each bout. 

• Strip Numbers – Shows which strip the bout has been assigned to (if any.) 

• Scheduled Bout Time – Displays the time at which the bout is scheduled to be fenced. 
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• Bout ID Numbers – Displays the unique bout ID number for each bout. For more information, 
see the Elimination Bout ID Numbers topic earlier in this chapter. 

• Bout Sequence Numbers – Displays a small number in each bout indicating where the bout is 
located in the table. For example, in the table of 32, the sixteen bouts will be numbered 1-16. 

• View Positions of Tied Competitors – Shows the list of tableau positions taken by tied 
competitors (this is the same as the list shown when the DE round was started.) 

• View Swaps Made in Pairs – Shows the list of competitor swaps made in pairs if this option was 
chosen when setting up the DE round.  This is the same list that is shown when the DE round 
starts. 

• Restart Tableau Display Timer – Allows you to restart the delay timer used to hide the public 
display of the tableau. 

 

Finishing DE Rounds 

Fencing Time will automatically determine that a DE round is finished when all of the bout scores have 
been entered. Once the round has been finished, you will not be able to go back and change the scores 
since doing so could affect the results of the round. 
 
To officially end the round, click the green “Start Next Round” button. Fencing Time will automatically 
promote the remaining competitors to the next round. If the round is the final round in the event, the 
“Finish Event” button will be displayed and clicking it will end the event.  
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Chapter 18: Repêchage and All-Places-Fenced Rounds 

 
In addition to standard single-elimination DE rounds, Fencing Time can run repêchage and “all-places-
fenced” rounds. These formats are far less common than standard DE rounds, but Fencing Time fully 
supports them for both individual and team events if you choose to use them. 

Repêchage Explained 

If you were to do a survey of fencers, you would find that the vast majority have never had any 
experience with repêchage. An even larger number would probably admit that they have no idea how 
repêchage works. In actuality, repêchage is not very complex and makes logical sense once you think 
about it. 
 
In a repêchage round, each competitor has two chances to advance to the final 8. It differs from a 
standard DE round in this way because a single loss does not mean elimination. A competitor is only 
eliminated after two losses. This is why repêchage is sometimes referred to as “double elimination.”  
The bouts in a repêchage round are identical to those fenced in a standard DE round and follow the 
same rules. 
 
The intent of repêchage is to narrow the field from 32 or 16 down to 8 finalists. There are two kinds of 
repêchage, “repêchage from 32” and “repêchage from 16”. These two numbers indicate the size of the 
initial repêchage table, just like a “DE of 32” refers to a DE round that starts with a table of 32.  
 
To demonstrate how repêchage works, refer to the sample repêchage table below. This example is a 
repêchage from 16, but repêchage from 32 works in a similar way. 
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If you ignore table C and everything to its left, notice that tables A and B are simply a standard DE 
tableau from 16 down to 4. This can be called the “winner's path”. 
 
As you would expect, the fencer who wins the bout in table A will advance to table B. The fencer that 
wins in table B advances to the rightmost table of 4 fencers. These four “double-winners” have assured 
themselves a place in the final round of 8 (after the repêchage). 
 
Remember, the goal of repêchage is to promote 8 fencers to the final round. The “double-winners” 
make up four of these eight fencers. However, where do the other four come from?  That is where the 
repêchage comes in. 
 
Look again at table A. As we said, the winners of bouts in A go to table B. However, the losers are placed 
into table C. All of these losers fence each other. If a fencer loses their bout in table C, that would be 
their second loss (since their loss in A put them in C in the first place.)  Once they've lost their second 
bout, they are now eliminated. The winner of the bout in table C has their name put on the lines left of 
table C. 
 
Once we have the four winners of table C, we seed them into the new table D, which is simply a single-
elimination tree that goes from 8 down to 4. The winners of table C represent four of these eight 
fencers. But where do the other four come from? 
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Look back at tables A, B, and C. Notice that we 
didn't consider the case where a fencer wins their 
bout in A, but then loses their bout in B. It is 
those fencers, the four who lose their bout in B, 
who represent the other four positions in table D. 
 
In summary, table D consists of the fencers who 
have one loss and one win. They may have won 
their first bout then lost their second or vice-
versa. Regardless, because they had a loss, they 
now must fence each other to see who survives 
table D. 
 
The way fencers are placed in table D depends on 
their initial seed. The rules for performing this 
seeding are a bit complicated, and there are rules 
that require moving fencers around in the seeding to ensure that they do not fence someone they 
already fenced in a prior table. Fencing Time takes care of these rules for you, so you do not need to 
worry about the details. Note that all eight fencers need to be known before table D can be seeded, so 
don't be alarmed when you don't see fencers appear there even though their bout in table B or C has 
been fenced. 
 
After the eight fencers in table D fence, four winners remain. These four fencers will now advance to the 
final round of 8, along with the four “double-winners” that we talked about earlier.  
 
The final round of 8 is a standard single-elimination DE until one winner remains. 
 
In a nutshell, that's all there is to repêchage!  Repêchage from the 32 is a bit more complex - there is an 
additional round due to the added fencers. However, the process is identical - if a fencer loses two 
bouts, they are eliminated. 
 

Viewing the Repêchage Tableau and Entering Scores 

Repêchage rounds, like all other rounds, are shown on a round tab in your event. The display of a 
repêchage tableau is virtually identical to that of a standard DE tableau. The only difference is the actual 
layout of the bouts. The function of the various buttons and options available is identical to those in the 
DE rounds. 
 
For a complete description of the options available in the repêchage rounds, see the discussion in the 
“Direct Elimination Rounds” chapter. 
 
The repêchage tableau is broken into multiple parts to reflect the different phases of the repêchage 
round. The primary tableau is shown first, followed by the “losers” tableau, which is populated with the 
fencers that lost in the first table. The subsequent repêchage tables (fenced as straight direct 
elimination trees) are drawn below primary tableau. 
 
Scores in repêchage rounds are entered in the same way as they are done in DE rounds. However, there 
is one important difference:  since a repêchage round consists of several sub-tables, there is an implicit 
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dependency between them. As a result, changes in one table may affect another. For example, the 
results of the primary tableau are needed in order to seed the repêchage table that follows it. If you 
make a change to the primary tableau that causes the winner of a bout to change (such as changing a 
score, or clearing a score entirely), the repêchage table will need to be reseeded to reflect the change. If 
any scores were entered in the repêchage table, those bouts would be invalidated and the scores lost. 
 

All-Places-Fenced Rounds 

All-places-fenced (“APF”) rounds are similar to standard DE and repêchage rounds. In APF rounds, 
competitors are not eliminated after losing their first bout. Instead, they fence off successive bouts until 
all places have been determined. This is different from standard DE rounds, where a competitor's final 
place depends on when they lose their bout and their initial seeding in the round.  
 
Fencing Time supports APF rounds from the table of 16 or the table of 8. In both cases, the rounds run 
until every place has been determined.  
 

Viewing the All-Places-Fenced Tableau and Entering Scores 

All-places-fenced rounds, like all other rounds, are shown on a tab in the event window. The display of 
an APF tableau is similar to that of a standard DE tableau. The only difference is the actual layout of the 
bouts. The function of the various buttons and options available is identical to those in the standard DE 
rounds. 
 
The all-places-fenced tableau is broken into multiple sub-tables to reflect the cascade of bouts necessary 
to determine all places. The primary table is shown first, followed by the loser’s table which is populated 
by the fencers that lost in the first table. The subsequent tables used to fence off the various places are 
drawn below primary table. 
 
Scores in all-places-fenced rounds are entered in the same way as they are done in standard DE rounds. 
For details on entering scores, refer to the “Direct Elimination Rounds” chapter. 
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Chapter 19: Qualifier Events 

 

 
 
During the typical USA Fencing season, you may run various events that serve as qualifiers.  These 
qualifiers can include divisional qualifier events for Summer Nationals and the Junior Olympics, as well 
as RYCs, SYCs, ROCs, and RJCCs.   
 
Among that list of events, there are two different mechanisms for qualifying.  Regional events (RYCs, 
SYCs, ROCs, and RJCCs) do not qualify fencers directly, but instead award points to the top finishers in 
each event.  Divisional qualifiers (for Division II, Division III, and Y14 at Summer Nationals, and junior and 
cadet at JOs) directly qualify the top-finishing fencers for the events. 
 
Fencing Time handles these two mechanisms differently.  In the regional event case, there is not much 
Fencing Time can do other than inform you which fencers earned points – this is because the actual 
point list is maintained by USA Fencing.  However, in the case of divisional qualifiers, Fencing Time can 
apply the (often confusing) rules for you to determine who qualified. 
 
Since USA Fencing occasionally makes modifications to the qualification rules, you should ensure 
Fencing Time has the latest version of the rules. To do this, run Fencing Time while your computer is 
connected to the internet. When Fencing Time starts, it will automatically check to make sure that it is 
up to date.  
 

Setting up a Qualifier Event 

The first step in setting up a qualifier is to select which national event it is a qualifier for when creating 
the event. You can also set this option on the “Summary” tab in the event window at any time before 
finishing the event. Qualifier events are required to be gender specific. 
 
For RYCs and RJCCs, you will also need to select the region number in which your event is hosted.  This is 
because only fencers from that region earn points – fencers from other regions, while welcome to 
attend, do not earn points.  By setting the event’s region number, Fencing Time can determine which 
fencers will earn points based on the region they reside in. 
 
For divisional qualifiers, it is very important to note which fencers may have already pre-qualified. 
Generally, this is only a consideration for JO qualifiers and Y14 qualifiers.  Fencers who have national 
points on the corresponding list (junior, cadet, or Y14) are pre-qualified for their respective event.  (Note 
that having regional points does not count in this case.)  If that fencer fences in the JO/Y14 qualifier and 
places in the top 25%, since they are already pre-qualified, they do not “use up” a qualification slot - the 
next eligible fencer gets to qualify. As a result, it is crucial to know who has pre-qualified before the 
event starts. 
 
When running a qualifier event, a separate column for the pre-qualification status will appear on the 
Event Competitors window (labeled as “Qual”.)  You should use this column to mark off those who are 
already pre-qualified.  

Qualifier events are only available in tournaments run under the USA Fencing 
authority that are marked as such. 
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Determining Qualifications at the End of the Event 

After the qualifier event ends, the Qualifiers window will appear, listing all of the competitors who 
qualified based on applying the selected event rule to the final results. 
 

 
 

If you need to change which qualification rule to use, you can select the event from the dropdown list. If 
you change the rule, the list of competitors and computed qualifiers will be updated to reflect this. 
 
If you need to edit the list of pre-qualified competitors (perhaps you forgot to mark someone as pre-
qualified before or during the event), click the “Edit Prequalified Competitors” button. (This option is not 
available for events that award points.) 
 
If there is a tie for the final qualification slot, the “Fence-offs” button will be active. When clicked, you 
will be prompted with a list of the tied fencers. You will need to have a fence-off between those fencers 
and specify the winner so that the final qualification slot can be awarded. To reset the fence-offs (in case 
you need to re-enter them), click the “Reset Qualifiers” button. 
 
When you are happy with the list of qualifiers, click “OK”. The events that each competitor has qualified 
for will be listed in the final results.  
 

Reporting Qualifications to USA Fencing 

The results file generated at the end of your competition for USA Fencing contains the list of qualifiers.  
Because of this, there is no need to submit a separate qualification spreadsheet as was done years ago. 
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Chapter 20: Working with XML Files 

 
Tournaments run by the FIE and its confederations (such as the EFC) use XML files to transfer 
competition data between their inscription/results system and tournament management software.  
Many other national fencing federations also use the same XML format for this same purpose.  Fencing 
Time makes working with these XML files simple. 
 

Creating Tournaments from XML Files 

Tournaments can be created in Fencing Time using one or more XML files.  Each XML file contains the 
list of registered competitors along with their point ranking, club and nation affiliation, and license 
number. 
 
Each XML file only contains data for a single event, so you will need to import multiple files into your 
tournament if you are running multiple events. Fencing Time makes this process simple and 
straightforward. 
 
To begin the process, download all of the XML files from the inscription website and store them 
somewhere on your computer.  A folder on the desktop often is a convenient place to store the XML 
files. 
 
Next, select File →New Tournament from XML Files from within Fencing Time. This will bring up the 
familiar Edit Tournament window where you specify the name and dates of your tournament.  Be sure 
to select the correct authority for the tournament.  If you are running a World Cup or other Cadet Circuit 
event, be sure to choose the FIE or EFC authorities, respectively. 
 
After clicking “OK”, you will be taken to the Import Event from XML Files window: 
 

 
 

This window shows the events that you have selected to import into your tournament.  Initially the list is 
empty; when you click “Add Event”, Fencing Time will ask you to select one (or more) of the XML files 
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that you have.  After you have chosen the files, the list will be updated to show the properties of each 
event. 
 
It is important to verify that the event properties are correct.  Most importantly is the event type, which 
helps Fencing Time choose the proper format for the event.  Events run by a national federation will be 
of type “Other” – options such as World Cup, Grand Prix, etc. are reserved for use by the FIE and its 
confederations.   
 
The other properties such as Age, Gender, and Weapon can be changed, if necessary, but these are 
taken directly from the XML file and are almost always correct.  The Chair Category property is used for 
wheelchair events and should be modified as needed.  The event ID, team or individual, and size 
(number of competitors) cannot be changed. 
 
The Ranking Point List indicates which point list the event will use for seeding.  This also is the list that 
will receive the rankings specified in the XML file.  For FIE events, the point list will be selected 
automatically (for example, a junior World Cup will use FIE Junior Rankings.)  For non-FIE events, you 
may choose a national point list, or possibly create a new one.  To change the point list, double-click in 
the point list cell and select from the dropdown menu. 
  
When you are done adding events and have finished updating the properties, click “Import” to create 
the tournament.  Fencing Time will read the data from the XML files and create the tournament with all 
of the events with competitors.  
 
After the tournament has been created, if you need to import more events from additional XML files, 
you can do this by clicking the “Import Events” button under the event list.  This will return you to the 
Import Event from XML Files window where you can follow the above process to add more events. 
 

Updating Event Competitors from Updated XML Files 

When you create an event in Fencing Time from an XML file, the list of entrants reflects the entries at 
the time you downloaded the file.  It is not uncommon for the list of entries to change in the days prior 
to your event as late entries are added and scratched entries are removed. 
 
In order to have the latest list of entries in Fencing Time, you will need to re-import the XML file.  
However, there is no need to re-create the entire event since it already exists in Fencing Time.  You 
simply need to update the competitor list. 
 
Fencing Time has a feature to make this process simple.  On the “Summary” tab for each event, there is 
a large button under the competitor breakdown (by country) labelled “Re-Import Competitors from XML 
File”.  Clicking this button will prompt you to specify the XML file that you want to re-import.  If you 
select an XML file for a different event, Fencing Time will warn you since this usually indicates you have 
chosen the wrong file. 
 

Importing Fencers from XML Files 

If you need to add a fencer to an individual event that has not yet started, and he/she is not already in 
your database, you can load his/her data from an XML file (such as one from a prior tournament where 
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he/she was present.)  To do this, open the Event Competitors window and click the “Import from XML” 
button.  Next, select the XML file containing the fencer(s) that you want to import.  Fencing Time will 
show a list of all fencers found in the file, each with a checkbox by their name.  Select one or more 
fencers using the checkboxes and click “OK” to import them into the event.   
 

Importing Fencer Ranks from XML Files 

XML files usually contain ranking data for the fencers contained in the file.  Sometimes you may want to 
import this ranking data to use to seed an event.  You can do this from the Fencer Rankings window, 
which is accessed by clicking the “Rankings” button under the event list. 
 
To import ranks, first select the point list and weapon to import the rankings into from the dropdowns 
at the top of the Fencer Rankings window.  Then, click the “Import from XML” button and select the XML 
file to import from.   
 
When importing rankings, Fencing Time will read the “Classment” attribute for each Tireur element in 
the XML file.  This value (if any) will be assigned to the matching fencer in your tournament. 
 
It is useful to note that you can use either a registration XML file or a results XML file as the source for 
your rankings.  Importing ranks from a results XML file allows you to seed an event based on the results 
of another. 
 

Importing Referees from XML Files 

XML files often contain referees in addition to the event competitors.  If you need a referee, and he/she 
is not already in your database, you can load his/her data from an XML file (such as one from a prior 
tournament where he/she was present.)  To do this, open the Tournament Referees window and click 
the “Import from XML” button.  Next, select the XML file containing the referee.  Fencing Time will show 
a list of all referees found in the file, each with a checkbox by their name.  Select one or more referees 
using the checkboxes and click “OK” to import them into your tournament. 
 
The above procedure only loads the referee into your tournament, not a specific event.  If you want to 
both load the referee and add him/her to a specific event, this can be done by clicking the “Referees” 
button at the bottom on the main window.  Click “Import from XML” and follow the same selection 
process as described above. 
 

Exporting XML Results 

After a tournament has finished, the XML results usually are uploaded to a website such as the FIE 
website for archival.  In some cases, the uploaded results are used to recompute point rankings or other 
fencer standings.  To do this, you must export the results to XML files for submission. 
 
To export XML results, select File → Export Results to XML on the main menu bar. You will be presented 
with a form where you can fill in various properties of your tournament. Most of this is optional data 
which is stored in the XML file along with the results. 
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As with importing XML files, each event must be exported to its own XML file. To keep things orderly, 
Fencing Time will output one XML file per event to a folder that you specify. These files should then be 
individually submitted to the results system. 
 
If you want to export the results for a single event, click the “Export” button on the Final Results tab and 
select “XML Format” in the “Save as type” dropdown list. 
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Chapter 21: Reports 

 
Fencing Time offers a number of reports that summarize various aspects of your tournament. Reports 
can be accessed via the Reports menu on the main menu bar. 
 
Nearly every report in Fencing Time can be exported to several formats (text, XLS, CSV, and HTML) and 
printed. Most reports allow you to customize the columns displayed, as well as sort the report data. 
 

Event Schedule 

This tournament report displays the schedule of events based on the times and dates set in each event. 
The report also includes a status column to indicate the current state of each event. 
 

Tournament Competitor List 

The Tournament Competitor List compiles a list of all fencers registered in the tournament. Fencers are 
listed by name along with their member number, membership status, club, division, country, and a list 
of the events each competitor is registered for. 
 

Scratched Fencer List 

The Scratched Fencer List compiles a list of all scratched fencers from all events in the tournament.  This 
list can be helpful when processing fencer entry fee refunds. 
 

Withdrawn / No-Show / Excluded Competitor Report 

This report compiles a list of all competitors that medically withdrew, failed to appear, or were excluded 
from all events in the tournament.   
 

Event Attendance Crossover Report 

This report generates a spreadsheet file which contains an analysis of event crossover.  The data is 
presented in a grid showing what percentage of fencers in each event also fenced in another event.  This 
data can be very helpful in seeing where you get the most crossover, which can aid in scheduling. 
 

Final Result Summary  

The Final Result Summary report is a very useful tournament-wide report that lists all of the competitors 
in the tournament and their results in each event. Each competitor is listed with the event name, their 
final place, birth year, member number, club(s), division, country affiliations, and their classifications.  
 
Because of all the data present in this report, it is perfectly suited for summarizing results by any criteria 
– for example, you can easily summarize the results for a specific club or division. Exporting this report 
to an XLS or CSV for loading into a spreadsheet allows you to process the results in any way you want. 
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Medalist Summary 

The Medalist Summary report lists the medalists in each event along with their affiliations. 
 

Medals by… 

The Medals by report lists the number of gold, silver, and bronze medals earned by each country, 
division, or club represented in the tournament. 
 

Country Rankings 

The Country Ranking report lists all of the countries represented ordered by the total number of medals 
won. 
 

Overall Tournament Statistics 

The Overall Tournament Statistics report summarizes the number of participants by weapon and 
gender, as well how many top-32 ranked fencers are present.  It is designed to assist the FIE observer 
with filling out the report they send to the FIE. 
 

Nation’s Grand Prix Report 

This report ranks the participating countries based on the final placement of all of their individual 
fencers.  The country with the best overall record wins the Nation’s Grand Prix award. 
 

Financial Summary Report 

Fencing Time is able to track basic financial data about your tournament. Currently, financial 
information is limited to tabulating the registration and event fees collected.  
 
There are two types of fees. Registration fees are a one-time fee paid by each competitor regardless of 
how many events they participate in. This fee is set when you create the tournament. 
 
Event fees are charged on a per-event basis. Generally, a fencer will need to pay this fee for each event 
they participate in. This fee is set when you create the event. 
 
If you do not use a particular fee, simply set it to $0. Some people prefer to describe their fees as “$15 
for the first event and $10 for each additional event.”  Realize that this is identical to having a $5 
registration fee and a $10 per-event fee. 
 
The Event Competitors window provides two columns, “Reg$” and “Evt$”, which is where you enter the 
amount paid by each competitor. 
 
Note that if a fencer is in multiple events, the registration fee will appear multiple times. Fencing Time 
takes this into account and does not count the registration fee more than once per competitor when 
doing its calculations. 
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Referee Usage Reports 

Referee Usage reports can be generated on a per-event basis or rolled-up into a single tournament-wide 
report. The report lists referee activity in each round of the event(s). For more information on the 
format of Referee Usage reports, see the chapter on “Managing Referees”. 
 

Referee Daily Hours Report 

The Referee Daily Hours report compiles a spreadsheet showing each referee used by day along with his 
or her start and finish time.   To create this report, Fencing Time uses the time of the first pool or DE 
bout refereed by the referee, as well as the time at which their last bout finished. 
 

Trainer’s Report 

The Trainer’s report summarizes how many pool and DE bouts are fenced in each event. This report is 
often used by the medical trainer for statistical tracking of injuries. 
 

Unverified Birth Dates Report 

This USA Fencing-specific report lists all fencers in the tournament with unverified birth dates.  This can 
be especially helpful when running an SYC so that you know which fencers need to provide proof of 
birth year when they arrive. 
 

Fencer Changes Report 

This report summarizes any changes made to fencer data during your tournament. 
 

Classification Change Report 

The Classification Change report is only available when running an event under the USA Fencing 
authority. This report summarizes all of the classifications that were earned in your tournament. 
 

Qualification Summary Report 

The Qualification Summary report is only available when running a tournament with qualifier events 
under the USA Fencing authority. This report summarizes all of the qualifications that were earned in 
your tournament. 
 

DT Change Reports 

When running an FIE event, any changes made to an event that deviates from what Fencing Time 
recommends must be documented and justified. A form must be printed and signed by the head of the 
DT approving the change. Fencing Time will automatically detect changes that require DT approval and 
present you with a form to fill out. 
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When presented with a change report, you will not be allowed to continue without entering a reason for 
the change. 
 
DT change reports should be printed out at the time the change is made. If you need to review the 
changes made over the course of the tournament, you can do so using the Reports → DT Change 
Reports option on the main menu bar. Note that you will only be able to view and print the reports; they 
cannot be changed. 
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Chapter 22: Integration with AskFRED 

 
AskFRED is the website where organizers of local tournaments announce and promote their 
tournaments throughout the United States.  
 
AskFRED allows tournament coordinators to:  

• Set up tournaments and automatically email announcements  

• Accept registrations for their events and show who currently plans on attending  

• Optionally accept payment from fencers  

• Manage custom point-ranking lists (“leagues”) using the results from selected events  

• Download registration lists into Fencing Time  

• Display detailed results for all events (provided by Fencing Time), 

• Search the event history to find trends in event sizes so that you can forecast the expected 
turnout for their upcoming events 

 
AskFRED helps fencers by allowing them to:  

• Register for upcoming events and see who else is coming  

• View results for past events  

• Search the event history for their personal results 
 
AskFRED is completely independent of Fencing Time. However, extensive collaborative work has been 
done to make the two programs work together. Each can be used independently, but the true power of 
the system comes when they are used together.  
 
To use Fencing Time and AskFRED together, it is assumed that you have already set up a “bout 
committee” account on AskFRED and have created a tournament on the site. Complete information on 
how to get started using AskFRED can be found at http://www.askfred.net. 
 

Creating a Tournament from AskFRED 

Creating a tournament in Fencing Time using the information on AskFRED is simple.  This is done by 
going to AskFRED in your web browser, logging into your AskFRED account, and downloading the 
tournament registration data file. This file is then loaded into Fencing Time. 
 
To start the process, begin by logging onto the AskFRED website. Go to the “Bout Committee” section 
and find your tournament on the “BC Dashboard” page.  Select the tournament from the list of 
upcoming tournaments. 
 

http://www.askfred.net/
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To download the registration data for Fencing Time, click the “Download for Fencing Time” link in the 
Registrations box.  
 
When prompted, choose the option to save the file that AskFRED is providing. Be sure that you note the 
name of the file and what folder you save it to!  The name of the downloaded file will end with “frd” 
indicating that it’s a file from AskFRED. Generally, it is a good idea to save the file to your desktop so 
that it's easy to find.  
 
If the computer you are using isn’t the one Fencing Time runs on, you will need to copy the downloaded 
registration file to the Fencing Time computer. You can do this using a flash drive, over a network, etc. 
 
Once the registration file is on the computer that runs Fencing Time, select File → New AskFRED 
Tournament on Fencing Time’s main menu bar. Alternatively, you can click the button of the same name 
on the left menu panel (shown only when no tournament is currently loaded.)  When prompted for a 
file, select the file that you downloaded from AskFRED. 
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Fencing Time will take the file that you specified and import the data found in it. The process of 
importing the data consists of three steps: 
 

1. Synchronize the AskFRED and Fencing Time databases if necessary 
2. Create the tournament and events 
3. Add the registered fencers to the events 

 
The synchronization step is very important. Since AskFRED maintains a database of fencers and clubs 
that is independent of Fencing Time's database, it is necessary to synchronize the two so that Fencing 
Time uses the most current data. For a complete discussion on how the synchronization process works, 
see the “Data Synchronization” chapter. 
 
After the database has been synchronized, Fencing Time will automatically create the tournament with 
all the events that were listed on AskFRED. All of the competitors that registered on AskFRED will be 
added to the events. Once that is done, you can begin running your tournament like you normally 
would. 
 
Once your tournament has been set up in Fencing Time, you can delete the registration file that you 
downloaded from AskFRED. If for some reason you do need the file again, simply re-download it from 
AskFRED.  
 

Publishing Event Results on AskFRED 

After your tournament is finished, you can upload the results to AskFRED.  Doing this allows visitors to 
the AskFRED website to see the results of the tournament and search the result history to find out how 
specific fencers performed. 
 
The process for publishing your results on AskFRED is simply the reverse of the process you used to 
download the event registrations.  You will save the results to a file from within Fencing Time, go to 
AskFRED in your web browser, log into your AskFRED account, and upload the file.  
 
To start the process, select File → Export Results to AskFRED from within Fencing Time.   You will then 
be prompted to select a location to save your results file, which is named starting with the word 
“AskFredResults”. Generally, the desktop is a good place to put it so that it is easy to find. Be sure you 
don't confuse this file with the registration file that you originally downloaded from AskFRED. 
 
After you save the file, you will need to upload it to the AskFRED website. As with the registration file, 
this step can be done on a computer other than the one running Fencing Time. To do this, you will need 
to copy the results file from the Fencing Time computer to the upload computer using a flash drive or 
whatever mechanism you choose. 
 
Once you have the results file on the computer connected to the internet, log into the AskFRED website 
and go to your tournament dashboard page like you did when you originally downloaded the 
registration file. In the box labeled “Results”, click the “Choose File” button under the heading “Upload 
results from Fencing Time.”  In the window that pops up, locate the results file that you just saved from 
Fencing Time. Once you select the file, click “OK” and then click the “Upload .frd file” button on the 
AskFRED webpage.  You will then be taken through the process of verifying the uploaded results.  
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After you have completed the upload process, AskFRED usually takes a few minutes to process the 
results before they appear on the website.  
 

It is important to note that publishing results on AskFRED is not official. Classification 
changes and qualification status must be submitted to the USA Fencing National Office 
for processing. This is usually done in coordination with your division secretary. 
 
It is very important that you submit your event results to USA Fencing in a timely 
manner. Failure to do this denies the fencer the ability to compete with his or her new 
classification.  In addition, national events have hard deadlines by which any 
classification changes must be submitted.   
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If you discover an error in the uploaded results, the best way to fix it is to correct the error in Fencing 
Time, then go through the process of exporting the results to AskFRED all over again. The updated 
results will replace the ones already posted on AskFRED. 
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Chapter 23: Integration with the USA Fencing Registration Website 

 
The USA Fencing registration system is used primarily for taking registrations for regional and national 
fencing tournaments.  Like with AskFRED, you can take registration data from the USA Fencing system 
and import it into Fencing Time to create your tournament in just a few steps.  
 

Creating a Tournament from the USA Fencing Registration System 

Creating a tournament in Fencing Time from the USA Fencing registration system is simple and works in 
a similar fashion as is done with tournaments that use AskFRED.  If you are familiar with the AskFRED 
process, then you should have no issues learning the new process.   
 
As is done with AskFRED, the general process is to log into the USA Fencing system using your web 
browser, navigate to the tournament dashboard, download the file for Fencing Time, and load the file 
into Fencing Time. 
 
To start the process, begin by logging into the USA Fencing website at https://member.usafencing.org.  
When shown the option to view the “Member Dashboard” or “Tournament Organizer” dashboard, 
select the “Tournament Organizer” option and then choose the tournament that you will be setting up. 
 
If you are not asked to choose between “Member Dashboard” or 
“Tournament Organizer”, or if you do get the choice but don’t see the 
tournament you wish to manage in the list of tournaments, both 
situations mean that don’t have tournament manager access to the 
specific tournament.  You will need to contact the person who is the 
official organizer of the tournament and have them add you to the list of 
“staff” members. 
 
Once you are logged in and on the dashboard page for your tournament, 
you need to download the file which contains your tournament 
information.  There are two ways to do this. 
 
The first way is by using the “Download for Fencing Time” option at the 
top of the “Overview” page which appears when your tournament is 
scheduled to start within one week.  Click the “Download.usfa” button to 
download the file. 

 
You can also download the file using the “Download for Fencing Time” 
link at the bottom of the menu on the left side of the page.  This link is 
always available, not just when your tournament is under one week 
away. 

https://member.usafencing.org/
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When prompted to do so, save the file that the website is providing. The file will be named with your 
tournament name and ends in “usfa”.  Be sure to remember where the file is saved on your PC!  
Generally, it is a good idea to save it to your desktop so that it is easy to find.  
 
If the computer you are using is not the one Fencing Time runs on, you will need to copy the 
downloaded file to the Fencing Time computer. You can do this using a flash drive, over a network, etc. 
 
Once the file is on the computer that runs Fencing Time, select File → New USA Fencing Tournament on 
Fencing Time’s main menu bar. Alternatively, you can click the button of the same name on the left 
menu panel (shown only when no tournament is currently loaded.)  When prompted for a file, select the 
file that you just downloaded from the USA Fencing site. 
 
Fencing Time will take the file that you specified and import the data found in it.  All of the fencers and 
referees registered for the tournament will be created in the Fencing Time database (if they are not 
already present), their data will be updated (such as weapon classifications, membership status, club 
affiliations, etc.) and the tournament and events will be created with the proper settings (seeding 
method, event format, etc.) depending on the type of event.  When the process is complete, you can 
begin running your tournament like you normally would. 
 

Updating a Tournament Created from the USA Fencing System 

Most organizers set up their tournament in Fencing Time about one week before the tournament starts 
so that they can publish the initial live results.  This gives the fencers a chance to see the initial seedings 
and report any errors in their data. 
 
The problem with doing this, however, is that any changes made to the tournament on the USA Fencing 
system will not be reflected in Fencing Time.  The most common changes seen are late registrations, 
scratches, and changes to fencer classifications.  Less-common changes include changes to the 
scheduled event times and changes to fencer club affiliations. 
 
To keep Fencing Time in sync with the data in the USA Fencing system, you would need to monitor the 
tournament for any changes and make the corresponding change in Fencing Time.  This is a tedious 
process, and it is easy to miss something. 
 
Fencing Time offers the ability to re-import tournament data so that you can apply the latest changes 
made in the USA Fencing system.  To use this feature, follow these steps: 
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1. Log into the USA Fencing website and download the tournament file using the “Download for 
Fencing Time” link just like you did when originally setting up the tournament. 

2. Open the existing tournament in Fencing Time. 
3. Click the “Re-Import” button under the event list on the left menu panel.  When prompted, 

browse to the file that you just downloaded. 
 
Fencing Time will take a few moments to analyze the file and the differences between its data and the 
current tournament data.  Any changes found will be applied to your tournament.  Changes will only be 
made to events that haven’t yet started – events already underway will not be affected. The changes 
can include: 
 

• Updates to fencer data (membership status, weapon classifications, club/division/country 
affiliations, etc.) 

• Addition of fencers that registered late 

• Scratching of fencers that cancelled their registration 

• Updates to the list of hired referees 

• Updates to the event start times 
 
At the completion of the re-import process, Fencing Time will show you a list of all changes made. 
 

Submitting Tournament Results to the USA Fencing System 

After your tournament is complete, you will need to submit the results to the USA Fencing system.  Once 
again, this process is very similar to the AskFRED results process that you may be familiar with. 
 
In the past, it was necessary to send multiple spreadsheet files to USA Fencing – the results spreadsheet, 
the referee usage reports, and sometimes the qualifier spreadsheet.  All of this information has now 
been consolidated into a single file, which simplifies the process greatly. 
 
To prepare the results file at the completion of your tournament, choose File → Export Results to USA 
Fencing on the main menu bar.  This will create a file starting with “USFAResults”, which you should save 
to your PC.  Be sure to keep track of where the file is saved!  The desktop is often a good place to store 
this file. 
 
Once the results file has been created, log in to the tournament organizer dashboard on the USA 
Fencing website.  You should see a page asking you to go through the tournament finalization process. 
 
On step 2 of the finalization process, you will be prompted to attach the results file generated by 
Fencing Time.  Select the results file you created above and click “Submit Upload”. 
 
The USA Fencing system will process your results file and alert you to any problems such as missing 
membership numbers.   If the error is something that can be corrected in Fencing Time, correct the 
error, re-generate the results file, and submit the updated file on the USA Fencing website.   
 
Once all of the errors within your control have been cleared, the result submission process will be 
complete.
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Chapter 24: Importing Data from CSV Files 

 
Fencing Time can import large amounts of data from CSV (comma-separated-value) files. CSV files are 
very powerful because nearly every spreadsheet and database program can generate them. This will 
enable you to import data into Fencing Time that you may have stored elsewhere, saving you a huge 
amount of time that would otherwise be spent manually typing in all of the data. 
 
Fencing Time can import the following kinds of data from CSV files: 
 

• Fencers and membership data 

• Fencing clubs 

• Referees and referee hire lists 

• Fencer point rankings 

• Registered event competitors 
 
Each type of CSV import is discussed in its respective chapter of this User’s Guide. 
 

Importing Custom CSV Files 

Fencing Time knows the format of many different CSV files. If the format you are using for your data 
matches one of the known formats, the CSV process will be quite simple. However, sometimes you may 
have a CSV file in a format not known to Fencing Time. 
 
Fencing Time can import CSV files that use a custom format. This is especially useful if you maintain your 
own spreadsheets of data and want to bring that data into Fencing Time.  
 
To ensure that your data can be read by Fencing Time, your CSV file must contain the column headers in 
the first row. In addition, be sure that there are no extraneous columns to the right of the data columns. 
 
As you progress through the CSV Data Import 
Wizard, you will eventually reach a step that 
requires you to match the columns in your CSV 
file with the various types of data understood by 
Fencing Time. This critical step tells Fencing Time 
how to map the columns in your file to the types 
of data that Fencing Time needs.  
 
The table displayed by the wizard will list each 
column that Fencing Time found in your CSV on 
the left. On the right side of each row, you will 
initially see everything listed as “Ignore this 
column”. 
 
If you double-click one of the “Ignore this column” fields, a dropdown list will appear showing all of the 
possible kinds of data that Fencing Time understands. In this step of the wizard, you need to select 
which data item is represented by each column in your file. For example, if your file contains a column 
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named “Born” which contains the fencer's birthday, you will select “Birthdate” from the dropdown list 
on that row. This tells Fencing Time that every value it finds in the “Born” column in your file as a birth 
date. 
 
Some columns in your CSV file may not contain data that Fencing Time understands. If this is the case, 
leave that column listed as “Ignore this column” so that Fencing Time skips that column’s data. 
 
Click “Next” and progress through the wizard until you reach the summary. On this last step, Fencing 
Time will report any errors or warnings encountered during the import process. If there were errors, you 
can click “Back” to make changes to your settings if necessary. Often, errors can only be fixed by editing 
the data in your CSV file. 
 
After finishing the wizard, you may need to go through a data synchronization step. For more 
information on this, see the “Data Synchronization” chapter. 
 

Managing Custom CSV File Formats 

If you frequently import CSV files in custom formats, the process of mapping the columns in your file to 
Fencing Time data can be tedious. To make this simpler, you can save your custom format settings so 
that you do not need to go through the column-mapping step every time. 
 
To create a custom CSV format, check the “Save this CSV file format for future use” option on the page 
of the wizard where you perform the column matching. When you have finished setting up the column 
mappings and click “Next”, Fencing Time will prompt you to enter a name for the file format. You may 
choose any name you wish for the format. 
 
Once the format is saved, it will be available for future use. Next time you run the CSV import wizard, 
Fencing Time will display your saved format as one of the options on the “What kind of CSV file will you 
be importing?” step. Simply choose your format and proceed through the wizard. If you wish to delete a 
custom format, you can do so by clicking “Delete Format”. Note that formats supplied by Fencing Time 
cannot be deleted.  
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Chapter 25: Data Synchronization 

 
In Fencing Time, a data synchronization step occurs every time you load a tournament file, create a 
tournament from AskFRED, the USA Fencing registration system or import data from a CSV file. Often, 
you will need to assist Fencing Time with the data synchronization step. This chapter will help you 
understand why data synchronization is necessary, and how it should be handled. 
 

What is Data Synchronization? 

Whenever you have two sources of data that contain information that is supposed to be identical, you 
must synchronize the data. This is a potentially complex process that is best illustrated with an example. 
 
Fencing Time maintains a database of fencers. You often add fencers to this database when setting up 
an event. Sometimes you will modify the information in the database - perhaps you will correct a 
misspelled name, or update someone’s weapon classification. 
 
Now consider a second source of data that contains the same, or very similar, information. A good 
example of this would be the AskFRED website. AskFRED maintains its own database of fencers.  
 
Every so often, you will need to bring these two collections of data together. In the case of the AskFRED 
data, that “bringing together” occurs when you create a tournament using the downloaded registration 
data file as described in the “Integration with AskFRED” chapter. 
 
Suppose that one of the fencers in the registration file from AskFRED is named “John Adams”. When 
Fencing Time encounters that fencer during the process of creating a tournament from the AskFRED 
registration data, a decision has to be made. The process Fencing Time goes through looks something 
like this: 
 

1. Is John Adams a fencer that Fencing Time already knows about? 
2. If not, are there any fencers in Fencing Time's database that could be John Adams? 
3. If not, then John Adams must be a new fencer, so create a new fencer in the Fencing Time 

database from the data provided by AskFRED. 
 
This process is done for every fencer and club that is in the registration file.  
 
How does Fencing Time answer the above questions?  We will now explore the process Fencing Time 
uses to get the answers. 
 

Data Matching 

First, Fencing Time checks to see if it has encountered the John Adams fencer before. This is first done 
using the fencer’s membership number (if it is known), since that number uniquely identifies the fencer. 
Fencing Time looks through its database of fencers to see if it has a fencer with the same membership 
number. If one is found, then it must be John Adams. 
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If no matching fencer was found, Fencing Time then attempts to find a close match. First, it looks for all 
fencers with the last name of “Adams”. Once it has that list, it tries to find a fencer with the same first 
name and birth year. If it's able to find a match based on those criteria, it assumes that it has found a 
match. 
 
If no match has yet been found, it is now time to ask the user for some help. Fencing Time will present 
the user with a list of all fencers with the last name of “Adams” and ask if any of them are really John 
Adams. This is necessary because sometimes a fencer may be added with a slightly different name – 
such as “Johnny Adams”. If the user selects “None of the above” (or if there were no other fencers 
named “Adams” in the database), then it assumes John Adams is a new fencer and creates a new entry 
in the Fencing Time database for him. 
 

 
 

After this process has finished for every fencer being imported, there now is a “link” between the 
fencers coming from AskFRED and the ones in Fencing Time's database. However, we are not done yet. 
What if there are differences between the linked fencers? 
 

Reconciling Differences 

When differences exist between the data being imported and the matching data in Fencing Time’s 
database, those differences must be reconciled. This is a key part of the synchronization process. 
 
Suppose that AskFRED reports that John Adams has a C09 foil classification. However, the matching 
fencer in Fencing Time’s database is on record as having a C13 in foil. Which is correct? 
 
Again, it is now time to ask the user for help. The user is presented with a window showing the 
conflicting data and asks them to select the correct values. In this case, the conflict is over the foil 
classification, so the user would have to know which classification is correct (which could be looked up 
on the USA Fencing website) and select the correct one. 
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As you can see, Fencing Time does a lot of work during the synchronization process. This entire process 
has to be done for every fencer, club, and referee that is listed in the incoming file. Fencing Time 
attempts to make intelligent decisions during this process, but ultimately, it will require some input from 
the user to make the correct decisions. 
 
Although this example was done using an AskFRED registration file as the input, the exact same process 
happens when you import fencer data from a CSV file, as well as when you open a tournament file that 
was created on another PC. 
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Chapter 26: Live Results on the Internet 

 
The hallmark of a superlative tournament organizer is using technology to improve the tournament 
experience for everyone. This is not limited to just the fencers, but also includes the spectators both at 
the venue and those at home. Getting current tournament information to everyone is a goal all 
organizers should strive for. 
 
Fencing Time can greatly assist you in providing information to people via the internet. Live tournament 
results can easily be posted to the web every few minutes, enabling everyone to follow along with the 
action. To use this capability, you must be running Fencing Time on a computer that has access to the 
internet. 

Publishing to Fencing Time Live 

The Fencing Time Live website (www.fencingtimelive.com) is a centralized repository for everyone’s live 
results that is simple to use.  The user experience of Fencing Time Live has a sleek visual design that is 
optimized for viewing on mobile devices.  On any given weekend, you can find live results for dozens of 
tournaments being held worldwide. 

 

 
 
To publish live results to Fencing Time Live, you must first obtain an access key.  An access key is simply 
an 8-character code made up of numbers and letters that is issued to you by Fencing Time, LLC.  This 
code is entered into the live results configuration in Fencing Time to enable publication of live results to 
Fencing Time Live. 
 
To request a Fencing Time Live access key, run the main Fencing Time app and select the Tools → 
Request a Fencing Time Live Access Key menu item.  This will take you to a website where you need to 
fill out the request form, accept the terms of service, and click “Request Access Key” to place the 
request.  Your access key should arrive via email within a few minutes of submitting the request. 
 
Fencing Time Live access keys are unique for each requesting individual/organization.  You only need to 
request a key once; the key you receive should be used for all of your tournaments.   
 
After you have received your access key, you can now enable publishing to Fencing Time Live.  Use the 
View → Live Result Configuration option on the main menu bar (or the corresponding button on the 
toolbar) to open the Live Results Configuration window. 
 

Use of Fencing Time Live currently is free for all licensed Fencing Time users.  While 
there are no immediate plans to charge for the use of the service, this may change in 
the future.  

http://www.fencingtimelive.com/
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To start publishing live results, check the checkbox at the top of the window.  This will turn the header 
green from red, indicating that live results publishing is enabled. 
 
In the Access key field, enter the access key that you received by email.  Fencing Time will retain your 
access key setting, so it will be available for all of your tournaments. 
 
On the left side of the window is a list of all events in your tournament. To include an event in the live 
results, mark it as checked.  Events that are not checked will not appear on Fencing Time Live.  If you 
uncheck an event that had been checked, the event will be removed from Fencing Time Live. 
 
Sometimes, you might need to temporarily pause publishing of live results for a specific event.  
However, you don’t necessarily want to remove the event from Fencing Time Live – you just need to 
pause publication for a short period of time.  To do this, you can check the “Pause publication of live 
results” checkbox on the event’s “Summary” tab.  When you are ready to resume live result publication 
for the event, uncheck the box and publication will resume. 
 
After you have finished configuring the live results and enabled publication, Fencing Time will publish 
the tournament Fencing Time Live.  Updates are not published immediately – they are published once 
per minute. This publication will be done in the background, so you will not notice it happening.  A small 

 icon will appear in the lower-right corner of the main Fencing Time window to indicate that live 
result publication is enabled. If an error occurs during publication, this icon will change to a yellow 
warning sign. To see the error, double-click the warning icon. 
 
After the first publish has completed, you can re-open the Live Results Configuration window and the 
“Link to your live results” will now be available.  This is the link that you should share with people to 
direct them to your live results. 
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Live Stream Strips 

Some tournaments provide live video streams of specific strips – usually the strips used for the final 
rounds.  Each of these video streams typically has a link where the stream can be watched. 
 
Fencing Time lets you provide the live stream link for up to nine strips.  When a link is provided, a 
camera icon will appear on Fencing Time Live next to each bout being fenced on one of the specified 
strips.  Clicking the camera icon will take the user to live stream. 
 
To configure the live stream strips, click the “Live Stream Strips” button on the Live Results 
Configuration window and then enter the name of the strip and the live stream URL for each strip.  Note 
that the strip names provided here must match the strip names given when you assign strips to bouts. 
 

Publishing HTML Live Results to Your Website 

HTML live results is the old system that Fencing Time used for many years.  When using HTML live 
results, web pages are generated by Fencing Time and uploaded to your website every few minutes.  To 
use these live results, you must provide a web server (such as the one hosting your club website) and 
the information needed to access the server (username and password.)  Configuring HTML live results 
can be challenging for non-technical people. 
 
Fencing Time uses FTP (file transfer protocol) to upload files.  FTP is a common method for publishing 
data to websites. To enable Fencing Time’s publishing of live results, you must provide the login name 
and password of your web server’s FTP account. Your account on the web server must have permission 
to create files and folders on the web server.  
 
If you do not have a web server available, you can also publish the live results to a specific folder on your 
computer or a file share on a network. This option is mainly designed for scenarios where the web 
server is running on a machine on your local network. 

 

 
 
To configure the live results publication, you first must have a tournament file loaded. Select View → 
Live Results Settings on the main menu bar to bring up the Live Results Configuration window. 
 

You are strongly encouraged to use Fencing Time Live for your live results instead of 
HTML live results.  It is very likely that the HTML live results option will be removed 
from Fencing Time in a future version.  
 
Because the use of HTML live results is discouraged, the option to use them is not 
enabled by default.  To show the HTML Live Results options, you need to check the 
“Show HTML Live Results tab on the Live Results screen” option on the Tools → 
Preferences → General tab. 
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To start publishing live results, check the checkbox at the top of the window.  This will turn the header 
green from red, indicating that live results publishing is enabled. 
 
To enable the HTML live results, select the “HTML Live Results” tab and set the publish frequency to 
whatever you are comfortable with.  If you have a fast internet connection, every minute is 
recommended.  If your internet connection is slower, an interval of three to five minutes may be more 
appropriate.  In order to minimize the amount of data uploaded, Fencing Time will only publish files for 
events that have changed since the last update. 
 
There are two publication methods:  to a website using FTP (most commonly used), or to a file share or 
folder. The website option requires you to supply the name of your web server (host name) and your 
username and password.  
 
The remote path option specifies where you want the pages published on your website. You are strongly 
encouraged to use a separate path for each tournament, since the generated filenames are not unique 
for each tournament. Checking the “create remote path if necessary” tells Fencing Time to create the 
specified folder on your web server if it does not already exist. 
 
The “Port” and “Use active FTP” are advanced options which only should be used if your server uses a 
non-standard port or requires active FTP.  This is not common. 
 
If you choose to publish your live result data to a file share or folder, all you need to do is specify the 
destination in the output path box.  
 
The “Publish options” box contains two options that control how navigation between event pages is 
handled. The first option instructs Fencing Time to generate an index page for the tournament. This 
page contains the tournament schedule with links to each event. If you plan on integrating the 
generated pages into another website, you may not want the index page. 
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The “Include back button” option controls whether each event’s page should include a button which 
takes the user back to the index page.  
 
If you would like to include a logo at the top of each of each page, you can specify the image file to use 
in the provided field. Fencing Time will upload this file along with the rest of the tournament data. 
 
After you have finished configuring the live results and enabled publication, Fencing Time will publish 
the tournament state to your website at the frequency that you specified. This publication will be done 

in the background, so you will not notice it happening. A small  icon will appear in the lower-right 
corner of the main Fencing Time window to indicate that live result publication is enabled. If an error 
occurs during publication, this icon will change to a yellow warning sign. To see the error, double-click 
the warning icon. 
 

Forcing Immediate Publication of Live Results 

Fencing Time publishes live results every minute or so. However, sometimes you may not want to wait 
until the next publishing interval occurs and instead force the publication to happen immediately. 
 
The “Force Publish” button on the Live Results Configuration window allows you to do this.  You can 
choose which version of the live results to publish, and you can either publish the entire tournament’s 
data, or just the data for a specific event. 
 
The publish will occur as soon as you click “OK” on the Live Results Configuration window. 
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Chapter 27: Remote Monitors 

 
All modern PCs have the ability to display information a second screen. Using this capability, you can 
utilize Fencing Time’s “remote monitor” feature to show live information about your tournament on one 
or more screens (or projectors) at your competition venue. 
 
It is important to note that the “remote monitor” feature is different than the “live results” feature. 
Remote monitors are screens physically located at the competition, while live results are on the internet 
and are available to everyone.  

 

 
 

Configuring Your Computer for Two Displays 

Before you can use Fencing Time's remote monitor feature, you must enable your computer to output 
to multiple devices. How this is done can vary from computer to computer, but here are the basic steps 
that should help you get things configured. 
 
In the discussion that follows, the “second display” refers to any device capable of displaying a computer 
image. This includes monitors, projector systems, or any other devices that accept a computer video 
signal. 
 
Step 1: Hook up the second display 
The first step is to hook up the second display to your PC or laptop.  
 
If you are using a desktop PC, it must have at least two video connectors (VGA, DVI, or HDMI.) Most 
modern PCs usually have at least two connectors, with the second one located adjacent to the primary 
connector that your main screen is connected to. 
 
If you are using a laptop, look on the back or side panel for the connector for a video device. Usually, 
this will be an HDMI connector. Some more compact laptops use “mini” versions of these connectors 
that use an adaptor cable to connect to full-size connectors.  If your laptop doesn’t have any video 
connectors, you may have to use a USB “dongle” that converts a USB port to an HDMI connection. 
 
Once you have located the video connector, attach the cable from your second display and turn it on. 
  
Step 2: Tell Windows to use the second display as an extended desktop 
Once your second display is connected, you will need to tell Windows how you want to use it.  Locate 
the display settings in Windows and look for the option where you can configure “Multiple displays”.  
This usually is on the same settings page as the one where you set the display resolution. 
 

 
 

If you are using a Fencing Time server, you can set up many more remote monitors 
than when using a single computer.  For more details on this, see the Fencing Time 
Server System Guide. 
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If everything is working correctly, the display settings should indicate that you have two display devices 
connected. If the second display is not there, or if it is shown but is disabled, make sure the cable is 
connected and that it is powered on. If that doesn't solve the problem, you may need to reboot 
Windows for it to detect the second display. 
 
Windows refers to your main screen as the “primary” display. On a desktop PC, this is the screen where 
your main desktop is shown. On a laptop, it is the built-in screen. The second screen that you hooked up 
is the “secondary” display. Select the secondary display from the ones shown in the window. 
 
Most PCs allow you to use the secondary display in two different ways. The first way, which is common 
for laptops, is to duplicate the image shown on your primary display onto the secondary display. This 
usually is the default option. The second way is usually referred to “extended desktop”, which means 
that Windows will treat the second display as an extension of your desktop. In this mode, you can 
display different things on each screen. You will want to select this mode for the secondary display. In 
the sample window above, this is done by setting the “Multiple displays” dropdown list to “Extend these 
displays”. 
 
If you cannot find any way to select the extended desktop mode, then it is possible that your PC or 
laptop does not support the extended desktop feature, and therefore will not be able to be used for 
Fencing Time's remote display features. 
 
Step 3: Verify the second display is configured properly 
After making the necessary changes to the Windows display settings, you should see your desktop 
background on the secondary display. You should be able to move the mouse cursor off your primary 
display's screen and onto the secondary display. If you are able to do this, then your displays are now set 
up correctly. 
 

Feeds 

Fencing Time uses a concept called “Feeds” as a way of configuring remote monitors. Feeds allow you to 
have multiple remote monitors, each showing different data. 
 
In simple terms, a feed is list of events that should be displayed on a remote monitor. You can customize 
the content of each feed independently of all others. However, if you only have a single screen hooked 
up to your PC as a remote monitor, then one feed is generally all that you will need. 

 

 
 

Creating Feeds 

The first step in configuring the remote monitor is to create one or more feeds to be displayed. 
 

The true power of feeds is realized when you are using a Fencing Time server.  When 
using a server, you can have a nearly limitless number of remote monitors, each one 
customized with its own feed!  (Of course, you could just have a handful of feeds and 
re-use some by multiple screens.) 
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To start the process, select View → Remote Monitor Settings on the main menu bar. If the menu item is 
disabled, quit Fencing Time and restart the program. Fencing Time determines whether you have a 
second screen connected when it starts up, so if you configured the second screen after running Fencing 
Time, you will need to restart in order to detect the screen. If the option is still disabled, make sure you 
have your secondary screen configured properly as described above. 
 
The first window you will be presented with is the Remote Monitor Feeds window. This window shows 
the list of feeds present in your tournament.  At the top of the window are two buttons for controlling 
whether the remote monitor display is on or off. 
 
By default, Fencing Time creates two feeds for your tournament – the “Default Feed” and the hidden 
“Referee Strip Assignment Feed”.  The default feed is simply a starting point for you to use – you can 
keep it, modify it, or delete it altogether. 
 
The referee strip assignment feed is a hidden feed that you cannot modify.  This feed contains a single 
item – a list of the current referee strip assignments.  It is intended to be displayed only to your referees 
(presumably on a monitor in the referee lounge) so they can see where they should be at any given 
time.  In order to prevent referee assignments from being shown before they are finalized, the 
information will not be shown in the feed until the scoresheets are printed. 

 

 
 
If there are no feeds listed, you will need to click “Add” to create one. You can edit an existing feed using 
the “Edit” button and delete a feed using the “Delete” button.  If you have a feed already setup and 
configured the way you want it, you can create a new feed with the exact same settings (so that you can 
modify just a few things like the list of events) using the “Clone” button. 
 
When you create or edit a feed, you will see the Edit Feed window. At the top of the window is a text 
field where you can specify the feed name. Below the feed name there are multiple tabs, each one used 
to configure a different aspect of your feed. 
 

When you are connected to a Fencing Time server, the remote feeds on/off options 
will not be present.  This is because there are very likely multiple remote monitors on 
your network, rather than just one attached to your PC.  If you want to use the remote 
monitor on the PC that is connected to the server, you will need to launch the Fencing 
Time Remote Monitor program from the Windows Start menu.  Please refer to the 
Fencing Time Server System Guide for more information. 
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Events 
This tab shows a list of all events in your tournament. To add an event to a feed, place a check in the box 
next to the event name. 
 
Display Options 
The display options tab allows you to customize the information presented in this feed. These settings 
apply to all events shown in the feed.  
 

             
 
Feed Items 
This tab shows a list of all of the things that can be shown in a feed for an event. Normally, you will want 
to show all of these items for your events. These items won’t all be shown all of the time, of course. 
Fencing Time will know which items are applicable at any given time in your event. For instance, during 
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the DE round, Fencing Time won’t show pool scores since the competitors will not want to see those – 
they’d rather see the DE tableau.  
 
This list, essentially, tells Fencing Time which items it is allowed to show. If Fencing Time determines 
that it is time to show the DE strip assignments, but you have unchecked “DE strip assignments”, then 
they won’t be shown since you have disallowed that item. 
 
Announcement 
The announcement tab provides a field where you can enter an announcement that should be displayed 
in this feed. This announcement can be just about anything. You can specify the priority of the 
announcement and a “show until” time after which it will no longer be shown. 
 
To turn off an existing announcement, use the “Clear” button to erase it. 
 

Displaying the Remote Monitor 

Once you have one or more feeds defined, the next step is to display the feed on the remote monitor. 
To do this, click the “on” button on the Remote Monitor Feeds window. 
 
Moments after turning on the remote monitor display, the remote monitor should appear on the 
second display connected to your PC. At the top of the display you will see a blue header with the 
Fencing Time logo as well as some banner text. Filling the rest of the display is the area that displays 
event data. 
 
Usually, Fencing Time will know which feed you want to display. However, if that feed is not available, or 
if you want to display a different feed, you must tell the Fencing Time Remote Monitor which feed to 
“subscribe” to. This can be done in the remote monitor configuration. 
 

Remote Monitor Configuration 

To configure the Remote Monitor, click anywhere in the blue banner at the top of the remote monitor 
screen. This will bring up the Remote Monitor Main Menu window. 
 
The menu has four large buttons which take you to various configuration pages for the remote monitor. 
Each of these is described below. 
 
Select Tournament Feed 
This option will show a list of all of the feeds in your tournament so that you can select which one to 
display on the screen. 
 
Feed Display Options 
This option lets you configure various properties of the feed display. 
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You can adjust the font size with slider. The Scroll speed and scroll step size sliders are used to adjust 
how fast the information scrolls off the screen. Higher step sizes may cause the scrolling to appear 
“jumpy”, so only use this option if you cannot achieve the desired scrolling with the scroll speed slider.  
The “Pool scroll multiplier” allows you to speed up scrolling of pools without speeding up other items – 
this is usually desirable since a long list of pools can take forever to scroll by. 
 
The minimum display time specifies how many seconds must elapse before changing to a new item 
(after any scrolling is complete.) 
 
The background color option lets you choose one of the four standard strip colors (red, green, blue, 
yellow) as the background for the displayed data. This generally is used with the options in the display 
limits section below. 
 
The language option specifies what language to use when displaying the information on the screen.  If 
you are running in split-screen mode (described below), you can use a different language for each part 
of the screen. 
 
The display limits options enable the use of the display as a “fixed” 
display. This is often done at FIE events where screens are set up 
near each strip and only display the data for that strip. Usually, that 
data is either a pool or part of the DE tableau. To force the remote 
monitor application to function in this mode, enter a pool number 
or DE tableau partition number to be shown on the screen. 
 
Program Options 
On this screen, you can select the display language for the program 
option screens, the screen mode, and a custom logo to display in 
the upper-right corner of the display. 
 
The language selected here only controls the language used to 
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display the program option screens (including this one.)  This setting does not affect the language 
displayed on the screen that the spectators see.  To select the language that they see, use the Feed 
Display Options screen. 
 
The screen mode can be set to “Single pane” (the default) or a split-screen mode where two or three 
panes are stacked or side-by-side.  
 
Split-screen modes allow you to show two or three different feeds on the same computer monitor. Each 
pane on the screen will have its own title bar, which can be used to select the feed that part of the 
screen is displaying.  
 
Split-screen mode is great for widescreen monitors, where multiple columns may make sense. Or, if you 
orient your monitors into portrait mode, the stacked option may work best. 
 
You can also optionally show a footer bar at the bottom of the screen.  This bar can be configured to 
display the URL of your live results on Fencing Time Live and a clock with the current time.  When 
displaying the Fencing Time Live URL, a QR code will be shown next to it so that viewers can scan the 
code with their phone to quickly get to the live results. 
 
Exit Remote Monitor 
This option closes the remote monitor application. You can also do this by turning off the remote 
monitor display on the Remote Monitor Feeds window in Fencing Time.  
 

Controlling what is shown on the Remote Monitor 

In old versions of Fencing Time, you needed to carefully manage the data shown on the remote monitor. 
At every stage of your tournament, you needed to manually adjust what was displayed to ensure it was 
pertinent to the state of your tournament and provided the fencers with the information they needed. 
 
Needless to say, manually managing the remote monitor was tedious and a distraction from all of the 
other things you need to do while running an event. Fencing Time v4.0 solved this problem entirely - it 
decides what to display and when, removing your involvement entirely! 
 
At first, it would seem like this is a bad idea. However, after a thorough analysis of tournaments ranging 
from small local events to international World Cups, it became obvious that all tournaments go through 
a fairly predictable series of “states”, each one having obvious information that needs to be presented 
to the competitors. 
 
The event states that were identified are as follows: 
 

• Before check-in has opened 

• Check-in is open 

• Check-in is closed but some competitors are still listed as absent 

• Check-in is closed and no competitors are absent 

• Pools are in the process of being set up  

• Pools have been posted with strip assignments 

• Pools are being fenced and no scores have been submitted 
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• Pools are being fenced and some (or all) scores have been submitted 

• Elimination tableau has been created but strips are not yet assigned 

• Elimination tableau has been created and strips are assigned; no bout results have been 
submitted yet 

• Elimination scores have been submitted but bouts in the first table are still being fenced, so no 
results so far can be computed 

• Elimination scores have been submitted for at least one full table, and results so far are available 

• Event is finished 
 
In every state listed above, there are certain items that should be displayed to the competitors. For 
example, during the check-in phase, the check-in list and preliminary seeding should be displayed. 
During pool rounds, strip assignments should be shown until scores start coming in, at which point the 
scores should be shown. In elimination rounds, the seeding, strip assignments, and tableau should be 
shown. When scores start coming in, the strip assignments can be replaced with results so far. Finally, 
when an event is done, the final results should be shown. 
 
Fencing Time will automatically know what to display in each state of your event. You will no longer 
need to configure the display manually; Fencing Time’s display rules will do everything for you. 
 
When multiple events are in the same feed, Fencing Time will simply cycle through them in order. 
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Chapter 28: Preferences 

 
Numerous aspects of Fencing Time can be configured to suit your specific preferences. All of the 
program options can be found on the Preferences window, which is accessed by selecting Tools → 
Preferences on the main menu bar. 
 

General Preferences 

The options on the “General” tab control general program behavior. 
 

Load last tournament at startup 
Selecting this option will cause Fencing Time to 
automatically reload the tournament that was loaded 
when you last ran the program. 
 
Skip login screen at startup (when not using a server) 
If you do not ever connect to a Fencing Time server, the 
popup window that asks if you want to “Run Fencing 
Time only on this computer” or “Connect to a Fencing 
Time server” can be irritating. Selecting this option 
prevents the window from appearing when Fencing 
Time starts. Fencing Time will behave as if you had 
selected “Run Fencing Time only on this computer”. 
 
Display fencer last names in UPPERCASE 
Select this option to display fencer last names in 
UPPERCASE on-screen and on all printouts. 
 
Save tournament after each round 
When this option is selected, Fencing Time will automatically save the tournament at the completion of 
each round. This is a handy way to avoid forgetting to periodically save your tournament to protect 
against data loss in case of a power failure or computer crash. 
 
Automatically save tournament every X minutes 
When this option is selected, Fencing Time will automatically save the tournament at the interval 
specified. This save will happen without any prompting and should not be noticeable to you. This is an 
even more secure way to ensure that your tournament data is protected in case of a power failure or 
machine crash. 
 
Show the HTML Live Results tab on the Live Results screen 
By default, the HTML Live Results option is hidden on the Live Results Configuration screen.  This is 
because you are discouraged from using HTML Live Results and should be using Fencing Time Live 
instead.   However, if you absolutely must use HTML Live Results, this option will unhide the 
configuration options. 
 
Show birth year or full birthdate 
Fencing Time will display either full birthdates or just birth years depending on your selection.   
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Default location for tournament files 
If you want to change the default location where tournament files are saved and loaded from, enter the 
path here. Be certain that you have write permission to the specified folder.  
 
Language 
This option lets you select the language of the Fencing Time user interface. Changing languages will 
require restarting the program. 
 

Affiliation Preferences 

The options on the “Affiliations” tab of the 
Preferences window set the default affiliations to 
use for new events, fencers, clubs, and referees. 
 
Default authority 
The selected authority will be used as the default 
authority when creating new tournaments. In 
addition, when no tournament is loaded, this 
authority will be used when displaying information 
in the fencer, club, and referee databases. 
 
Default country, division, and club 
When creating new fencers and referees, the 
selections chosen here are used as the default 
affiliations for the new person.  
 
 
 

Printing Preferences 

The printing preferences can be modified by 
selecting the “Printing” tab on the Preferences 
window. 
 
Show logo on printed forms 
Most printed forms in Fencing Time can include 
logos on the page. You can select to show a logo in 
three positions at the top of your documents: left, 
middle, right. 
 
Fencing Time has built-in options for the Fencing 
Time and FIE logos.  You can also choose to use up 
to three custom logos. 
 
If you wish to use your own logo(s), use the “…” 
button to locate the logo image file on your hard 
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drive. Logo files are standard image files in either bitmap (.bmp), JPEG (.jpg) or GIF (.gif) format. Logos 
should be approximately 200x100 pixels in size to avoid distortion of the image when printed. 
 
Don’t show print dialog 
By default, Fencing Time will show the standard Windows print dialog whenever you print a document.  
This dialog lets you choose the printer, number of copies, etc.  However, if you always use the same 
printer, this dialog can be annoying.  By selecting this option, Fencing Time will skip the Windows print 
dialog and always print one copy of the document to the default printer. 
 

Membership Preferences 

Options on the “Membership” tab control which fields are updated when using the membership 
checking feature described in the “Managing and Checking-In Competitors” chapter. 
 

Referee Preferences 

The referee options center around the display of 
referee ratings.  Fencing Time considers referee 
ratings to exist in a hierarchy – FIE ratings being the 
highest and most important, and federation-specific 
ratings being the lowest.  For confederations that 
have a rating system (currently, the European and 
Asian Fencing Confederations), their ratings fall in 
between FIE and federation ratings. 
 
If a referee has FIE or confederation rating in 
addition to their federation-specific rating, you may 
wish to display the higher rating whenever Fencing 
Time displays rating information.  The two options 
on the Referees tab let you specify which ratings to 
display. 
 

 

Color Preferences 

When running many events, you often will have multiple event tabs open in Fencing Time and will 
frequently switch between them.  To help you distinguish one event from another, Fencing Time gives 
you the option to customize the background color used for each event. 
 
To enable color customization, check the “Color backgrounds by event” option.  The default set of colors 
for each event (based on weapon and gender) will be shown.  You can further customize which colors 
you would like to use by using the dropdown lists for each event type.
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Chapter 29: Transferring the Database between Computers 

 

 
 
On occasion, you may find that it is necessary to transfer the Fencing Time database (containing fencers, 
clubs, and referees) to another computer. This is often necessary if you get a new computer and install a 
fresh copy of Fencing Time on it. By transferring the database, you will preserve all of the data you’ve 
accumulated to date. 
 
To start the transfer process, select Tools → Move Master Database to/from Another Computer on the 
main menu bar. This will launch the Transfer Database Wizard. 
 
Transferring a database is a two-step process. The first step is to export the database from the “source” 
computer’s copy of Fencing Time so that it can be taken to the “destination” computer. To do this, 
choose the first option presented by the Transfer Database Wizard (running on the source computer’s 
copy of Fencing Time.)  You will be asked to specify a folder where you want the transfer file placed. 
 
After completing this step, Fencing Time will generate a file called “FencingTimeTransferData.ft4”. This 
file contains all of the information needed to bring the database to a new computer. 
 
The next step is to copy the FencingTimeTransferData.ft4 to the destination computer. You can do this 
by whatever method is most convenient:  copy it to a flash drive, send it via email, etc. Be sure you note 
where you place the file on the new computer. The desktop is usually a good choice. 
 
The next step requires that Fencing Time is already installed on the destination computer. If you have 
not already done so, install Fencing Time and then launch it.  
 
Next, go to the Tools menu and select the Move Master Database to/from Another Computer option to 
launch the wizard again. This time, you will select the second option presented – the option to import 
the database. 
 
When prompted, select the folder that contains the FencingTimeTransferData.ft4 file that you brought 
to the destination computer from the source computer.  
 
Once you have done this, Fencing Time will display a confirmation step before beginning the import 
process. It is important to understand that the imported database will completely replace all of the data 
on the destination computer. You will still be able to open tournament files, but any other 
fencer/club/referee data will be lost. If you are using a brand-new copy of Fencing Time, then this is not 
an issue, since few (if any) fencers/clubs/referees would have been created. 
 
Once you confirm the import, Fencing Time will replace your database with the one from the source 
computer. Once complete, you will have access to all of the data that was available on the source 
computer. You may now delete the FencingTimeTransferData.ft4 file – it is no longer needed. 
 

Database transfers only apply to the local database created on computers that are not 
connected to a Fencing Time server.   
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Astute users will notice that the Transfer Database Wizard can also be used to periodically backup your 
database for archival purposes. To do this, simply save the FencingTimeTransferData.ft4 file in a safe 
location. If you ever need to recover your database, you can restore the database from this file. 
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Chapter 30: Miscellaneous Features 

 
The following topics cover a number of other Fencing Time features that you may wish to explore. 
 

Time Marks 

Time marks are a handy feature that lets you timestamp events that take place during your tournament. 
By doing this, you can review the times of each event and determine how long different things took to 
run.  
 
Fencing Time will automatically log the time of significant events during your tournament. Significant 
events include the starting of rounds, the entering of pool scores, and the completion of each table in 
the DE tableau. You can also create a time mark for anything you choose simply by typing in what 
happened. 
 
To access the time marks, click the “Mark Time” button at the bottom of the event window of the event 
you wish to associate the time mark with. The Mark Time window will appear: 
 

 
 
The list at the top shows the events logged so far. All of the events shown are examples of events that 
Fencing Time automatically recorded. If you do not want these events to be automatically recorded, 
uncheck the “Automatically add important events” checkbox. 
 
If you want to mark the time of an event that happened outside of Fencing Time (such as “Started 
second flight of pools”), simply type a description of the event into the box and click “Add”. The event 
will be recorded at the current time. 
 
You can delete events in the list by selecting them and then clicking the “Delete” button. You can print 
and save the list of recorded events by clicking the corresponding buttons at the bottom of the window. 
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Printing Blank Forms 

If you need some blank printed forms, such as a pool sheet, DE tableau, etc., Fencing Time can print 
these for you.  
 
To print blank forms, select Tools → Print Blank Scoresheets and Forms from the main menu bar. Select 
the type of form that you want and click “Print”. 
 

Useful References 

Fencing Time provides several useful references for you on the “Help” menu on the main menu bar. 
 
Event Classification Chart 
This link will bring up a copy of the USA Fencing Event Classification chart for easy reference. 
 
Age Eligibility Chart 
This option will bring up a table that lists all of the age categories for the default authority. Each age 
category lists the range of eligible birth years for the current season. 
 
Website links 
Links to the Fencing Time, Fencing Time Live, and AskFRED websites are all provided here. Your 
computer must be connected to the internet to use these links. 
 
Log File Folder 
If you encounter a problem with Fencing Time and contact customer support, you may be asked to 
provide the Fencing Time log file to assist in troubleshooting.  This item on the Help menu opens the 
folder on your PC where the log files can be found so that you can locate the requested file and provide 
it to the support technician. 
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Appendix: Technical Information 

 
Fencing Time adheres to the rules specified in the current FIE rules, USA Fencing rules, USA Fencing 
Athlete Handbook, and USA Fencing Operations Manual. All rule changes that were in effect as of 
August 2024 have been applied. Rules that change occasionally, such as USA Fencing qualification rules 
and the event classification chart, can be updated easily by downloading an updated rules definition file. 
 
Fencing Time was homologated by the FIE on September 1, 2014.  It fully complies with all FIE rules and 
procedures and is capable of running international events of any size. 
 
Fencing Time is written in the C# language. It represents over twenty years of work and has over 
250,000 lines of code. 
 
“Fencing Time” is a registered trademark of Fencing Time, LLC. 
 


